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Technical Support
If you have difficulties using Express Accounts Accounting Software Free please read the 
applicable topic before requesting support. If your problem is not covered in this user guide 
please view the up-to-date Express Accounts Accounting Software Free Online Technical 
Support at www.nchsoftware.com/accounting/support.html. 

If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions
If you have any suggestions for improvements to Express Accounts Accounting Software Free, 
or suggestions for other related software that you might need, please post it on our 
Suggestions page at www.nch.com.au/suggestions/index.html. 

Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nchsoftware.com/accounting/support.html
www.nch.com.au/suggestions/index.html
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Introduction
Thank you for installing Express Accounts. 
Express Accounts is software that makes it easy for businesses to create and keep track of 
their bank accounts, quotes, orders, invoices, and bills. Express Accounts is designed so that it 
will integrate easily into most business practices with functionality that aids accounting and tax 
processes. 
Express Accounts generates professional-looking reports that can be printed, emailed or faxed 
directly from the program. It will keep track of all of your account transactions, allowing you to 
reconcile them with your bank account statements. It also generates professional looking 
quotes, orders and invoices that can be printed, emailed or faxed directly from the program. It 
then keeps track of which invoices have been paid with reports that can be used for chasing 
overdue invoices or preparing tax and other accounting returns. It also supports automatic 
statements and recurring billing invoices so you do not need to remember to bill customers. 
Express Accounts can be installed and running in less than 60 seconds. 
Features  
● Generates professional reports quickly
● Generates professional quotes, sales orders and invoices quickly
● Automatically records regular recurring orders/invoices (e.g., monthly invoices)
● Analyze sales by customer, sales person or item
● Ability to print reports or send them by email (pdf) or fax
● No need to learn complex accounting software
● Number of accounts limited only by your hard drive size which would be 100,000s on a 

modern computer
● Generates comprehensive reports for your accountant
● Reconcile account transactions with bank account statements
● Works for both product- and service-based businesses
● Can run multiple (unlimited) businesses from one install
● Installs and is ready for printing in less than a minute
● Designed to be very easy to use for day-to-day operation
System Requirements  
● Windows XP or later, including Windows 10
Optional 
● Internet Connection (for sending reports by email)
● Printer (for printing reports)
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Software License Terms
Our goal is for every user to have a successful experience with our software. We offer it to you 
on the basis that you accept our End User License Agreement (EULA).
This EULA limits our liability and is governed by an arbitration agreement and venue 
agreement. Please read below as these terms affect your rights.
1. The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. Installation 
of this software and any software bundled with or installed-on-demand from this software, 
including shortcuts and start menu folders, is licensed only in accordance with these terms. 
These copyrights do not apply to any creative work made by you, the user.
2. By installing, using or distributing the software you, on your own behalf and on behalf of your 
employer or principal, agree to these terms. If you do not agree to any of these terms, you may 
not use, copy, transmit, distribute, nor install this software - return it to the place of purchase 
within 14 days to receive a full refund.
3. This software, and all accompanying files, data and materials, are distributed "as is" and with 
no warranties of any kind, whether express or implied except as required by law. If you intend 
to rely on this software for critical purposes you must test it fully prior to using it, install 
redundant systems and assume any risk.
4. We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for all 
claims is limited to receiving a full refund for the amount you paid for the software.
5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You may not use this software if you 
do not regularly backup your computer, or do not have antivirus and firewall software installed 
on the computer, or keep sensitive data unencrypted on your computer. You agree to 
indemnify us from any claims relating to such use.
6. You may copy or distribute the installation file of this software in its complete unaltered form 
but you may not, under any circumstances, distribute any software registration code for any of 
our programs without written permission. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location where the 
unauthorized use occurs.
7. Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage statistics in limited circumstances.
8. Choice of Law. If you reside in the United States, your relationship is with NCH Software, 
Inc, a United States company, and this agreement is governed by the laws and courts of 
Colorado. If you reside anywhere in the world outside of the United States, your relationship is 
with NCH Software Pty Ltd, an Australian company, and this agreement is governed by the 
laws and courts of the Australian Capital Territory. Such courts have continuing and exclusive 
jurisdiction over any dispute between you and us, regardless of the nature of the dispute.
9. U.S. Customers Only: Arbitration Agreement and Class Action Waiver: PLEASE READ THIS 
CAREFULLY. IT MAY AFFECT YOUR RIGHTS.
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If you reside in the United States, NCH Software and you agree to arbitrate all disputes and 
claims between us. This agreement to arbitrate is intended to be broadly interpreted. 
References to "NCH" "you," and "us" include our respective subsidiaries, affiliates, agents, 
employees, predecessors in interest, successors, and assigns. This arbitration agreement 
does not preclude you from bringing issues to the attention of U.S. federal, state, or local 
agencies. Such agencies can, if the law allows, seek relief against us on your behalf. This 
Agreement evidences a transaction in interstate commerce, and thus the Federal Arbitration 
Act governs the interpretation and enforcement of this provision. This arbitration provision shall 
survive termination of this Agreement.
A party who intends to seek arbitration must first send to the other, by certified mail, a written 
Notice of Dispute ("Notice"). The Notice to NCH should be addressed to:
Legal Department
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
USA 
("Notice Address"). The Notice must (a) describe the nature and basis of the claim or dispute; 
and (b) set forth the specific relief sought ("Demand"). If NCH and you do not reach an 
agreement to resolve the claim within 30 days after the Notice is received, you or NCH may 
commence an arbitration proceeding. The amount of any settlement offer made by NCH or you 
shall not be disclosed to the arbitrator.
A. The arbitration will be governed by the Commercial Arbitration Rules and the Supplementary 
Procedures for Consumer Related Disputes (collectively, "AAA Rules") of the American 
Arbitration Association ("AAA"), as modified by this Agreement, and will be administered by the 
AAA. The AAA Rules are available online at adr.org, by calling the AAA at 1-800-778-7879, or 
by writing to the Notice Address. The arbitrator is bound by the terms of this Agreement. All 
issues are for the arbitrator to decide, including issues relating to the scope and enforceability 
of the arbitration provision. Unless NCH and you agree otherwise, any arbitration hearings will 
take place in Greenwood Village Colorado. If your claim is for $10,000 or less, we agree that 
you may choose whether the arbitration will be conducted solely on the basis of documents 
submitted to the arbitrator, through a telephonic hearing, or by an in-person hearing as 
established by the AAA Rules. If your claim exceeds $10,000, the right to a hearing will be 
determined by the AAA Rules. Regardless of the manner in which the arbitration is conducted, 
the arbitrator shall issue a reasoned written decision. NCH will pay all AAA filing, 
administration, and arbitrator fees for any arbitration initiated in accordance with the notice 
requirements above. If, however, the arbitrator finds that either the substance of your claim or 
the relief sought in the Demand is frivolous or brought for an improper purpose then the 
payment of all such fees will be governed by the AAA Rules. In such case, you agree to 
reimburse NCH for all monies previously disbursed by it that are otherwise your obligation to 
pay under the AAA Rules. In addition, if you initiate an arbitration in which you seek more than 
$75,000 in damages, the payment of these fees will be governed by the AAA rules.
B. The arbitrator may award declaratory or injunctive relief only in favor of the individual party 
seeking relief and only to the extent necessary to provide relief warranted by that party's 
individual claim. YOU AND NCH AGREE THAT EACH MAY BRING CLAIMS AGAINST THE 
OTHER ONLY IN YOUR OR ITS INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR 
CLASS MEMBER IN ANY PURPORTED CLASS OR REPRESENTATIVE PROCEEDING. 
Further, unless both you and NCH agree otherwise, the arbitrator may not consolidate more 
than one person's claims, and may not otherwise preside over any form of a representative or 
class proceeding. If this specific provision is found to be unenforceable, then the entirety of this 
arbitration provision shall be null and void.
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C. Notwithstanding any provision in this Agreement to the contrary, we agree that if NCH 
makes any future change to this arbitration provision (other than a change to the Notice 
Address) you may reject any such change by sending us written notice within 30 days of the 
change to the Arbitration Notice Address provided above. By rejecting any future change, you 
are agreeing that you will arbitrate any dispute between us in accordance with the language of 
this provision.
D. To opt out of this Arbitration Agreement and class action waiver send an Opt Out notice to 
the Notice Address stating "I am electing to opt out of the Arbitration Agreement and class 
action waiver contained in the Legal Terms applicable to my purchase of an NCH product." 
Your Opt Out Notice must include the date and proof of purchase. The Opt Out Notice must be 
postmarked no later than thirty (30) days after the date of purchase. A separate Opt Out Notice 
must be sent for each product purchased.
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Getting Started - Quick Start Wizard
After Express Accounts installs, and any time you select to add a new business to Express 
Accounts the Quick Start Wizard will run. 
The wizard will guide you through setting up the most basic details of your business including:
● Business Name - The name of your business. This will appear at the top of your reports 

and invoices.
● Chart of Accounts - You can use the default Chart of Accounts that comes with Express 

Accounts, or import your existing Chart of Accounts. You can make changes to your Chart 
of Accounts later, if needed. See the Chart of Accounts topic in the Getting Started section 
of this manual for more information about customizing your Chart of Accounts.

● Address and Contact - The details you enter here will appear at the top of your reports and 
invoices.
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Getting Started - Main Window Reference

Menus
Accounts - The Accounts menu contains common actions for working with Express 
Accounts, such as Web Access, backup and restore data,Closed-to-date, switching 
between multiple business accounts, importing data from ExpressInvoice,
Import Transactions and exiting Express Accounts.
Sales  - From the Sales menu you can create a new invoice, apply a customer payment, 
and view a list of invoices, as well as create quotes, sales orders and credit notes.
Purchases  - The Purchases menu contains all actions related to purchasing and payment. 
It includes links for creating a purchase order, viewing purchase orders, entering 
accounts payable, viewing accounts payable, and entering payments for accounts payable.
Transactions - The Transactions menu allows the user quick access to transaction screens, 
including making payments and receiving payments, making a manual journal entry, 
reconciling accounts, and recalculating customers' balances.
Reports - From the Reports menu, the user can select which report they want to view.
View - From the View menu, the user can view lists of customers, suppliers , invoices, the 
chart of accounts, and more.
Tools - The Tools menu is where recurring invoices, orders, and statements are run from, 
if they are not available in the explorer bar. It's also where the Options  dialog can be 
accessed, and where you can register Express Accounts.
Help - The Help menu contains a link to the Express Accounts Help documentation, links for 
the Express Accounts webpage, technical support, related programs, and other links you 
might find useful.

Toolbar
The toolbar will update depending on which tab is selected. Each tab contains the following 
icons on the toolbar:

Journal - Click the Journal icon in the toolbar to open the journal, where a list of all the 
journal entries you have made is displayed.
Reports - Click the Reports icon in the toolbar to select which report you want to view.
View - Click the View icon in the toolbar to view lists of customers, suppliers , invoices, the 
chart of accounts, and more.
Web Access - The Web Access icon opens the web interface of Express Accounts. The 
Web Access can be configured from the Options ~ Web Access tab.
Options  - The Options window is where many program settings can be configured and 
customized, including Business information, Accounting, Regional settings, Sales Taxes , 
Payments, Inventory settings, Page Layout, Page Styles, Invoice , Quote, Sales Order, 
Purchase Order, Credit Note, Packing Slip , Receipts, Checks, Statements, Web Access, 
and Other  options. 
Buy Online - Click the Buy Online icon to be taken to a webpage where you can purchase 
or upgrade Express Accounts.
Suite - The Suite is where you can view and download all NCH Software products.
Help - Click the Help button to open the Express Accounts documentation.

Explorer Bar
The Explorer Bar is found in the left sidebar of Express Accounts. It contains links to the most 
common tasks you might use, and contains links relevant to the tab view that is selected. 
Clicking the heading of each section will expand or collapse the links in that section, making 
this section customizable to your needs.

To-Do
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 - The links you find in the To-Do section of the Explorer Bar will vary depending on how 
many times you have used Express Accounts, if you are scheduled to run recurring 
payments or invoices, or if Express Accounts thinks it is time to back up your data.

Flow Chart
The flow chart in the main screen of Express Accounts, or the control panel, gives you yet 
another quick way to access the most commonly used features in Express Accounts. Each 
group and the arrows between the boxes help guide you through common accounting 
practices for the different aspects of your business. The boxes shown will be relevant to the tab 
view that is selected to provide quick access to the features of the task you are performing.

Tabs
Each tab contains links to the related accounting functions listed for the tab. The toolbar, 
explorer bar, and control panel will update each time a new tab is selected.

Accounts Tab
The Accounts tab opens a menu with links for common actions for working with Express 
Accounts, such as Web Access, backup and restore data, switching between 
multiple business accounts, and exiting Express Accounts.
Home Tab
The Home tab contains links to the most common function you'll use in Express Accounts. For 
example, look at the Explorer bar, which appears in the left sidebar. For the Home Tab, the 
explorer bar contains links to the following:
● Transactions - make a payment, receive payments, view the journal, reconcile an account.
● Sales - create an invoice or apply a customer's payment.
● Purchases - create a purchase order , create new accounts payable and pay bills .
● Banking - reconcile an account.
● Reports - view the income statement and balance sheet reports. More reports can be found 

by clicking the Reports tab.
● Configuration - set up or edit the chart of accounts, and configure other program settings 

through the options link.
Directly under the explorer bar is a quick-glance at the balances of your accounts, your 
business's income and profit.
Sales Tab
The Sales tab contains links to sales-related functions in Express Accounts. For the Sales Tab, 
the explorer bar contains links to the following:
● Simple Sale - quickly record a sale that you have received payment for and that does not 

have an invoice.
● Quotes - create a new quote, sales order, or convert a quote to a sales order.
● Invoices - create a new invoice, apply a customer payment, or view a list of invoices.
● Invoice Items - view and manage a list of all items in your inventory.
● Customers - add new customers  to the system, or view and manage a list of all customers.
● Sales Reports - view reports related to sales. For a complete list of reports available, click 

the Reports tab.
Directly under the explorer bar is a quick-glance at the sales activity of your business from the 
last month, and the accounts receivable balance.
Purchases Tab
The Purchases tab contains links to purchasing-related functions in Express Accounts. For the 
Purchases Tab, the explorer bar contains links to the following:
● Enter Payments - pay bills  for previous accounts payable bills you have entered, or 

other payments .
● Accounts Payable - enter your upcoming bills as a new account payable and view and 

manage a list of all accounts payable.
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● Orders - create a new purchase order, which can later be transitioned into an account 
payable.

● Suppliers - add a new supplier , or view and manage a list of all suppliers.
● Purchases Reports - view reports related to purchases. To view a list of all reports, click the 

Reports tab.
Directly under the explorer bar on this tab is a quick-glance at the expense activity of your 
business over this month and the last, as well as any balance in your accounts payable.
Banking Tab
The Banking tab contains links to banking-related functions in Express Accounts. To quickly 
reconcile accounts, click one of the links under the Reconcile Bank Accounts heading. Clicking 
the link for Bank Account #1  will open up a Reconcile Account dialog set up to reconcile the 
Checking Account, and the link for Bank Account #2  will be set up to reconcile the Savings 
Account, but you can select a different account once the dialog is open, if needed.
Directly under the explorer bar on this tab is a quick-glance at your business's bank accounts.
Reports Tab
The Reports tab displays a list of all reports available within Express Accounts. The area under 
the explorer bar displays a quick-glance of your business's net assets and the profit earned 
during this month and the last.

15

pordermain.html
addsupplier.html
supplierslist.html


Getting Started - Chart of Accounts
The Chart of Accounts is a list of all the accounts your organization uses. When a new 
business is set up in Express Accounts, the setup wizard asks if you would like to use the 
default Chart of Accounts list or create one manually.
Working with the default Chart of Accounts
To view the default Chart of Accounts for your business, click the View icon in the toolbar and 
select Chart of Accounts.  This opens the Chart of Accounts window where you can view the 
Chart of Accounts; or add, edit, delete, or restore accounts. Each account has a number 
assigned to it by Express Accounts, but these numbers can be edited if needed.
To edit an account's properties, including its account name, number, or opening balance, 
select the account, then click Edit in the toolbar. For more information about the options for the 
account properties, see the Account Properties topic in the Screen References section of this 
manual.
Creating a Chart of Accounts manually
You might want to manually create a Chart of Accounts for your business if you have an 
existing Chart of Accounts from a previous system or accounting software. This is an option 
you can select in the Setup Wizard for each new business, which will load without the Express 
Accounts default list of accounts so you can add your own. To begin creating your Chart of 
Accounts, click the View icon in the toolbar and select Chart of Accounts.  This opens the 
Chart of Accounts window where you can add, edit, delete, or restore accounts.
To create a new account, click the New icon in the toolbar. This brings up the New Account 
Dialog. For manually creating a Chart of Accounts, you'll use the Create New Account 
section. Fill out the information for the account, then click the Add  button to add it to the Chart 
of Accounts. For more information about the options for creating a new account, see the 
New Account topic in the Screen References section of this manual.
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Getting Started - Taxes
If you plan on using Express Accounts for creating invoices for customers, you will need to set 
up the tax amounts required by your local government. Express Accounts can, in some cases, 
detect your location and automatically set up the tax rates in your country or province, but you 
will want to check that the rates applied are correct, and make adjustments as necessary. 
Express Accounts detects your location based on the locale set in your computer system, so 
double check your system settings for the most accurate setup.
To view the tax configuration dialog, click the Options icon in the toolbar, then click the Tax 
tab. You can create new tax rates by clicking the Add  button. You can add as many tax values 
as you need, and you can designate which tax should be applied to items by default to save 
you time creating invoices.
Applying a tax amount to an item occurs in the New Invoice dialog. If you don't have a default 
tax amount set, or need to change the tax for an item from the default setting, select the tax 
amount from the drop menu for that item. All the tax will be added up at the bottom of the 
invoice by Express Accounts.
See also:
● Options ~ Tax
● New Invoice
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Getting Started - Customization for Your Business
Express Accounts gives you some control over how your printed quotes, orders, invoices, and 
reports will look. Available options include:
● Add your company logo to the header of printed quotes, orders, invoices, and reports. See 

Options ~ Company for details.
● Add your company logo to printed receipts. See Options ~ Receipts for details.
● Customize the headings for certain heading rows on printed quotes, orders, and invoices, 

as well as messages to your customers that appear on the footer. See 
Options ~ Page Layout , Options ~ Invoice Content, Options ~ Page Styles , 
Options ~ Quote , and the Sales Order topic in the Screen References section of this 
manual for details.

● Set the prefixes and numbering for your accounting entries, useful if you are transitioning 
from a previous system. See Options ~ Accounting for details.

● Regional settings appropriate for your location, such as the currency symbol, printed date 
format, decimal and thousands symbol, digits after a decimal point, and paper size. See 
Options ~ Regional  for details.
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Getting Started - Register Express Accounts
Express Accounts requires purchase and registration of a license for each installation. You can 
view pricing information via the purchasing link on the Express Accounts home page at 
www.nchsoftware. com/accounting/plus.html.
After buying a license you will receive a 'Software Purchase Serial Numbers' email containing 
your 12-digit license serial number and instructions on how to use this number to activate the 
license.
To activate Express Accounts, select Register Software from the Accounts or Tools menu and 
then click the Activate Online link in the 'Step 2: Activate Serial Number' section of the software 
registration window. This takes you to the Activate Software page on the NCH Software 
website. Note: You do not need to reinstall Express Accounts to activate the software.
Enter the license serial number in the box provided, your personal registration details, and click 
the 'Activate Software License' button. The license Registration and Activation Code details 
(Name - Location - ID - Key) will be displayed on your browser, and will also be emailed to you.
Enter the Registration and Activation Code details - exactly as provided - into the 'Step 3: Enter 
the license details' section of the registration window, and then click the OK button. Note: 
When you receive the email containing your registration code you should heed the advice on 
that email and print out a copy of it immediately, and keep that hard copy in a safe place.
We also recommend that you retain a copy of the easetup.exe Express Accounts software 
installation file for the version you are using. Place this .exe file on a portable medium such as 
a CD or USB flash drive, and keep it safe with the printout of your license Registration and 
Activation Code.
If your code is not accepted...
1. Check you have entered the Name, Location, ID and Key exactly as they appear on the 

email containing the license Registration and Activation Code. In particular, the Key from 
the code is comprised of eight lowercase letters only; it contains no numbers or uppercase 
letters. The Name and Location fields are case-sensitive.

2. If the Express Accounts license was purchased a while ago, for a previous version, the 
license Registration and Activation Code that you are using may not work with a more 
recent version of Express Accounts. In this case you must purchase an upgrade license at 
www.nch.com.au/ upgrade/index.html.

3. If you have had to re-install Express Accounts (e.g., following a hard drive reformat or 
replacement), and your license Registration and Activation Code has worked previously 
with the version of Express Accounts that you are using, the code may simply require 
resetting. Contact NCH Registration Support using the email form at 
www.nch.com.au/support/regcontact.html on the website, and include the full details (Name 
- Location - ID - Key) of your code.
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Getting Started - Shortcut Keys Reference
The following list of keyboard shortcuts will help you navigate through Express Accounts' main 
interface quickly.
Universal Shortcuts
The following shortcuts can be used from any screen 
Open Web Interface Ctrl+W
Adjust settings and options Ctrl+O 
Main Screen
New Invoice Ctrl+N
Open Invoices List Ctrl+I
Apply Customer's Payment List Ctrl+P
Open Customer's List Ctrl+C
Open Items List Ctrl+T
Apply Customer's Payment Ctrl+Y
Open Recurring Invoices List Ctrl+R 
Open Sales Orders List Ctrl+S
New Sales Order Ctrl+D
New Quote Ctrl+Q
Open Quotes List Ctrl+U 
Chart of Accounts Ctrl+A
Enter Manual Journal Entry Ctrl+J
Reconcile Account Ctrl+E
Open Journal List Ctrl+V
Run Recurring Invoices F5
Run Automatic Statements F6
Open Help Documentation F1
Exit Express Accounts Alt+F4
Reports
Print this report Ctrl+P
Save to PDF Ctrl+S
Send this report by email Ctrl+E
Chart of Accounts
Create Default Ctrl+D
Add Account Ctrl+N
Restore Ctrl+R
Find Account Ctrl+F 
Find Next Account F3
Edit Enter
Delete Delete
Close Window Esc
Accounts Payable list
New Payment Ctrl+N
Find Payment Ctrl+F 
Find Next Payment F3 
Edit Alt+Enter
Delete Delete
Close Window Esc
Payments of Accounts Payable list
New Accounts Payable Ctrl+N
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Enter Payment Ctrl+Y
Find Accounts Payable Ctrl+F
Find Next Accounts Payable F3
Edit Alt+Enter
Delete Delete
Close Window Esc
Checks List
Email Check Ctrl+E
New Check Ctrl+N
Void Check Delete
Print Check Ctrl+P 
Find Check Ctrl+F 
Find Next Check F3 
Edit Alt+Enter
Close Window Esc
Payments List
New Payment Ctrl+N
Charge Credit Card Ctrl+C
Print Preview Ctrl+Shift+P
Print Receipt Ctrl+P
Email Receipt Ctrl+E 
Find Payment Ctrl+F 
Find Next Payment F3 
Edit Alt+Enter
Delete Delete
Close Window Esc
Refunds List
New Refund Ctrl+N
Charge Credit Card Ctrl+C
Print Preview Ctrl+Shift+P
Print Receipt Ctrl+P
Email Receipt Ctrl+E 
Find Refund Ctrl+F 
Find Next Refund F3 
Edit Alt+Enter
Delete Delete
Close Window Esc
Journal Entry List
Send to Email Ctrl+E
New Entry Ctrl+N
Save as PDF Ctrl+S 
Print Entry Ctrl+P 
Find Entry Ctrl+F 
Find Next Entry F3 
Edit Enter
Delete Ctrl+Delete
Close Window Esc
Suppliers List
Add Supplier Ctrl+N
Delete Delete
Edit Alt + Enter
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Email Supplier Ctrl+E
Call Supplier Ctrl+T
Find Supplier Ctrl+F 
Find Next Supplier F3
Close Window Esc

22



Getting Started - Guide to Bookkeeping
For a comprehensive beginners guide to bookkeeping, visit the FastTrack Bookkeeping 
website at www.fastpathbooks.com/. At the website you'll learn about the following:
● Bookkeeping – what is it all about? 
● Types of Accounts
● Tracking Transactions
● Reports
● Grouping Journal Entries - books of first entry
● Sales Tax
● Depreciation
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Common Tasks - Creating Items and Services
If your company sells items or services, Express Accounts will keep them in a list so you can 
add them to quotes, orders, and invoices quickly. If you are adding services, enter them as 
items, as Express Accounts does not distinguish between the two. There are three ways to add 
new items and services to the system: through a New Invoice, using the Items List, and 
importing items.
Add Items through a New Invoice, Quote, or Order
This is an efficient way to add new items and services to Express Accounts, since items are 
created at the same time you create a customer invoice, quote or order. While you are creating 
a new invoice, quote, or order, any items you enter that haven't been added to Express 
Accounts yet will automatically be added to the Items list once the invoice, quote, or order is 
saved or recorded. Each new item entered will include the item number, description, unit value, 
and tax.
Note: If you want to keep track of the inventory quantity, you will have to edit the item in the 
Items list (see below).
See New/Edit Invoice, New/Edit Quote, and the New/Edit Order topic in the Screen 
References section of this manual for details about filling out these forms.
Add Items using the Items List
To open the Items List, click the View icon on the toolbar and select Items.  To add a new 
item, click the Add  icon in the toolbar. There are two tabs in the Item dialog. On the first tab, 
called Item, fill out the item details. If you want to manage inventory stock levels using Express 
Accounts, click to the Inventory tab and enter your on hand quantity, ideal quantity, and 
warning level quantity. Click OK to save the new item or service.
To Edit an existing item or service  from the Items List, select the item and click the Edit 
icon in the toolbar.
See the Item ~ Item and Item ~ Inventory topics in the Screen References section of this 
manual for more information about the Item dialog.
Import Items from a CSV File or Another Express Accounts Business
From a CSV File - You can import a list of items you have used previously to save time 
entering new items into Express Accounts. To import a list, open the Items list, click the Item 
menu and click Import Items from CSV. Browse to the CSV file and open it. The Match CSV 
Fields dialog will open in Express Accounts. You'll need to match up the columns from the CSV 
file with headings in Express Accounts. For more information on how to do this, see the help 
topic Match CSV Fields in the Screen References section of this manual.
From Another Express Accounts Business  - To import items from another business within 
Express Accounts, open the Items list, click the Item menu and click Import Items from other 
Business.  This opens a dialog. Select the business you want to import items from in the top 
window and the items will appear in the bottom window. Uncheck any items you do not want to 
import. Click the Import button when you are finished.
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Common Tasks - Add New Customers
If your company sells items or services to regular customers, Express Accounts will keep them 
in a list so you can create quotes, orders, and invoices for your customers quickly. Express 
Accounts will also keep customer credit card information on file, and will tell you if customers 
are up-to-date with their accounts due.
There are three ways to add new customers to the system: through a New Invoice, Quote or 
Order; using the Customer List, or importing a customer list.
Add Customers through a New Invoice, Quote, or Order
This is an efficient way to add new customers to Express Accounts, since customers records 
are created at the same time you create a customer invoice, quote or order. While you are 
creating a new invoice, quote, or order, if you enter a new customer into the Invoice Customer 
field, the customer name will be saved automatically once the invoice, quote, or order is saved 
or recorded.
Note that this method only saves the customer name, not their contact information. To add all 
information, enter the new customer name into the field, then click the Edit the customer 
record button to the right of the customer field, and enter the additional information on the 
Customer dialog (see below for more details).
For more information about invoices, quotes, and orders, See New/Edit Invoice, 
New/Edit Quote, and the New/Edit Order topic in the Screen References section of this manual 
for details about filling out these forms.
Add Customers through the Customers List
To open the Customer List, click the View icon in the toolbar, then select Customers.  To add 
a new customer, click the Add  icon in the toolbar. This brings up the Customer dialog, which 
has four tabs:
● Customer tab - Enter the customer's contact details, including their billing address.
● Credit Card tab  - Enter the customer's credit card info for quick payment. Credit card 

numbers are displayed as dots to protect the customer's information.
● Other tab  - Enter the customer's shipping address and preferences.
● Info tab  - View the customer's account statement information to quickly see if they are 

up-to-date on their account. This tab won't be visible when a new customer is created from 
the Customers list the first time only.

Click OK to save the new customer record.
To Edit an existing customer from the Customers List, select the customer and click the Edit 
icon in the toolbar.
Import Customers from a CSV File or Another Express Accounts Business
From a CSV File - You can import a list of customer you have used previously in another 
program to save time entering new customers into Express Accounts. To import a list, open the 
Customer list, click the Customer menu and click Import Customers from CSV. Browse to 
the CSV file and open it. The Match CSV Fields dialog will open in Express Accounts. You'll 
need to match up the columns from the CSV file with headings in Express Accounts. For more 
details on how to do this, see the help topic Match CSSV Fields  in the Screen References 
section of this manual.
From Another Express Accounts Business  - To import customers from another business within 
Express Accounts, open the Customer list, click the Customer menu and click Import 
Customers from other Business. This opens a dialog. Select the business you want to 
import customers from in the top window and the customers will appear in the bottom window. 
Uncheck any customers you do not want to import. Click the Import button when you are 
finished.
See also:
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● Customer List
● Customer ~ Customer
● Customer ~ Credit Card
● Customer ~ Other
● Customer ~ Info
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Common Tasks - Customer Statements
Generate a Customer Statement
Express Accounts keeps track of a customer's account balance so you can quickly see their 
payment status. A customer's balance is displayed next to their entry on the Customer List, 
which is accessed by clicking the View icon in the toolbar and selecting Customers.  To view, 
print, or send a statement from the Customer List, highlight a customer and click the small 
triangle next to the Statement  icon and select a method for sending, saving, or preview. Enter 
in a time period for the statement, and the statement will be generated.
Send Automatic Statements
You can use Express Accounts to send automatic statements to customers to remind them of 
their balances. To do this, click the Options icon from the toolbar, and click the General  tab. 
In the Automatic Statements section, you can select to send automatic statements to every 
customer with an outstanding balance or just customers who are overdue, and set a minimum 
amount a statement is sent for.
Unpaid Accounts Report
Access the Unpaid Accounts Report by clicking the Reports tab and selecting Unpaid 
Accounts Report. The list that appears shows only those customers with outstanding 
balances. Clicking the Due Date heading will rearrange the list so you can easily see which 
accounts are overdue.
See also:
● Customer List
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Common Tasks - Add New Suppliers
If your company purchases items regularly from vendors or suppliers, Express Accounts will 
keep them in a list so you can create purchase orders quickly.
To add a new supplier, open the Suppliers List by clicking the View icon in the toolbar, then 
select Suppliers.  To add a new supplier, click the Add  icon in the toolbar. This brings up the 
Supplier dialog. Fill in the supplier's information and click OK to save the new supplier record. 
To Edit an existing supplier  from the Suppliers List, select the supplier and click the Edit 
icon in the toolbar.
For more details about the Supplier dialog, see the Supplier ~ Supplier topic in the Screen 
References section of this manual. Also see the Suppliers List topic.
Adding Suppliers from a Purchase Order
If you find yourself in the middle of a purchase order and want to add a new supplier right 
away, you don't need to close the purchase order to do so. Enter the supplier name in the Orde
r Supplier  field and press Enter, then click the Edit the supplier record button to the 
right of the Order Supplier field. This will open the Supplier dialog, which you can fill out as 
explained above. Click OK to save the record and you will be returned to your purchase order.
Import Suppliers from a CSV File 
You can import a list of suppliers you have used previously to save time entering new suppliers 
into Express Accounts. To import a list, open the Suppliers list, click the Supplier  menu and 
click Import Suppliers from CSV. Browse to the CSV file and click Open. The Match CSV 
Fields dialog will open in Express Accounts. You'll need to match up the columns from the CSV 
file with headings in Express Accounts. For more information on how to do this, see the help 
topic Match CSV Fields in the Screen References section of this manual.
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Common Tasks - Quotes
You can use Express Accounts to generate sales quotes for your customers, then later turn the 
quote into an order, and then an invoice.
Create a New Quote

From the Sales menu select New Quote, or click the Sales tab, and click the Create new 
Quote  link in the explorer bar, and the New Quote dialog will open.
Begin filling out the quote by selecting the customer's name from the Quote Customer 
drop-down box, and their billing and shipping address will be filled out for you. If you are 
creating a quote for a new customer, simply type their name into the Quote Customer field, 
and fill in their address.
Enter items or services into the quote by clicking anywhere inside the items list to create a 
new item entry. Click within the Item or Description  cell and use the drop-menu to quickly 
locate an item by its code or description. For new items, enter the details into the quote, and 
the details will be added to your items list for you, and will be available the next time you 
want to create a quote, order, or invoice. Enter the quantity, and the totals will update 
automatically.
Save the quote by clicking Record  at the bottom of the screen. For more saving options, 
including Record and Print, click the triangle on the right side of the Record button.
For more detail about all the fields on the New Quote dialog, view the New Quote reference 
in the Screen References section of this manual.
View Existing Quotes
To view a list of all quotes, click the View icon in the toolbar and select Quotes . By default, 
the list displays recorded quotes only. To view all quotes, or just draft quotes, use the 
drop-menu labeled Display Quotes to select.
For more details about the quotes list, see the Quotes List topic in the Screen References 
section of this manual.
Turn a Quote into an Order or Invoice
When a customer has accepted your bid, you can easily turn the quote you gave them into 
an order or an invoice. First, open the Quotes List by selecting Open Quotes List from the 

 or click the View or convert Quotes  link in the explorer bar of the Sales tab. 
Select the quote from the list, then click either Order or Invoice  from the toolbar. This will 
open a New Order or New Invoice dialog containing all the details from the quote. You can 
edit any information on the order or invoice, then save.
Once a quote has been converted into an order or invoice, its status in the Quotes List will 
change to either Ordered or Invoiced.
More information about sales orders can be found in the Sales Orders topic in the Common 
Tasks section of this manual. More information about invoices can be found in the Invoices 
topic in the Common Tasks section of this manual.
Import Quotes from a CSV File 
You can import a list of quotes you have recorded from another system to integrate your 
records into Express Accounts. To import a list, open the Quotes list, click the Quote  menu 
and click Import Quotes from CSV. Browse to the CSV file and click Open. The Match 
CSV Fields dialog will open in Express Accounts. You'll need to match up the columns from 
the CSV file with headings in Express Accounts. For more information on how to do this, 
see the help topic Match CSV Fields in the Screen References section of this manual.
See also:

● Options ~ Quote  for information about configuring quote numbering, logo placement, and 
standard text.
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Common Tasks - Sales Orders
You can use Express Accounts to generate sales orders for your customers, then later turn the 
order into an invoice.
Create a New Sales Order

From the Sales menu select New Sales Order, or from the Sales tab click the Create 
new Sales Order link in the explorer bar, and the New Order dialog will open.
Create a sales order from an existing quote - select the quote number from the Quote 
Number drop-menu. The details of the quote will appear on the sales order form. You can 
make edits to the information or items, and then save the sales order.
Create a new sales order  - Begin filling out the order by selecting the customer's name from 
the Order Customer drop-down box, and their billing and shipping address will be filled out 
for you. If you are creating an order for a new customer, simply type their name into the Ord
er Customer  field, and fill in their address.
Enter items or services into the order by clicking anywhere inside the items list to create a 
new item entry. Click within the Item or Description  cell and use the drop-menu to quickly 
locate an item by its code or description. For new items, enter the details into the order, and 
the details will be added to your items list for you, and will be available the next time you 
want to create a quote, order, or invoice. Enter the quantity, and the totals will update 
automatically.
Save the order by clicking Record  at the bottom of the screen. For more saving options, 
including Record and Email, click the triangle on the right side of the Record button.
For more detail about all the fields on the New Order dialog, view the New Order  topic in 
the Screen References section of this manual.
Create a Recurring Order Schedule
If a sales order needs to be fulfilled on a regular basis, Express Accounts allows you to 
automate part of the process by creating recurring order schedules.
To create a recurring order schedule, fill out the order as usual, then select Save as 
Recurring  from the drop-menu at the bottom. This brings up the Recurring Order Schedule 
dialog. Fill out when the first order should be scheduled, how often the order should be sent, 
what action to take to save, print, or send the order, and then click OK to save the schedule.
When a recurring order is due to be sent, a Run Recurring Orders  link will appear in the 
ToDo list in the Explorer bar. Click this link to have Express Accounts run all recurring 
orders that are scheduled to go out.
You can view a list of all recurring orders by selecting Recurring Orders  from the View 
menu. From the Recurring Orders list, you can select a recurring order and edit the details 
of the order, or edit the recurring schedule.
For more details about filling out a recurring order schedule, see the 
Recurring Order Schedule topic in the Screen References section of this manual.
View Existing Sales Orders
To view a list of all sales orders, click the View icon in the toolbar and select Sales Orders. 
By default, the list displays recorded orders only. To view all orders, or just draft orders, use 
the drop-menu labeled Display Orders to select.
For more details about the orders list, see the Orders List topic in the Screen References 
section of this manual.
Turn a Sales Order into an Invoice
When a sales order has been fulfilled, you can easily turn the sales order into an invoice for 
billing your customers. First, open the Sales Order List by selecting Open Sales Order List  
from the Sales menu. Select the order from the list, then click the Invoice
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 icon in the toolbar. This will open a New Invoice dialog containing all the details from the 
sales order. You can edit any information on the invoice, then save.
Once a sales order has been converted into an invoice, its status in the Orders List will 
change to Invoiced.
More information about invoices can be found in the Invoices topic in the Common Tasks 
section of this manual.
See also:

● Options ~ Sales Order  for information about configuring sales order numbering, logo 
placement, and standard text.
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Common Tasks - Invoicing
You can use Express Accounts to bill your customers by creating professional-looking invoices.
Create a New Invoice

Click the Sales menu and select New Invoice  or click the Invoice  icon on the toolbar of 
the Sales tab, and the New Invoice dialog will open.
Create a sales order from an existing quote, order, or draft invoice  - From the Use  
drop-menu in the upper left, select either Quote, Order, or Draft Invoice. This will open a list 
of the specified records. Select the quote, order, or draft invoice, and click the select icon in 
the toolbar. The details of the record will appear on the invoice form. You can make edits to 
the information or items, and then save the invoice.
Create a new invoice - Begin filling out the invoice by selecting the customer's name from 
the Invoice Customer  drop-down box, and their billing and shipping address will be filled 
out for you. If you are creating an invoice for a new customer, simply type their name into 
the Invoice Customer  field, and fill in their address.
Enter items or services into the invoice by clicking anywhere inside the items list to create a 
new item entry. Click within the Item or Description  cell and use the drop-menu to quickly 
locate an item by its code or description. For new items, enter the details into the invoice, 
and the details will be added to your items list for you, and will be available the next time 
you want to create a quote, order, or invoice. Enter the quantity, and the totals will update 
automatically.
Save the invoice by clicking Record  at the bottom of the screen. For more saving options, 
including Record and Print, click the triangle on the right side of the Record button.
For more detail about all the fields on the New Invoice dialog, view the New Invoice topic in 
the Screen References section of this manual.
Create a Recurring Invoice Schedule
If an invoice needs to be sent on a regular basis, Express Accounts allows you to automate 
part of the process by creating recurring invoice schedules.
To create a recurring invoice schedule, fill out the invoice as usual, then select Save as 
Recurring  from the drop-menu at the bottom. This brings up the 
Recurring Invoice Schedule dialog. Fill out when the first invoice should be scheduled, how 
often the invoice should be sent, what action to take to save, print, or send the invoice, and 
then click OK to save the schedule.
When a recurring invoice is due to be sent, a Run Recurring Invoices link will appear in 
the ToDo list in the Explorer bar. Click this link to have Express Accounts run all recurring 
invoices that are scheduled to go out.
You can view a list of all recurring invoices by selecting Recurring Invoices from the View 
menu. From the Recurring Invoices list, you can select a recurring invoice and edit the 
details of the invoice, or edit the recurring schedule.
For more details about filling out a recurring invoice schedule, see the 
Recurring Invoice Schedule topic in the Screen References section of this manual.
View Existing Invoices
To view a list of all invoices, click the View icon in the toolbar and select Invoices . By 
default, the list displays recorded invoices only. To view all invoices, or just draft invoices, 
use the drop-menu labeled Display Invoices to select.
For more details about the invoices list, see the Invoices List  topic in the Screen 
References section of this manual.
Unpaid Invoices

When the time comes to contact overdue customers, you can use the Unpaid Accounts Report 
or the Customer List.
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Unpaid Accounts Report- To access the Unpaid Accounts Report, click the Reports tab and 
select Unpaid Accounts Report  from the main window. You can sort the list by customer or 
due date to give you a good idea of who is behind on payments.
Customer List - To access the customer list, click the View icon on the toolbar and select Cust
omers.  The customer list displays what each customer's balance is, when their earliest 
due date is, and what their last invoice number was.
Send Automatic Statements
You can send automatic monthly statements to customers who are overdue. This is done by 
clicking Options on the toolbar, then going to the Company tab and configuring the Automatic 
Statements section.
Receive Payment for Invoices
To apply a payment toward an invoice, from the Sales tab click the Payment  button on the 
toolbar. This opens the payment dialog. Select a customer from the Customer drop-menu, and 
their unpaid invoices will appear in the Invoices section of this dialog. Any amount entered in 
the Amount field will be applied to the invoices in the order they are due.
Note that the invoices section is for your reference only. Express Accounts applies payments 
toward a customer's account, not to specific invoices.
For more details about the payment dialog, view the Payment topic in the Screen References 
section of this manual.
See also:
● Options ~ Accounting for information about configuring invoice numbering, 

Options ~ Page Styles  for logo placement, and Options ~ Invoice Content for standard text.
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Common Tasks - Purchase Orders
You can use Express Accounts to generate purchase orders when you need to order from your 
suppliers.
Create a New Purchase Order

From the Purchases menu  select New Purchase Order or click the Create new 
Purchase Order link from the Purchases tab, and the New Order dialog will open. Begin 
filling out the order by selecting the vendor's name from the Order Supplier drop-down 
box, and their billing and shipping address will be filled out for you. If you are creating an 
order for a new supplier, simply type their name into the Order Supplier field, and fill in 
their address.
Enter items into the order by clicking anywhere inside the items list to create a new item 
entry. Click within the Item or Description  cell and use the drop-menu to quickly locate an 
item by its code or description. For new items, enter the details into the order, and the 
details will be added to your items list for you, and will be available the next time you want 
to create a quote, order, or invoice. Enter the quantity, and the totals will update 
automatically.
Save the purchase order by clicking Record  at the bottom of the screen. For more saving 
options, including Record and Email, click the triangle on the right side of the Record button.
For more detail about all the fields on the New Order dialog, view the New Order  topic in 
the Screen References section of this manual.
View Existing Purchase Orders
To view a list of all purchase orders, click the View icon in the toolbar and select Purchase 
Orders. By default, the list displays recorded purchase orders only. To view all orders, or 
just draft orders, use the drop-menu labeled Display Orders to select.
For more details about the orders list, see the Purchase Orders List  topic in the Screen 
References section of this manual.
See also:

● Sales Order for information about configuring sales order numbering, logo placement, and 
standard text.
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Common Tasks - Accounts Payable
You can use Express Accounts to enter a bill you have received for payment at a later date.
Entering Accounts Payable

From the Purchases menu  select Enter Accounts Payable  or click the Enter new 
Accounts Payable link from the explorer bar of the Purchases tab, and the New Accounts 
Payable dialog will open. Begin filling out by selecting the supplier's name from the Supplier

Enter accounts by clicking anywhere inside the list to create a new entry. Click within the Nu
mber  or Name cell and use the drop-menu to quickly locate an account by its number or 
name. Enter the amount, and the totals will update automatically.
Save the accounts payable entry clicking Record  at the bottom of the screen. 
For more detail about all the fields on the dialog, view the Enter new Accounts Payable 
topic in the Screen References section of this manual.
View Existing Accounts Payable
To view a list of all purchase orders, click the View icon in the toolbar and select Accounts 
Payable. By default, the list displays recorded accounts payable only. To view all , or just 
draft, use the drop-menu labeled Display Orders to select.
For more details about the orders list, see the Accounts Payable List topic in the Screen 
References section of this manual.
See also:

● Sales Order for information about configuring sales order numbering, logo placement, and 
standard text.
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Common Tasks - Payments and Purchases
Use Express Accounts to keep track of the payments and purchases you make. To make a 
payment or enter a purchase transaction, click on the Transactions  menu and select Paymen
t Transaction , or click The Purchases tab and click the Of other payments  link in 
the explorer bar. This brings up the Payments and Purchases dialog.
Entering a Transaction

Enter the transaction details, including who the payment is to, the amount, a journal memo 
(optional), and which account the payment should be allocated from. If your accounts do not 
balance, you cannot finalize the transaction in Express Accounts until they do; the status 
bar beneath the accounts list at the bottom will notify you if the accounts are out of balance.
- For more information on the details of the Payments and Purchases dialog, see the 
Payments and Purchases topic in the Screen References section of this manual.
- For more information about configuring payment numbering, see the Options ~ Accounting

You can record the payment as a cash payment, or as a check payment. To specify, click 
the triangle next to the Record  button at the bottom of the dialog.
Create and Use Payment Templates

For payments that you make routinely, you can use Express Accounts to set up a template to 
save time.

Enter a payment transaction as described above, but before you record the transaction, 
click the Save As Template  button in the lower left of the dialog. Enter a name for the 
template and click OK. The template will be available for use next time you enter a payment 
or purchase.
To use a template, open the payments and transactions dialog as described above, and 
click the Use Template  button in the lower left of the dialog. Select the template you need 
to use from the list and click Load. The payment template will be loaded into the Payments 
and Purchases dialog. Make sure the details are as you expect them, then click Record  to 
apply the payment.
Also see these topics in the Screen References section:
● Select Template
● Name Template
Manual Journal Entries

General payments and purchases should not be made as a manual journal entry, but there are 
cases when you might need to account for changes in your accounts using this method. Speak 
to your accountant if you are unsure when to manually enter journal entries.

To enter a payment or purchase manually on the journal, begin by opening the Journal by 
clicking the Transaction  menu and select Manual Journal Entry to pull up the Journal 
Entry dialog. This dialog can also be found from the Journal by clicking the Add  button in 
the toolbar.
Select which journal the entry should be applied to, and make a journal memo (optional). In 
the Account Allocation area, select an account(s) to debit money from, and account(s) to 
credit money to. When the accounts are balanced, click Record  to save the journal entry.
View and Edit Payments
All payment and purchase entries can be viewed from the Journal. To open the journal, click 
the Journal icon on the toolbar of any tab, or press Ctrl+V. When the View Journal window 
opens, you will see a list of all journal entries, whether payment, receipts, sales, or 
purchases, by default. To view all payments, select the Payments tab. To edit a payment, 
click to select a payment entry, then click the Edit
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 button in the toolbar to open the Journal Entry dialog. You can edit the amount and which 
accounts the payment was allocated to or from. Click Record  to save any changes. 
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Common Tasks - Receive Money
Use Express Accounts to keep track of the payments and income you receive for your 
business. 
Enter a Customer Payment

To enter a payment, click the Transactions  menu and select Receive a Payment, or you 
can simply click the Payments  button in the Sales  toolbar. This brings up the Payment 
dialog.
Enter the customer making the payment (the customer must first have a customer record to 
appear in the list; see the Customer ~ Customer topic in the Screen References section of 
this manual), the amount paid, the method of payment, include the invoice number 
(optional), and allocate which accounts the money should be applied to. When all the details 
are filled in correctly and your accounts balance, click the Record  button to apply the 
payment.
For more details on the Payment dialog, view the Payment topic in the Screen References 
section of this manual.
View and Edit Customer Payments
To view all customer payments entered, click the View icon in the toolbar and select Payme
nts.  You will see a list of all payments made. To easily find a payment you are 
looking for, you can click the headings of each column to sort by that heading. You can also 
designate a time period to limit the number of payments shown in the list, or view payments 
by customer only. For more details on all the options in this window, see the Payments List 
topic in the Screen References section of this manual.
To edit a payment, select the payment by clicking it in the list and then click the Edit icon in 
the toolbar. Make the necessary edits to the payment, and when the accounts balance, click 

 to apply the change to the payment.
View Payment Report
The payment report displays all payments entered into Express Accounts for the specified 
amount of time. To generate a payment report, click the Report tab and select Sales 
Invoice Payment Report. Specify the time period the report should cover, and click View. 
The report results will appear in the Sales Invoice Payment Report window. You can 
preview a .pdf of the report or email, print, fax, or save a copy of the report .pdf using the 
icons in the toolbar.
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Common Tasks - Manual Journal Entries and Edits
The journal is where you view all transactions for all accounts kept in Express Accounts. You 
can view the journal by clicking the Journal  icon in the toolbar of any tab to open the View 
Journal dialog, or press Ctrl+V. 
Make a Manual Journal Entry
General payments, purchases, receipts, and sales should, in general, not be entered manually 
into the journal, but there are cases when you might need to account for changes in your 
accounts using this method. Speak to your accountant if you are unsure when to make manual 
journal entries.

To make a manual journal entry, begin by opening the Journal by clicking the Transaction  
menu and select Manual Journal Entry to pull up the Journal Entry dialog. This dialog can 
also be found from the View Journal dialog by clicking the Add  button in the toolbar.
Select which journal the entry should be applied to, and make a journal memo (optional). In 
the Account Allocation area, select an account(s) to debit money from, and account(s) to 
credit money to. When the accounts are balanced, click Record  to save the journal entry.
Edit a Journal Entry
If an entry on the journal needs correcting, you can click the entry to select it, then click the 

 button in the toolbar to open the Journal Entry dialog for that entry. Make the 
necessary corrections, and when the accounts are in balance, click the Record  button to 
apply the changes to the journal.
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Common Tasks - Reconcile an Account
When the time comes to reconcile your records with your bank statement, Express Accounts 
has tools to help make sure all transactions are accounted for. You can reconcile manually, or 
upload your electronic bank statement into Express Accounts for faster reconciliation.
Reconcile Account Manually

To begin reconciling an account, gather your bank records, then click the Transactions 
menu and select Reconcile Account to open the Reconcile Account dialog. Select the 
account you would like to reconcile from the Account drop-menu, and the account's 
unreconciled journal entries will be displayed in the Local Ledger Transactions section. 
Select the Bank Statement Date, and enter the balance provided on your bank statement.
As you compare the Local Ledger Transactions list to your bank statement, tick off the 
entries that match.
● If an entry contains an error Double-click the entry, select it in the resulting window and 

click Edit on the toolbar to make changes to the entry. Click Record  to apply the 
change.

● In an entry needs to be deleted  Double-click the entry, select it in the resulting window 
and click Delete on the toolbar. Confirm the deletion, then close the View Journal 
window to return to your reconciliation.

● If an entry is missing  For a missing payment or purchase, click the Add a new 
payment transaction  button under the ledger list. For a missing customer receipt or 
sale, click the Add a new receipt transaction button under the ledger list. Enter the 
missing details and when the accounts are in balance, click Record  to apply the 
payment. The new transaction will appear in your local ledger list and will be checked off 
as reconciled.

Once all the entries are checked off and the account shows a $0.00 amount in the Out of 
Balance field, click the Reconcile  button at the bottom of the window to record the 
statement reconciliation.
For more information on this dialog, view the Reconcile Account  topic in the Screen 
References section of this manual.
Upload Bank Statement
Click the Load a bank statement button under the Bank Statement's list, which should be 
empty at this point. Browse to the bank statement file. Express Accounts can only load files 
in .csv or .ofx format. Click Open to load the statement into the Reconcile Account dialog.
Express Accounts will compare your local ledger with the bank statement and will match 
transactions for reconciliation to save you time. In your local ledger list (the list on top), 
reconciled transactions will be checked off and highlighted in green. Items that remain 
unmatched in your local ledger list may contain errors.
Items that appear in the bank statement list (the lower list), but not in your local ledger list 
can easily be added. Select the entry from the bank statement list and click the Add 
Transaction  button. The transaction will be added to the local ledger list and will display as 
a reconciled entry.
In the bank statement list (the lower list), entries that appear in red are highlighted as 
possible recurring transactions. If you select the entry and click Add Transaction, the entry 
will be added to the local ledger list, and will be automatically added to the local ledger list 
every time a bank statement containing the entry is loaded to the Reconcile Account dialog.
For more information on this dialog, view the Reconcile Account  topic in the Screen 
References section of this manual.
Recalculate Balances
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During reconciliation, if you are making changes to journal entries, the changes might not 
refresh as they should. If you find your accounts are not balancing, try recalculating the 
balances in Express Accounts to see if it helps with your reconciliation. To do this, exit 
reconciliation and click the Transactions  menu option in the main window and select Recal
culate Balances.  Express Accounts will run a recalculation automatically, and you 
can return to your reconciliation without taking further action.
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Common Tasks - Recalculating Customers' 
Balances
If you want Express Accounts to recalculate customers' balances, perform this task if you think 
there is something wrong with the balance.
Recalculate Customers' Balances  

If you are making changes to journal entries, the changes might not refresh as they should. 
If you find your accounts are not balancing, try recalculating the balances in Express 
Accounts to see if it helps. To do this, click the Transactions  menu option in the main 
window and select Recalculate Customers' Balances.  Express Accounts will run a 
recalculation automatically. 
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Common Tasks - Payroll
We recommend using a payroll service to process your payroll. We have provided a directory 
of businesses that offer payroll services. Use any of the companies on that list with Express 
Accounts and you will have a full business accounting system. We offer this directory as a free 
service to assist our customers finding payroll service providers.
To access this directory visit: http://www.nchsoftware.com/accounting/payroll.html
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Common Tasks - Pulling Reports
There are a variety of reports you can generate in Express Accounts. To view a complete list of 
the reports available, click the Reports tab. The reports Express Accounts can generate 
include:
● Balance Sheet - view a summary of the business's assets, liabilities and equity from a 

specified date.
● Chart Of Accounts - view a list of all the accounts in the Chart of Accounts, including the 

account number and type, and whether entries to the account debit or credit the account.
● Income Statement - also referred to as a Profit and Loss Statement, or P & L. View a report 

of the business's revenue during a specified time period.
● Income Statement Analysis- a comparison of two Income Statement periods.
● Account Enquiry - view the transactions on any account and its balance for a specified time 

period.
● Cash Flow Statement - view the cash generated during a specified time period.
● Trial Balance - view the balances of your credit and debit accounts over a period of time to 

check for accounting errors.
● Unpaid Accounts Report - view a list of all customers with an outstanding balance.
● Invoices Report - view a list of all invoices created during a specified time period.
● Quotes Report - view a list of all quotes created during a specified time period.
● Orders Report - view a list of all sales orders created during a specified time period.
● Sales Invoice Payment Report - view a list of all invoice payments received during a 

specified time period.
● Salesperson Report - view a list of salespeople, their dollar amount in sales, and the 

percentage of total sales they made during a specified time period.
● Item Sales Report - view a list of all items sold, and the dollar amount the item generated 

during a specified time period. The quantities reported in this report may be different to the 
inventory report, because the item sales report contains the items sold as reported in 
invoices for a specified period of time, where as the inventory report is a current snapshot 
of on-hand items quantities available for sale. 

● Items Per Customer Report - select a customer and view the items they have purchased by 
quantity.

● Customers Report - view a list of all customer's balance, their due date, last invoice 
number, and the contact number.

● Customers Sales Report - select from a list of customers showing each customer's total 
invoice amount, and the total payment amount.

● Inventory Report - view a list of all inventory items, their unit value, and the total value of 
your on-hand inventory. The quantities reported in this report may be different to the item 
sales report, because the item sales report contains the items sold as reported in invoices 
for a specified period of time, where as the inventory report is a current snapshot of 
on-hand items quantities available for sale. 

● Reconciliation Report - view a list of all accounts, their reconciled amount, during a 
specified time period.

● VAT Report - view the VAT reclaimed, due, amount to be paid and total income and 
expenses during a specified time period. (available only if you live in a country that uses 
VAT)

● Accounts Payable Report - view the accounts payable during a specified time period.
● Payments of Accounts Payable Report - view the payments of accounts payable during a 

specified time period.
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● Consolidated Reports - select a business and choose to view the balance sheet, income 
statement, or cash flow statement for that company.

● Mileage Reports - select one of three types of mileage reports (generated for a specified 
time period): a general summary showing the mileage accrual of all vehicles, a detailed 
mileage report showing each trip for a vehicle, and a customer report showing all the 
mileage associated with a customer.

● Accounts Receivable Aging Report - view a report for outstanding balances according to 
the amount of time they have been outstanding. Report can be be filtered by customer.

● Budget Report - select a budget and view the differences between the actual and allocated 
amounts.

● Custom Reports - select this to begin creating customized reports for your business. 
Please see the Custom Reports help page for more information on how to use this feature.
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Common Tasks - Options
The program options can be accessed by clicking the Options button on the toolbar. There 
are several tabs on the Options dialog that allow you to configure different program options. To 
open the Credit Note and Packing Slip dialogs, click their buttons on the Invoice tab. To open 
the Order dialog, click its button on the Quote tab.
● ~ Business
● ~ Accounting
● ~ Regional
● ~ Sales Tax
● ~ Payments
● ~ Inventory
● ~ Page Layout
● ~ Page Styles
● ~ Invoice
● ~ Quote
● ~ Sales Order
● ~ Purchase Order
● ~ Credit Note
● ~ Packing Slip
● ~ Receipts
● ~ Checks
● ~ Statements
● ~ Web Access
● ~ Other
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General - CSV Import Wizard: Select CSV for 
Import

Select CSV for Import
CSV Import File  
Enter the name of the CSV file containing the import or click the adjacent button to open a file 
browsing dialog. 
A CSV (Comma-Separated Value) file contains data entries separated by a comma. Many 
spreadsheet applications allow the user to save entered data in the CSV format. 
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General - CSV Import Wizard: Match Data Fields
Match Data Fields
This page of the wizard provides a means of associating the headers in your CSV file with the 
fields supported by Express Accounts Accounting Software Free. 
To assign a header to a specific field, click on the cell adjacent to the field. A list of unassigned 
headers will display, from which you may select the header you wish to assign. 
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General - CSV Import Wizard: CSV Import Results
CSV Import Results
The results page shows how many items were successfully imported, how many rows failed to 
produce an import, as well as all relevant errors generated during the import. 
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Advanced - Application Integration with Inventoria
Use this help page to troubleshoot the most common problems when attempting to 
synchronize items or quantities with Inventoria. 

Unable to connect to [host name] through port [port number].
Express Accounts was unsuccessful in its attempt to connect to the server program. Confirm 
that the server program is running and has Web Access enabled. Verify that the host name 
entered into Express Accounts is the correct host name or IP address of the computer which is 
running the server and that the port number entered into Express Accounts matches the port 
number through which the server accepts web connections. 

Connection rejected -- LinkSync not enabled by [program name].
The synchronization behavior is not enabled by any business in the server program. Complete 
the setup process for Application Synchronization in the Options dialog of the server program. 

Connection rejected -- invalid authorization key.
The authorization key entered into this instance of Express Accounts does not match that of 
the server. The authorization key is case sensitive and must exactly match the authorization 
key entered into the server program. 

Quantity change failed -- invalid location name: [location name].
Express Accounts is attempting to update quantities for an item at a location that does not exist 
in the server Inventoria program. The location name entered into Express Accounts is not case 
sensitive but must otherwise match the name of one location in the server Inventoria. 

Quantity change failed -- invalid item name: [item name].
Express Accounts is attempting to update quantities for an item that does not exist in the 
server Inventoria program. The most likely cause of this error is that the item was created 
locally or deleted from the server Inventoria after the most recent item synchronization. 
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Advanced - Multiple Businesses
Express Accounts will keep accounting records for multiple businesses with a single 
installation. To create a new business, click the Accounts  menu and select Multiple 
Businesses, then click Add.  The Startup Wizard will run, where you enter the basic details of 
the new business.
To toggle between different businesses, click the Accounts  menu and select Multiple 
Businesses, highlight the business you want to view and click the Select button. The other 
business will be loaded into Express Accounts.
To quickly see which account you are viewing, look at the Title bar in the upper left of the 
Express Accounts main window, and the business name will be displayed in brackets.
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Advanced - Multiple Currencies
Express Accounts handles a business dealing with multiple currencies as a different business 
for each currency. For example you could create one "business" called YourCompany - USD 
and another YourCompany - Euro. Each could handle sales tax, VAT separately and you can 
print reports entirely separately for the US dollar account or the EURO account. Each account 
must be set up separately with its own customers, contact details etc.
To add a new currency to the business: from the Accounts  menu select Multiple Businesses,

Add.  The Startup Wizard will run. It is recommended you name the new business 
currency something logical like YourCompany - Australian Dollar. Remember, treat it as an 
entirely new business.
Assign appropriate tax rates and currency notation in the Options settings on the Tax and Re
gional  tabs. See the Options ~ Tax and Options ~ Regional  help topics in this manual for 
more details.
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Advanced - Mail Merge
Mail Merge is a powerful tool that is included in most new word processing applications. When 
understood and used effectively it can cut down the time taken to do bulk tasks, like sending 
letters to customers, exponentially. This section of the help is not just limited to exports from 
Invoice either, if you take the time to read and experiment with what's said on this page you 
can set up Mail Merge with other applications increasing productivity even more. To make 
things easier read the instructions entirely before following them step by step. 
Mail Merge is a 6 step process: 
1. Create a data file.
2. Connect the file to a document.
3. Write the document you want to bulk send.
4. Insert 'place holders' in the document that correspond to parts of the data file.
5. Select which entries in the data file are to fill the 'place holders'.
6. Merge the data file and the document
If some (or all) of that doesn't make sense now don't worry, everything is detailed step by step 
below using Invoice and Microsoft Office Word 2007 and Invoice and Open Office 2.2 Writer as 
examples. Just keep in mind as you are reading that any program that advertises a mail merge 
feature will need to have ways of doing the above steps, all you have to do is figure out which 
buttons to press to do them (and if it's not immediately obvious then you may want to consider 
using another program!). 
Step 1: Create a data file 
The point of this step is to create a file that is able to be 'understood' by whatever program is 
doing the merge. Nearly all programs that can mail merge (including Microsoft Word and Open 
Office Writer) are able to 'understand' a file type called 'CSV' so when we want to create a data 
file from within Invoice, Invoice automatically 'exports' the file as 'CSV'. There are two different 
possibilities for CSV files within Invoice: 
● Customer details
● Reports
In our example we'll export the customer details to a CSV file. Follow similar steps to those 
found below to export a Report, just select 'Save as CSV' from the file menu of the report 
screen. 
1. Go to view then select Customers from the main menu (or you could press Ctrl+C)
2. Select the customers who you wish to export the data from (hold down Ctrl and click to 

select multiple customers)
3. Go to Customer in the menu and select Export Data for Mail Merge
4. Navigate to the folder you want the file to be in and type a name for the file, then click 

Save. Make sure you remember or write down where you have saved the file as you'll need 
to know this later.

5. A box should pop up saying whether the export has been successful or not. Read it and 
click OK.

Congratulations! You've just exported the file, which now contains all the following data for the 
customers you selected: 
● The customer's name
● The contact person
● The contact person's first name
● The first 4 lines of their address
● The customer's fax number
● The sales person who dealt with that customer
Step 2: Connect the file to a document 
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This step connects the data file and the document together ready to be 'merged'. Instructions 
on how to do this for Microsoft Office Word 2007 and Open Office 2.2 Writer are below. 
Microsoft Office Word 2007 
1. Start Word.
2. Click on the tab at the top of window that says 'Mailings'.
3. Click 'Select Recipients' in the Mailing tab, then scroll down and select 'Use Existing List...'
4. Navigate to the folder where you exported the CSV file, select it and click Open.
Open Office 2.2 Writer 
1. Start Writer.
2. Go to File then New then select Spreadsheet.
3. In the spreadsheet window open the CSV file.
4. Go to File then Save As, from the drop down box select the dBASE format and click Save.
5. Close the Spreadsheet program.
6. Back in Writer go to File then New then select Database.
7. In the box that pops up select 'Connect to an existing database' then from the drop down 

menu select dBASE and click Next.
8. Click on Browse and find the folder where you saved the dBASE file in the Spreadsheet 

program. Select it and click OK then click Next.
9. Make sure that 'Yes, register the database for me' is selected and both of the checkboxes 

are NOT selected. Click Finish and save this file where you saved the dBASE file.
10. Finally go to View and click 'Data Sources' if your file isn't there then right click on the left 

window go to 'Registered databases...' select your file and click ok.
Step 3: Write the document  
This is pretty self explanatory. The only difference is that whenever you want to write 
something that would be contained in the data file you just connected, leave a space. If you 
feel confident, you can combine this step with next one inserting place holders as you go to 
save you having to come back later. 
Tip: Make sure you put spaces where they are needed around the place holders, they're not 
put in for you e.g. Dear < < Customer_Name> > , merges to -> Dear Bob, where as Dear< < 
Customer_Name> > , merges to -> DearBob, 
Step 4: Insert place holders 
This step is to tell the program where to put different parts of the data file. To do this you insert 
place holders in the place of where you would normally manually type the data. When you 
eventually merge, these place holders will be replaced with data from the data file. 
Microsoft Office Word 2007 
1. Click the part of the document where you want to insert the place holder.
2. Click 'Insert Merge Field' in the Mailing tab, then scroll down and select the place holder 

you want to insert.
Open Office 2.2 Writer 
1. Click the plus next to your database in the view data source window.
2. Click the plus next to the Tables icon.
3. Double click on the table that is listed.
4. In the window to the right you should see all the data contained in the file organized into 

columns. Click and drag the column names into the document where you want the place 
holders.

Step 5: Select parts of the data file 
Microsoft Office Word 2007 
1. Click 'Edit Recipient List' in the Mailing tab.
2. Check or uncheck the appropriate boxes that correspond to the data you want to insert.
Open Office 2.2 Writer 
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1. Click the 'Mail Merge' button from the data sources toolbar.
2. Go to Step 6, you can click the left and right arrows to preview what the finished document 

will look like, if there is a particular part of the file you don't want included then preview it 
and check the box 'Exclude this recipient'.

Step 6: Merge 
Microsoft Office Word 2007 
1. Click 'Finish & Merge' in the Mailing tab, scroll down and select 'Edit Individual 

Documents...'
2. Select 'All' and click OK
3. A new document will pop up with all the merging taken care of! Make sure you save, print, 

email or do whatever you wanted to do with the document before closing it.
Open Office 2.2 Writer 
1. Still in the mail merge wizard having completed Step 6 go to Step 8.
2. This will open the merged document, from here you are presented with several options. 

Each is pretty self explanatory.
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Advanced - Data Backup
It is essential to back up your Express Accounts data often in the event that you lose data. 
Express Accounts gives you several options for backing up your data, and makes it easy to 
restore your data when you need it.
To back up data, click the Accounts  menu and select Back Up Data. Select a method for 
backup depending on how you would like to access the data later on.
Restore Backup Data  
To restore data, click the Accounts  tab and select Restore Data.
Restore scheduled backup: Can be set to restore backup data from a particular date. 
Scheduled to run at the same time every day.
Restore manual backup : To restore data manually, browse to the location of your backup file. 
Confirm you want to restore by clicking OK. 
See also:
● Backup Data in the Screen References section
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Options - Options ~ Business
The Business section is where you enter details about your business or company that appear 
on invoices, quotes, orders, reports and other documents. To open the Business section, click 
the Options icon on the toolbar and select the Business  item on the left (selected by default).
Business Type  
Select the radio button which best describes your business. This only affects the headings on 
invoices, these headings can be changed later either by choosing the business type in the Busi
ness  section in Options or by changing the text for the individual headings under Invoice
Text  in the Invoice  section in Options.
Business Name  
Enter the official name of the business (e.g., Acme Corporation, Inc).
Registered Number  
In many countries, each business has an official number which must be displayed on the 
invoice. Please enter it here.
Address  
Enter the address of your business as you want it to be printed on the invoice.
Contact Details 
Enter the contact details you want on the invoice. For example, phone, fax and email address.
Logo Image File  
To add your logo to invoices, statements and other reports, you can select the file path to a 
jpg/bmp/gif/png image.
Configure Multiple Businesses...  
Express Accounts can keep accounting records for multiple businesses with a single 
installation. Click this button to add, select or edit businesses. This feature can also be used to 
support multiple currencies by allowing a new business to handle a new currency type. 
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Options - Options ~ Accounting
Fiscal Year End  
This is the end of the financial year for the company for accounting and taxation reasons.
Prohibit transactions being entered beyond 1 year in the future 
Check this box to prohibit transactions being entered beyond 1 year in the future. 
Include $0.00 balances in reports  
Tick this option to include $0.00 balances in reports.
Negative Amounts 

Use parentheses '(' and ')' 
Tick this option to use parentheses '(' and ')' to designate negative amounts in reports.
Use minus '-' as the prefix 
Tick this option to use minus '-' sign as the prefix to designate negative amounts in reports.
Numbering

This list is used to define the prefix and item number for various entries to uniquely identify 
them. Note that the prefixes are optional. 

Invoices
The current Invoice prefix and Invoice number are displayed. You can change either to suit 
your needs. The number will increment by one each time an invoice is entered.
Quotes
The current Quote prefix and Quote number are displayed. You can change either to suit 
your needs. The number will increment by one each time a quote is entered.
Sales Orders
The current Sales Order prefix and Sales Order number are displayed. You can change 
either to suit your needs. The number will increment by one each time a sales order is 
entered.
Purchase Orders
The current Purchase Order prefix and Purchase Order number are displayed. You can 
change either to suit your needs. The number will increment by one each time a purchase 
order is entered.
Credit Notes
The current Credit Notes prefix and Credit Notes number are displayed. You can change 
either to suit your needs. The number will increment by one each time a credit note is 
entered.
Receipts
The current Receipt prefix and Receipt number are displayed. You can change either to suit 
your needs. The number will increment by one each time a receipt is created.
Checks
The current Check prefix and Check number are displayed. You can change either to suit 
your needs. The number will increment by one each time a check is entered.
Payments made
The current Payments made prefix and Payment Number are displayed. You can change 
either to suit your needs. The number will increment by one each time a payment is entered.
Payments received
The current Payments received prefix and Payments received Number are displayed. You 
can change either to suit your needs. The number will increment by one each time a 
payment is created.
Sales
The current Sales prefix and Reference Number are displayed. You can change either to 
suit your needs. The number will increment by one each time a sale is entered.
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Purchases
The current Purchases prefix and Receipt Number are displayed. You can change either to 
suit your needs. The number will increment by one each time a purchase is entered.
Journals
The current Journal prefix and Journal Number are displayed. You can change either to suit 
your needs. The number will increment by one each time a general journal entry is made.
Chart of Accounts  
Edit Chart of Accounts... 
Click this button to manage your chart of accounts, and edit the various properties.
Link Default Accounts... 
Click this button to link default accounts to various types of transaction entries.
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Options - Options ~ Regional
The Regional tab of the Options dialog is where settings specific to your region are set. Some 
default settings are set automatically according to the location entered for the business in the 
startup wizard. To open the Regional tab, click the Options icon on the toolbar and click the R
egional  tab. 
Country
This is the country of your business.
Currency Symbol
This is the symbol used for money in your country, such as $.
Currency Name
This is the name used for money in your country. For example, Dollars or Pounds.
Currency subunit
This is the name used for the money subunit in your country. For example, Cents or Pence.
Currency Order
Use this option to select if the currency symbol is before the number (e.g., $10.00) or after the 
number (e.g., 10.00$).
Currency Digits
Use this option to set the number of digits after the decimal point. It can be set to zero, one, 
two or three.
Decimal Symbol
This is the symbol used for the decimal point; usually a dot everywhere but in Europe, where a 
comma is used.
Thousands Symbol
This is the symbol used to separate thousands; usually a comma.
Printed Date Format
This is the date format used for printing or pdf generation.
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Options - Options ~ Sales Tax
The Sales Tax page of the Options dialog is used to configure any sales tax, GST or VAT rates 
that are applied to items. Some default taxes are set automatically according to the location 
entered for the business in the startup wizard. To open the Sales Tax page, click the Options 
icon on the toolbar and click the Sales Tax link. 
Tax Rates  
Add  
Click the Add button to add a new tax rate to the list. This action will open the Tax Rate dialog 
where you will enter information about the new tax rate.
Edit 
Click the Edit button to edit the details of the tax rate selected in the list.
Delete 
Click the Delete button to delete the tax rate selected in the list.
Reset Tax Rates  
Click the Reset Tax Rates button to reset all the the tax rates in your list.
Items have this tax rate by default 
Any new item will have this rate selected by default.
Item prices are tax inclusive (presumed to already include tax)  
If this is ticked, all items subject to tax will be priced and displayed as being tax inclusive.
By default new customers are tax exempt  
If ticked, any new customer will be marked as tax exempt (so no sales tax will be applied). Use 
this if you mainly export.
Display combined tax rates separately  
When this option is enabled, Express Accounts will display the sub tax rates separately instead 
of the combined tax name.
Show sales tax rate as column on invoice 
Select this option if you would like to display the sales tax in percentage and/or name in the 
item rows.

Show sales tax rate percent (e.g., 8.90 %) 
Select this option if you would like to display the sales tax in percentage in the item rows.
Show sales tax name (e.g., GST) 
Select this option if you would like to display the sales tax name in the item rows.
Show sales tax amount as a column on invoice (e.g., $9.56)  

Select this option if you would like to display the sales tax amount in the item rows. 
Track sales tax paid  
When this option is enabled, Express Accounts will allow tracking of any taxes you pay for 
when entering purchases from suppliers. This option is primarily used in countries where input 
tax credits can be reclaimed.
VAT Reporting period (available for users in the United Kingdom only) 
Use this option to set your VAT Reporting period. Currently supported are monthly reporting 
and quarterly reporting.

I report my VAT monthly 
Select this option if your business reports VAT monthly.
I report my VAT quarterly  
Select this option if your business reports VAT quarterly.

Start months of VAT period 
Select the starting months of your quarterly VAT reporting periods.
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Options - Options ~ Inventory
If you use NCH Software's inventory program, Inventoria, you can synchronize data about 
stock quantities between Inventoria and Express Invoice. 
Show warning for items that aren't in stock 
Check this box to show a warning during Invoice/Sales Order creation if invoiced/ordered items 
aren't in stock.
Inventoria Synchronization Settings  

Allow Express Accounts to synchronize with Inventoria 
Check this option to permit Express Accounts to connect remotely with Inventoria for 
downloading current item data and uploading quantity changes.
Access Authentication Code (match it to server program):  
Enter the code that Express Accounts will use to connect to a server Inventoria program.
IP Address of server program (not including 'http://'): 
Enter the address or IP of the server program to which Express Accounts should connect.
Port number used by server program: 
Enter the port number used by the server program to accept web connections. Inventoria 
has a default port number of 1097.
Location name for this business profile:  
Select or enter the name of the location in the server Inventoria which corresponds to the 
current business profile in Express Accounts.
Retrieve Locations  
Use this button to request a list of locations existing in the server Inventoria.
Update Now  
Use this button to immediately perform an item synchronization using the current settings. 
Note this will import all items from the server Inventoria, but it will only update the quantities 
from items at the selected location.

62



Options - Options ~ Page Layout
The Page Layout page of the Options dialog is used to specify how your printed pages will be 
laid out, including paper size, margins, and if you want to set the placement of the Bill-to and 
Ship-to addresses for windowed envelopes. 
Paper Size 
Select the paper size you will be printing your invoices, reports and statements on from the 
drop menu. It is also the paper size used for pdf generation. 
Logo Height 
The logo height field determines the size of your logo when it is printed. The logo will be 
enlarged or reduced according to the height entered while still maintaining the correct aspect 
ratio. 
Please be aware that overly large logos may be overprinted with the header text. 
Margins 
Set the margins for all reports, invoices, orders and quotes here by entering new margins for 
the top/bottom and the sides.
Windowed Envelopes 
This section of the layout page allows you to customize the positioning of the Bill-to and 
Ship-to addresses, and the company info block, to align with windowed envelopes.
Enable Address Positioning
When this option is checked, the billing and shipping addresses will be offset to the default 
settings shown in the boxes below. Please note that enabling this feature may create conflicts 
with the positioning of other elements on your invoice. Check the Page Styles page and 
preview your template or page styles to make sure no overlap occurs between different text 
elements.
Bill-to and Ship-to Address Offset
When the Enable Address Positioning option is enabled, you can adjust the position of the 
Bill-to and Ship-to address. Enter values for how far the address should be from the top and 
left edges of the envelope when the invoice is folded.
Enable Company Info Positioning
When this option is checked, the company info block will be offset to the default settings shown 
in the boxes below. Please note that enabling this feature may create conflicts with the 
positioning of other elements on your invoice. Check the Page Styles page and preview your 
template or page styles to make sure no overlap occurs between different text elements.
Company Info Address Offset
When the Enable Company Info Positioning option is enabled, you can adjust the position of 
the company info block. Enter values for how far the company info should be from the top and 
left edges of the envelope when the invoice is folded.
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Options - Options ~ Page Styles
The Page Styles page of the Options dialog is where you can create or select a page style that 
suits your business. Use this page to add decorative elements such as borders, lines and color 
to your invoice, as well as adjust the font settings and move text elements around the page to 
create the invoice look you need. 
Select a Template 
Select a Template from the template thumbnails to set the pre-styled decorative elements.
Express Accounts provides the following page style options: 
● Default This is a simple black and white template without extra design elements. 
● Custom  Select this option to create your own page style from scratch. When you select 

this option, the last saved custom invoice options you set will appear in the settings. 
● Pre-styled List  The list of pre-styled invoices, including Blue Trim, Blue Velvet, Citrus 

Splash, etc., allow you to select an invoice that is already configured with a colorful, 
professional look. It is possible to customize a pre-styled invoice by selecting the template 
from the list, then making any necessary changes to the settings. 

Preview Template 
Click the Preview Template button to save your current settings and view your template. Any 
change you make to the page style can be viewed by clicking this button. 
Customize Template
Borders
The borders section allows you to place a border around your entire invoice, or to add lines to 
distinguish the upper and lower sections of your invoice. 

None  This option does not create a border. 
Border The options here allow you to apply borders with thick or thin lines, single or double, 
in either of the colors you selected in the above Colors section. 
Header and Footer  The Header and Footer options allow you to style the top and bottom 
of your invoice separately if you do not what a border around the entire invoice. The 
selections for Header and Footer allow you to apply thick or thin lines, single or double, in 
either of the colors you selected in the above Colors section. 
Header style appears above all text  
Check this option if you want the lines in the header to appear above any text on the top line 
of the invoice. When it is unchecked, the top line will be in line with the top text of the 
invoice, which gives another design option.

Text
The text attributes section is where you can specify how you want text to appear on the 
invoice. The attributes that you can change include the font, font size, font style, color, and 
alignment. See the topic for Text Attributes in this manual for more information on each text 
option. 

Use global text attributes 
Select this option if you want to apply the same text style to the entire invoice.
Set styles for each text section 
Select this option to apply different text options to individual text sections. The sections are:
● Invoice Title - This is the Invoice title that appears at the top of the invoice, if you select to 

show the title.
● Company Name - Adjusting the attributes for the company name affects only how your 

company name appears, not the company address and contact information, which is part of 
the "All Other Text" section below.
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● Heading Text - This adjusts heading text such as the Bill to and Ship to labels, and the 
column headings in the items table.

● All Other Text - This adjusts the text in the invoice details, company address and contact 
information, and billing and shipping addresses.

Accents
The text block accents section is where you can add a border, color block, or lines around 
specific areas of text on your invoice.

Use global text block accents 
Selecting this option will apply the same text accents to each text section on the invoice.
Set accents for each text block 
Select this option to apply different accents to individual text blocks. The sections are:
● Invoice Title - This is the Invoice title that appears at the top of the invoice.
● Invoice Details - This is the block of text that describes the due date, salesperson, invoice 

number, etc.,
● Company Info - This text block includes the Company heading, address and contact 

details. Check the Link Company Logo to this text block option to ensure your company 
logo always appears to the left of this text block. 

● Bill To and Ship To - the billing and shipping addresses.
● Item Table Heading - this is the heading of each column on the items table.
● Remittance Slip - refers to the remittance slip at the bottom of the invoice, when this option 

is turned on from the Options ~ Invoice Content page. 
Positioning 
The header block positioning section allows you to place blocks of text in specific areas around 
the top of the invoice print-outs. You see a grid structure of pull-down menus on the screen, 
which visually represents the rough placement of the selected block of text. For example, to 
make your company information appear in the upper right corner, you would select Company 
Info  from the top right drop menu. 

Colors
Color #1 and Color #2  

Click one of the color buttons to change the color scheme for the invoice. Many of the style 
settings refer to the colors selected here.
When the Color dialog opens, select from one of the basic colors, or for more advanced 
options, click the Define Custom Colors  button. In the expanded area, you can either select 
from an expansive color palette, or enter an RGB code. When you have chosen your custom 
color, click the Add to Custom Colors  button and click OK to apply the color selection to the 
invoice. 

Items List
Shade every other line on the item list 

Check this box if you would like every other line in the invoice list to be shaded, providing for 
increased readability when mulitple items are present in the list.
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Options - Options ~ Invoice
The Invoice Content page of the Options dialog is where you specify the content that appears 
on your invoice, and includes the option to customize different labels, such as column 
headings and other titles used on the invoice. 
Invoice, Quote and Order Options  

Show Item column  
Enable this checkbox to view the Item Code column.
Show Discount column 
Select this option to display the Discount column on 'Create New Invoices, Orders, and 
Quotes' windows.
Print salesperson name  
Enable this checkbox to print the salesperson on invoices,quotes and orders.
Hide Bill To and Ship To labels  
Enable this checkbox to hide Bill To and Ship To labels.
Replace %TEXT% in comments  
It is sometimes useful to print the Record number/Record total amount/Customer name in 
the foot or note comments. To do this enter in the foot/note comments with the word 
NUMBER, AMT, CUSTOMER, SUPPLIER circumfixed with percentages, i.e., %NUMBER% 
that way whenever a record is issued the %NUMBER% will be replace with the actual 
record number (%AMT% for total record amount, %CUSTOMER% with record's customer 
name, and %SUPPLIER% with record's supplier name [applicable for Bills and Purchase 
Orders only]). 
Invoice Options 
Print due date 
Enable this checkbox to print the due date on invoices.
Add 'Paid' text on invoices that have been paid 
Enable this checkbox if you want to place a 'Paid' text at the top of paid Invoices printout.
Add 'Overdue' text to invoices that are overdue 
Enable this checkbox if you want to place an 'Overdue' text at the top of Invoices that are 
overdue.
Add 'Copy' text to invoices that are re-printed  
Enable this checkbox if you want to place the word 'Copy' at the top of Invoices that have 
already been printed.
Include remittance slip at the bottom of the invoice 
Enable this checkbox if you want to include the remittance slip at the bottom of the invoice.
Invoice Text Items  

This is the text that will be printed on invoices, such as headings, titles and labels. Select a title 
or heading from the drop menu, then alter the text for that item in the field to the right. 
Custom Fields  
Custom Fields may be added to both the top and bottom sections of the printed Invoices. This 
will allow you to further customize the layout of your printed Invoices so that you can add in 
extra information custom to individual Invoices. The fields that you add will appear in the 
Invoice dialog where you may add in the Invoice specific information to be used for the printed 
Invoice. 
New Custom Fields may be added to the Invoice's top or bottom sections by clicking the Add  
button and selecting the section in the Top/Bottom column. The Custom Field name will be 
used as the field label in both the Invoice dialog and the printed Invoices. 
Selected Custom Fields may be deleted by clicking the Delete button. 
Note and Foot Comments 
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Text
Text entered here will appear at the bottom of the invoice printout or pdf.
Alignment / Font Size 
Choose an alignment (Left, Right, Center) and a font size (Normal or Small) for the Note 
comment.
Preview Invoice 

Click the Preview Invoice button to save your current settings and view your invoice template. 
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Options - Options ~ Quote
The Quote tab of the Options page is used to set the standard text that appears on printed 
quotes. You can preview any changes you make by clicking Preview Quote at the bottom of 
the Quote tab dialog. 
Quote Text Items
This is the text that will be printed on quotes. Select a title or heading from the drop menu, then 
alter the text for that item in the field to the right.
Note and Foot Comments
Text entered here will appear at the bottom of the quote printout or pdf. Choose an alignment 
and font size for the text. The foot comment will appear beneath any note comment.
Preview Quote
Click this button to save your settings and preview what the quote will look like.
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Options - Options ~ Sales Order
The Sales Order tab is where the standard text that appears on sales orders can be configured 
to meet your business needs. You can preview any changes you make by clicking the Preview 
Sales Order button at the bottom of the Sales Order dialog. To open the Sales Order dialog, 
click the Options icon on the toolbar, and click the Sales Order tab. 
Order Text Items 
This is the text that will be printed on sales order. Select a title or heading from the drop menu, 
then alter the text for that item in the field to the right.
Note and Foot Comments 
Text entered here will appear at the bottom of the order printout or pdf. Choose an alignment 
and font size for the text. The foot comment will appear beneath any note comment. 
Preview Sales Order  
Click this button to save your settings and preview what the sales order will look like.

69



Options - Options ~ Purchase Order
The Purchase Order Options dialog is where the standard text that appears on purchase 
orders can be configured to meet your business needs. You can preview any changes you 
make by clicking the Preview Purchase Order  button at the bottom of the Purchase Order 
Options dialog. To open the dialog, click the Options icon on the toolbar, and click the Purcha
se Order  tab. 
Order Text Items 
This is the text that will be printed on purchase order. Select a title or heading from the drop 
menu, then alter the text for that item in the field to the right.
Note and Foot Comments 
Text entered here will appear at the bottom of the order printout or pdf. Choose an alignment 
and font size for the text. The foot comment will appear beneath any note comment.
Preview Purchase Order  
Click this button to save your settings and preview what the purchase order will look like.
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Options - Options ~ Credit Note
The Credit Note page is where the standard text that appears on orders can be configured to 
meet your business needs. You can preview any changes you make by clicking the Preview 
Credit Note  button at the bottom of the Credit Note dialog. To open the Credit Note dialog, 
click the Options icon on the toolbar, and click the Credit note  tab. 
Accounts Receivable  
Select the account that credit notes should be linked to.
Credit Note text items  
Select the text type from the drop menu and type your custom text into the field to the right. 
Note and Foot Comments 
Text entered here will appear at the bottom of the credit note printout. The foot comment 
appears below the note comment. Choose an alignment and font size for the text of each 
comment type.
Preview Credit Note 
Click this button to save your settings and preview what the credit note will look like.
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Options - Options ~ Packing Slip
The Packing Slip dialog is used to set the standard text that appears on printed packing slip. 
You can preview any changes you make by clicking Preview Packing Slip at the bottom of the 
Packing Slip dialog. To find the Packing Slip dialog, open the Options dialog, and click the Pack
ing Slip  link in the left sidebar of the window under Page Layout. 
Packing Slip Text  

Packing slip title 
Enter your custom text for Packing Slip Title to be displayed on the printouts and pdf.
Note and Foot Comments

Text entered here will appear at the bottom of the packing slip printout or pdf. Choose an 
alignment and font size for the text. The foot comment will appear beneath any note comment.
Preview Packing Slip
Click this button to save your settings and preview what the packing slip will look like. Note that 
packing slips do not have the same style applied to them as invoices.
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Options - Options ~ Receipt
The Receipt tab of the Options dialog is used to set the text that appears on receipts and the 
way receipts are laid out. 
Small Receipts Options  

Use small size for printed Receipts
This option forces receipts to be printed within a width of 3 inches. It is intended for use with 
continuous receipt paper rolls.
Logo height
The logo height field determines the size of your logo when it is printed. The logo will be 
enlarged or reduced according to the height entered while still maintaining the correct 
aspect ratio up to the point where the logo will exceed 1/3 of the width of the receipt at 
which time the logo's width will not be increased even though the height still is. 
A logo jpg file must be specified on the Company tab of Options to appear on the receipt. 
Margins (in.)  
Set the margins for small receipts by entering values for the top/bottom and the sides.
Receipt Text Items

This is the text that will be printed on receipts. Select a title or heading from the drop menu, 
then alter the text for that item in the field to the right.
Note and Foot Comments
Text entered here will appear at the bottom of the receipt printout or pdf. Choose an alignment 
and font size for the text. The foot comment will appear beneath any note comment.
Preview Receipt
Click this button to save your settings and preview what the receipt will look like.
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Options - Options ~ Check
The Check Options page provides options for configuring the appearance of checks. The 
positions entered here are measured in inches and are relative to the entire size of the page. If 
"Print Voucher" is selected, instead the positions are assumed to be relative to the portion of 
the page the check will be printed on. 
To open this dialog, click the Options icon in the toolbar, and click the Check tab.
Text Placement (in.) 

Date Position 
The date position on the check, to align with the preprinted check by adjusting the 
positioning from the default position, in inches.
Supplier Name Position 
The supplier's name position on the check, to align with the preprinted check by adjusting 
the positioning from the default position, in inches.
Supplier Address Position 
The supplier's address position on the check, to align with the preprinted check by adjusting 
the positioning from the default position, in inches.
Amount Position  
The amount position on the check, to align with the preprinted check by adjusting the 
positioning from the default position, in inches.
Spelled Amount Position  
The spelled amount position on the check, to align with the preprinted check by adjusting 
the positioning from the default position, in inches.
Note Position 
The notes position on the check, to align with the preprinted check by adjusting the 
positioning from the default position, in inches.
Company Logo 
The position of your company logo, to align with the preprinted check by adjusting the 
positioning from the default position, in inches.
Company Name and Address  
The position of your company's name and address, to align with the preprinted check by 
adjusting the positioning from the default position, in inches.
Display Check Fields 
Show supplier's address 
Select this to show the supplier's address on the check.
Show currency symbol 
Select this to show the currency symbol if it is not already printed on your checks.
Show notes 
Select this to show notes on the check.
Show currency name  
Select this to show the currency name if it is not already printed on your checks.
Spell cents in words  
Select this to translate the cents to words.
Show company logo 
Select this to print your company's logo on the check.
Show company name and address  
Select this to print your company's name and address on the check.
Print Voucher 
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Select this to print vouchers along with the check. Vouchers are a copy of the check along 
with a list of each transaction the check is paying for. These transactions are referenced 
either by purchase orders linked with the check, or by any manually entered reference 
numbers.

Check with one voucher or Check with two vouchers  
These options split the check into equally sized portions (either one-half or one-third of 
the page), prints the check based on its selected position, and prints the vouchers on the 
remaining portions of the page.

Check on top , Check in middle, Check on bottom 
Select which portion of the page the check should be printed on. Note that it cannot 
be printed in the middle when "Check with one voucher" is selected.
Preview Check  

Click this button to save your settings and preview what the check will look like.
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Options - Options ~ Statements
The Statement dialog is used to set the text that appears on Customer and Supplier 
Statements, and the way some texts are laid out. You can preview any changes you make by 
clicking Preview Statement at the bottom of the Statement dialog. To access the Statements 
Options dialog, click the Options icon on the toolbar, and click the Statements  tab. 
Automatic Statements 
Customer statements can be automatically printed or sent at the end of each month. The 
statements can be sent to customers who have any amount due or customers who are 
overdue, depending on the option you select.

Send monthly statements 
Customer statements can be automatically printed or sent at the end of each month. The 
statements can be sent to customers who have any amount due or customers who are 
overdue, depending on the option you select.
Ignore amounts under 
This option helps avoid sending statements to customers who owe just a few dollars.
Statement Text Items  

This is the text that will be printed on statements. Select a title or heading from the drop menu, 
then alter the text for that item in the field to the right.
Comment 
Text entered here will appear at the bottom of the statement printout. Choose an alignment 
and font size for the text.
Preview Statement 
Click this button to save your settings and preview what the statement will look like.
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Options - Options ~ Other
The Other tab of the Options dialog is where various general settings can be configured, 
including email and fax settings, csv format settings, user access settings and more.
Send Settings 

Email Settings  
Please refer to Knowledge Base Articles - Problems when sending email using our software

Fax Settings  
Click the Fax Settings button to set up or view the fax gateway. An electronic gateway 
needs to be configured before you will be able to send faxes within Express Accounts. For 
more information and a list of recommended gateways, refer to 
http://www.nch.com.au/fax/services.html. 
Show financial summaries on the main window 

Check this option to display the summary of the income and account revenues on the bottom 
of the main window.
CSV Format Settings  

Save csv files in UTF8 character encoding 
Check this option to save csv files in utf8 character encoding.
Save as csv for Excel 
Check this option to save csv files that can be opened by Windows programs such as 
Excel, WordPad, etc...
User Access Settings  
Only allow administrators and specific user(s) to run Express Accounts  
Enable this checkbox to specify users and administrators that can run Express Accounts.
Allowed user(s): 
List specific users that can run Express Accounts (e.g. user1,user2).
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Options - Options ~ Payments
The Payments tab of the Options dialog is where credit card payments are configured, so that 
you can accept credit card payments from customers using Express Accounts. Credit card 
gateways can virtually take the place of physical credit card swipe machines and process your 
customer's payments securely. 
A list of the available credit card gateways appears on this page. If you do not see any 
gateways, click the Check for Updates  button to refresh the list. By updating the list, you will 
see credit card gateways that have been tested with Express Accounts. 
To configure settings for a gateway, select it from the list so that its name is highlighted, and 
click the Configure... button. To enable a credit card gateway for charging customers, check 
the box to the left of its name. Only one credit card gateway can be selected at a time. Note 
that if you do not enable a gateway by checking its box, credit card charging with Express 
Accounts will not be possible. 
For more information about each of the supported gateways, click the links below:
● Authorize 

● Authorize website: www.authorize.net 
● Authorize getting started guide www.authorize.net/files/gettingstarted.pdf 
● Also see the Authorize account settings topic in this manual. 

● Eway 
● Eway Australia website: http://www.eway.com.au/. More countries are available by 

clicking the flags in the upper right corner of this website. 
● Also see the Eway account settings topic in this manual. 

● PayPal 
● PayPal website: www.paypal.com. You will want to set up a PayPal account. 
● Also see the Paypal Account Settings topic in this manual. 

Check for Updates
Connect to the internet and check for updates, or for support for additional gateways.
Configure
Configure or adjust the settings for the selected account.
Payment Methods
When you apply a payment you select the payment method. This can then be used to create 
reports of payments and to aid reconciling statements. You can change the default list of 
payments by entering a comma separated list of the methods your company accepts here. An 
example is Check,Bank Deposit,Credit Card etc. 
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Options - Options ~ Web Access
The Web Access tab of the Options dialog lets you configure settings for the Express Accounts 
Web Interface. The web interface works by having Express Accounts run as a mini web server. 
To set up the web interface, you must first make sure the server is online. Bring it online by 
selecting either of the following checkboxes:
● Allow access to Express Accounts on the local network
● Allow access to Express Accounts from the internet (Cloud Access)
Next, specify a username and password to use as your logon details (this is done from the 
Web Access tab of the Options dialog). Next, specify what port on which you would like the 
web interface to run by clicking the Configure  button next to Local Network and Public 
Network links. The default port is 96, and we recommend that if you change it then you do not 
use port 80, because that port is often used by other web servers. 
To access the web interface from the Express Accounts computer, the easiest way is just to 
click on one of the hyperlinks shown in the dialog window - both links point to the same URL. 
Alternatively, type "http://localhost:[port]" into your web browser, where "[port]" is the port 
number you specified in the dialog. If you want to access the web interface from elsewhere on 
your LAN, or from the Internet, use the following formatting when typing the URL into your web 
browser: 
● http://computername:port e.g., http://mycomputer:96 (for use on a Local Area Network)
● http://privateip:port e.g., http://192.168.0.1:96 (for use on a Local Area Network)
● http://publicip:port e.g., http://212.137.22.14:96 (for Internet use)
● http://domainname:port e.g., http://axon.mycompany.com:96 (advanced option - only use if 

you have a domain name set up for your IP address)
You need to make sure your firewall is not blocking the port number you have specified. Refer 
to your firewall settings to check the correct UDP port is opened.
Speak to your network administrator about any networking problems you have. They can 
usually fix routing or firewall problems. You can also refer to 
http://www.nch.com.au/kb/10046.html for more information on networking problems and 
solutions. 
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Web Access - Introduction to the Web Access 
Feature
The web interface, or the web access feature, can be accessed online from any location, 
including any computer or mobile device with internet access. Using this feature is helpful for 
business that need to give multiple users access to the same data, or for businesses that need 
to update accounts and inventory, or invoice while on the road.
Setting up web access requires configuring one computer to allow access to the account 
information, and setting up a web account for each user who will be accessing Express 
Accounts. The following help topics in the Web Access section of this manual will guide you 
through the process. There are also video tutorials provided by NCH that demonstrate how to 
set up this feature, as well as how to troubleshoot any problems you may have connecting.
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Web Access - Setting up Web Accounts
Each person who has access to Express Accounts can be given a different level of User 
Privileges. The levels are:
● Administrator - has access to all businesses, can manage passwords for all users, can 

create and edit account and inventory data through the web interface, and can view reports.
● User  - has access only to assigned businesses, can create and edit account and inventory 

data, and can view reports.
● Viewer  - has access only to assigned businesses, can only view account and inventory 

data, and can view reports.
To create a web account, click the Options icon in the toolbar, and click on the Web Access 
tab. Click the Add  button to create a new user account. Enter a display name, an email 
address, and a password for the user. Make sure the Account Enabled check box is 
checked, and then assign the user a User Privilege level, and select which organization(s) the 
user should have access to. Click OK to finish.
See also:
● User Account
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Web Access - Configuring your Internet 
Connection for Web Access
To configure your computer for access to Express Accounts, click the Options icon in the 
toolbar, and click the Web Access tab. 
First, click the Start button to activate the server so you can access Express Accounts from a 
browser. The server must always be on ("started") for Web Access to work. You may see 
messages asking you to click Unblock or Allow if your computer prompts you for access. Make 
sure you allow this, or Express Accounts will not be available at other computers and devices.
Determine if your users will be accessing Express Accounts on a local network (where your 
computers can connect to each other without an internet connection), or if your users will 
access Express Accounts remotely using an internet connection.
For a local network,  create user accounts for each person as described in the 
Setting up Web Accounts topic in the Web Access section of this manual, then share the Local 
Network link in this dialog with the user.
For a public network,  you must ensure the routing section of this window does not show a 
red status error. If it does, you will need to resolve the error before Express Accounts will be 
available from the internet. This most likely will involve forwarding port 98 through your router 
and firewalls throughout your system. For help doing this, click the link that says Help to 
resolve this issue  in the routing section, or see http://www.nch.com.au/kb/10046.html. There, 
you will find a series of tutorials aimed at troubleshooting your connection problems. If the 
routing status is green, Express Accounts will be available to other users when they paste the P
ublic Network  access link into a browser and login with their user account details.
See also:
● Web Access Page knowledge base article http://www.nch.com.au/kb/10233.html
● Configure Local Network Web Access knowledge base article 

http://www.nch.com.au/kb/10234.html
● Configure Public Network Web Access knowledge base article 

http://www.nch.com.au/kb/10235.html
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Web Access - How to Log On to Web Access
To access the Web Access feature, you can use the links provided on the Web Access tab of 
the Options dialog for Local Network or Public Network, or click the Web Access icon in the 
toolbar. This will open up a browser window where the user will be prompted to enter their 
account details to log in. The same links can be used to gain access to the Web Access of 
Express Accounts from your mobile phone.
See also:
● Setting up Web Accounts
● Password Management
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Web Access - Password Management
When a new user is created, their password will not be visible to other users in Express 
Accounts, and will be displayed as a series of dots. Each user is able to change their password 
or reset their password
Change Password
Users can change their password to something more memorable from the web interface by 
clicking the Change Password  link from the right sidebar of the web interface. They will be 
required to enter their old password before a new password will be accepted. If the user cannot 
remember their old password, the will have to reset their password.
Reset Password
At the Login screen for Web Access, click the Forgot your password?  link. An email will be 
sent to the user with a new password. The user should use the new password to logon to the 
Web Access feature and update their password to something they can remember.
Note  In the event the user does not receive an email to reset their password, they will have to 
have a user with administrator user privileges reset their password for them through the main 
interface Options ~ Web Access or through the Web Access interface by clicking the Add/Edit 
Users  link in the right sidebar.
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Web Access - Web Access Interface Reference
The Web Access interface looks much different than the main interface of Express Accounts, 
but does allow users with Administrator and User privileges to accomplish the same tasks as 
within the main interface.
Main Screen
The main screen contains links to any part of Express Accounts you may need to access. To 
return to this screen from anywhere in the web interface, click the Main link in the upper right 
corner at any time.
The upper right corner of the main screen contains links to log the user off, and to view the 
help documentation to Express Accounts. All help files refer to the main interface of Express 
Accounts, but both interfaces use the same labels and terminology. Under those links, Express 
Accounts displays the user who is currently logged on, and which business the user is 
currently viewing.
The main area of the web interface is the control panel. It contains links for tasks Express 
Accounts, including:
● Invoices - view, edit, and create invoices and recurring invoices; view and print packing 

slips
● Manual journal entry - create a purchase or receipt transaction and allocate to the 

appropriate accounts
● View journal - view journal by payment, receipt, sales, or purchases according to date; edit 

entries; export journal to csv
● Reconcile account - Reconcile your records to your bank's records; upload bank statement
● Quotes - view, edit, and create quotes; turn quotes into sales orders and invoices
● Sales Orders - view, edit, and create sales orders and recurring orders; turn sales orders 

into invoices
● Purchase Orders - view, edit, and create sales orders and recurring orders
● Customer Payments - view customer payments by date, method, amount, invoice number 

or payment reference
● Items - view, edit, and create items; adjust inventory with purchase and sell icons
● Customers  - view, edit, and create customers records; view, print, or send customer 

statements
● Reports - view, print, or send any of the reports generated in Express Accounts
The right sidebar, labeled Actions, contains quick-access links to the most common tasks 
used in Express Accounts, including: 
● Create New Invoice - create a new invoice and save as a draft, record, send, or save as 

recurring
● Create New Quote  - create a new quote and save as a draft, record, or send
● Create New Sales Order  - create a new sales order and save as a draft, record, send, or 

save as recurring
● Create New Purchase Order - create a new purchase order and save as a draft, record, 

send, or save as recurring
● Make a Payment - enter a payment; enter a check and print
● Receive Money  - enter a receipt
● View Checks  - enter, view, and edit checks; print checks
● Add New Item - enter a new inventory item
● Add New Customer  - create a new customer record
● Add/Edit Users - create new web access user accounts (users with Administrator user 

privileges only)
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● Adjust Settings and Options - view and configure program settings (users with 
Administrator user privileges only)

● Select Company Profile - switch to another business
● Change Password - enter a new password
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Web Access - Setting Up Web Access
Express Accounts can be set up to run as a mini web server, giving you and your employees 
access to Express Accounts over the Internet, from any location, as long as the main computer 
running Express Accounts is left running. Setting up Web Access from your local computer 
also enables you to assign login information for different employees, giving them varying levels 
of access to Express Accounts features.
Once Web Access has been set up, you can login to the Express Accounts web interface and 
use the same features online as you do from the Express Accounts application.
Automated start up
Express Accounts can be set to run automatically when the computer starts. To enable this, 
tick the "Run Express Accounts automatically on start up" option. If you want to access 
Express Accounts remotely or over a network using the Web Access feature, you should select 
this option. 
There are many modes of running automatically, which you can select in the pull down list 
under the "Run Express Accounts automatically when you login" checkbox. The options are: 
● Start when any user logs on.
● Start when this user logs on only.
● Start before logon. Show all users’ tray.
● Start before logon. Show this user only.
● Start before logon. Do not show icon. 
Service Settings
Click the button to view the Service Settings. To learn more about running Express Accounts 
as a server, see the Service Settings help topic www.nch.com.au/kb/10049.html .
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Web Access Screen References - Select Company 
Profile
This page is where you can toggle between different business profiles.
To create a new business: in the desktop software, click the Accounts  menu and select Multi
ple Businesses , then click Add.
Select New Company Profile  
Click the drop-down menu and then select the business profile you want to use, then click OK. 
This will change all the viewable records to those associated with the selected business.
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Web Access Screen References - Supplier 
Additional Info
Opening Balance 
Enter the opening balance of the supplier.
Balance Due 
This is the current total balance due to the supplier.
Oldest Date Due  
This is the date that the last purchase order for the supplier was created.
Last Order 
This is the purchase order number for the last order for the supplier.
Main Options  
Click this to save any changes and then go back to the main details for the supplier.
Save Changes 
Click this to save any changes you have made and then go back to the supplier list.
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Web Access Screen References - Select Invoice 
Period
After you click the Invoices link from the control panel of the web interface, you will be asked to 
select a time period of invoices to view. 
Select Customer  
Select a customer or all customers from the pulldown menu.
Select Invoices 
Select a type of invoice to view from the pulldown menu: Recorded, Drafts, or Recurring 
invoices.
Select Period  
Select a period of invoices to view from the pulldown menu. If you want to enter a custom 
period, you must select Custom Period from the menu first.
Start Date  
If you want to view a custom time period, make sure Custom Period is selected in the Select 
Period pulldown menu above. Then, enter a beginning date for the invoice range you would 
like to view.
End Date 
Enter an ending date for the invoice range you would like to view.
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Web Access Screen References - Recurring 
Invoice Schedule
After you click the Save As Recurring button from the invoice dialog of the web interface, you 
will be asked to select a schedule of the invoice. 
Start Date  
Select the date when the recurring invoice will start.
Interval 
Select the interval of the recurring invoice. Choose from weekly, fortnightly, monthly, bimonthly, 
quarterly, 6 months, annually, or every 2 years for the interval.
Replace the string %period% in any description with dates.  
If you want to have the recurring date in the description, enabling this option will replace the 
text "%period" to the recurring date.
Update the prices of any items which have been changed. 
Enable this option to allow the prices of any items which have been changed.
Automatically charge the customer by credit card. 
Enable this option to automatically charge the customer via credit card.
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Web Access Screen References - Chart of 
Accounts List
Use the Chart of Accounts List to manage your accounts.: the number assigned to an account, 
the type of account, if it is a header account, and if it is an account open at the bank. The 
accounts are displayed in a list. To open the Chart of Accounts List, click the View chart of 
accounts link in the right-side navigation panel of the main page. This feature is not available 
for users with 'viewer' only privilege. 
Add New Account  
Click this button to create a new account.
Edit 
Click the Edit icon to edit the associated account.
Delete 
Click the Delete icon to delete the associated account.
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Web Access Screen References - Invoices List
Use the Invoices List to manage your invoices. To get here, click the Invoices link in the web 
interface control panel, then select a range of invoices to view based on time period. Here, you 
will see a list of all the invoices Express Accounts has created. 
You can refine the contents of this list by using the tabs at the top of the page to select 
Recorded, Draft, All, or Recurring invoices. You can use the Period drop menu to filter the 
listed invoices by date, and the Start and End date pickers can be used to fine tune the date 
period. The Customer drop menu can also be used to further narrow the invoice selection to a 
specific customer. Click Update to filter the invoices based on the criteria you selected. Users 
with viewer-only privileges will be unable to add and delete invoices. 
Add New Invoice  (not available on the Display Recurring tab) 
Click this button to create a new invoice.
Run Selected Invoice  (Display Recurring tab only) 
Click the Run Selected Invoice button to generate all currently due invoices for the selected 
recurring invoice, according to its schedule.
Edit 
Click the Edit icon to edit the associated invoice.
PDF 
Allows you to save your Invoice as a .pdf document.
Print 
This command will open a Print dialog window and allow you to print your Invoice or save it as 
a .pdf document.
Packing Slip  
Click the Packing Slip icon to download a packing slip as a PDF for the associated invoice.
Ship Label 
Click the Ship Label icon to download a shipping label as a PDF for the associated invoice.
Log  
Click the Log icon to view all activities associated with the associate invoice, such as emailing 
to customers.
Edit Schedule  
Click this button to modify the invoice schedule details.
Apply Payment (not available on the Display Recurring tab) 
Click this button to apply a payment.
Schedule  (Display Recurring tab only) 
Click the Schedule button to view and/or change the schedule for the selected recurring 
invoice, or to change the action taken when the invoice is generated (email, fax, print, save, 
etc.).
Delete 
Click the Delete icon to delete the associated invoice.
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Web Access Screen References - Add/Edit Invoice
The Add/Edit Invoice window is where you fill in the details for the invoice. To access the 
Add/Edit Invoice window, click Add New Invoice  from the Invoices List or click the edit icon of 
an existing invoice from the Invoices List. Users with viewer-only privileges will be unable to 
edit invoice details. 
Customer 
Choose the Customer from the pull down list, or enter a new customer. Adding new customer 
here will create a new record for the customer on Customer List so you can quickly access 
every time you create quotes, orders and invoices. 
Date 
Type in the invoice date or select a date by clicking the calendar 
Create From 
Choose an existing quote, order or draft invoice from the pull down list, or leave blank if you 
are not generating an invoice from an existing quote, order or draft invoice. 
Order Number  
When an invoice is generated from an existing order, this field displays the linked order 
number. Manually editing this field is not recommended. 
Terms 
The payment terms are used to calculate the payment due date. 
Days  
Enter the number of days the invoice is due from the invoice date. 
Deposit Account 
Select the invoice payment deposit account from the drop-down list. 
Ship By  
Select the shipping method from the drop-menu, or enter a new shipping method. The Ship By 
detail will be printed on the invoice for customer reference. Leave this blank if not required. 
Shipping Cost and Shipping Tax 
Enter any shipping costs associated with the invoice in the field. If any tax should be applied to 
the shipping, select the appropriate tax rate from the drop menu. Tax rates must be set up on 
the Options ~ Tax tab before they will be available here. 
Tracking Ref No. 
The tracking reference number refers to the shipping method, and is printed on the invoice for 
customer reference. Leave this blank if not required. 
Customer PO No.  
The customer purchase order number is printed on the invoice and on the statements for 
customer reference. Leave this blank if not required. 
Salesperson  
Enter the salesperson for this invoice, or choose one from the pull-down list. 
Tax 
Select the special sales tax exempt option if this is a customer who is sales-tax exempt (a 
foreign customer, for example). 
Bill To  
Enter the address the invoice should be sent to. 
Ship To 
Enter the address the products should be sent to. Leave this blank if this is not required. 
Comments 
These notes are printed on the bottom of the invoice. 
Private Comments 
These are notes for internal use only - they are not printed on the invoice. 
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Invoice Items
This is the list of items on the invoice. Click Add Item to add a new item, or edit and delete 
existing items. 
Add Flat Discount  
Click on this button to add a flat amount as a discount to the entire invoice. 
Add Percentage Discount 
Click on this button to add a percentage-based discount to the entire invoice. 
Add Discount per Item 
Click on this button to enable the discount column for each item on the invoice. Line item 
discounts must be entered as a percentage. 
Subtotal  
This is the total without the tax calculations. 
Total  
This is the sales tax and total display. If you think the sales tax calculation is wrong, please see 
the Tax tab of Options to configure sales tax rates. 
Record  
Click on this button to Record the invoice. 
Record and Pay (if available)  
Click on this button to Record the invoice along with a payment at the same time. 
Save as Draft (if available)  
Click on this button to save the invoice as a draft. 
Save as Recurring 
Click on this button to save the invoice and set it as a recurring invoice. 
Record & Fax 
Click on this button to Record the invoice and fax a copy to the customer. 
Record & Email 
Click on this button to Record the invoice and email a copy to the customer. 
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Web Access Screen References - Select Quotes 
Period
After you click the Quotes link from the control panel of the web interface, you will be asked to 
select a time period of quotes to view. 
Select Customer  
Select a customer or all customers from the pulldown menu.
Select Quotes 
Select the type of quote to view from the pulldown menu: Recorded or Draft quotes.
Select Period  
Select a period of quotes to view from the pulldown menu. If you want to enter a custom 
period, you must select Custom Period from the menu first.
Start Date  
If you want to view a custom time period, make sure Custom Period is selected in the Select 
Period pulldown menu above. Then, enter a beginning date for the quotes range you would like 
to view.
End Date 
Enter an ending date for the quotes range you would like to view.
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Web Access Screen References - Quotes List
Use the Quotes List to manage your quotes. To get here, click the Quotes link in the web 
interface control panel, then select a range of quotes to view based on time period. Here, you 
will see a list of all the quotes Express Accounts has created. 
You can refine the contents of this list by using the tabs at the top of the page to select 
Recorded, Draft, or All quotes. You can use the Period selector to filter the listed quotes by 
date, and the Start and End date pickers can be used to fine tune the date period. The 
Customer selector can also be used to further restrict the quote selection to a specific 
customer. Click Update to filter the quotes based on the criteria you selected. Users with 
viewer-only privileges will be unable to add and delete quotes. 
Add New Quote  
Click this button to create a new quote.
Create Order 
Click the Create Order icon to convert the quote into a sales order.
Create Invoice 
Click the Create Invoice icon to convert the quote into an invoice.
Edit 
Click the Edit icon to edit the associated quote.
PDF 
Allows you to save your Quote as a .pdf document.
Delete 
Click the Delete icon to delete the associated quote.
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Web Access Screen References - Add/Edit Quote
The Add/Edit Quote window is where you fill in the details for the quote. To access the 
Add/Edit Quote window, click Add New Quote  from the Quotes List or click the edit icon of an 
existing quote. Users with viewer-only privileges will be unable to edit quote details. 
Customer 
Choose the Customer from the pull down list, or enter a new customer. Adding new customer 
here will create a new record for the customer on Customer List so you can quickly access 
every time you create quotes, orders and invoices. 
Date 
Select the quote date. 
Salesperson  
Enter the salesperson for this quote, or choose one from the pull-down list. 
Tax 
Select the special sales tax exempt option if this is a customer who is sales-tax exempt (a 
foreign customer, for example). 
Bill To  
Enter the address the invoice should be sent to. 
Ship To 
Enter the address the products should be sent to. Leave this blank if this is not required. 
Comments 
These comments are printed on the bottom of the quote. 
Private Comments 
These are comments for internal use only - they are not printed on the quote. 
Quote Items  
This is the list of items on the quote. Click Add Item to add a new item, or edit and delete 
existing items. 
Add Flat Discount  
Click on this button to add a flat amount as a discount to the entire quote. 
Add Percentage Discount 
Click on this button to add a percentage-based discount to the entire quote. 
Add Discount per Item 
Click on this button to enable the discount column for each item on the quote. Line item 
discounts must be entered as a percentage. 
Subtotal  
This is the total without the tax calculations. 
Total  
This is the sales tax and total display. If you think the sales tax calculation is wrong, please see 
the Tax tab of Options to configure sales tax rates. 
Record  
Click on this button to Record the quote. 
Save as Draft  
Click on this button to save the quote as a draft. 
Record & Fax 
Click on this button to Record the quote and fax a copy to the customer. 
Record & Email 
Click on this button to Record the quote and email a copy to the customer. 
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Web Access Screen References - Select Orders 
Period
After you click the Orders link from the control panel of the web interface, you will be asked to 
select a time period of orders to view. 
Select Customer  
Select a customer or all customers from the pulldown menu.
Select Orders  
Select the type of order to view from the pulldown menu: Draft & Recorded , Recorded, Draft, 
or Recurring orders.
Select Period  
Select a period of orders to view from the pulldown menu. If you want to enter a custom period, 
you must select Custom Period from the menu first.
Start Date  
If you want to view a custom time period, make sure Custom Period is selected in the Select 
Period pulldown menu above. Then, enter a beginning date for the orders range you would like 
to view.
End Date 
Enter an ending date for the orders range you would like to view.
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Web Access Screen References - Sales Orders 
List
Use the Sales Orders List to manage your orders. To get here, click the Orders link in the web 
interface control panel, then select a range of orders to view based on time period. Here, you 
will see a list of all the orders Express Accounts has created. 
You can refine the contents of this list by using the tabs at the top of the page to select Recorde
d , Draft, Draft & Recorded  or Recurring orders. You can use the Period selector to 
filter the listed orders by date, and the Start and End date pickers can be used to fine tune the 
date period. The Customer selector can also be used to further restrict the order selection to a 
specific customer. Click Update to filter the orders based on the criteria you selected. Users 
with viewer-only privileges will be unable to add and delete orders. 
Add New Order (not available on the Display Recurring tab) 
Click this button to create a new order.
Run Selected Order (Display Recurring tab only) 
Click the Run Selected Order button to generate all currently due sales orders for the selected 
recurring sales order, according to its schedule.
Create Invoice (not available on the Display Recurring tab) 
Click the Create Invoice icon to convert the order into an invoice.
Schedule  (Display Recurring tab only) 
Click the Schedule button on the toolbar to view and/or change the schedule for the selected 
recurring sales order, or to change the action taken when the order is generated (email, fax, 
print, save, etc.).
Edit 
Click the Edit icon to edit the associated order.
PDF 
Allows you to save your Order as a .pdf document.
Delete 
Click the Delete icon to delete the associated order.
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Web Access Screen References - Add/Edit Sales 
Order
The Add/Edit Sales Order window is where you fill in the details for the order. To access the 
Add/Edit Sales Order window, click Add New Order from the Order List or click the edit icon of 
an existing order. Users with viewer-only privileges will be unable to edit order details. 
Customer 
Choose the Customer from the pull down list, or enter a new customer. Adding new customer 
here will create a new record for the customer on Customer List so you can quickly access 
every time you create quotes, orders and invoices. 
Date 
Select the order date. 
Quote Number 
Choose an existing quote from the pull down list, type in a new quote number, or leave blank if 
you are not generating an order from an existing quote. 
Terms 
The payment terms are used to calculate the payment due date. 
Days  
Enter the numbers of days for the Pay in Days payment terms to use to calculate the payment 
due date. 
Ship By  
Select the shipping method from the drop-menu, or enter a new shipping method. The Ship By 
detail will be printed on the order for customer reference. Leave this blank if not required. 
Tracking Ref No. 
The tracking reference number refers to the shipping method, and is printed on the order for 
customer reference. Leave this blank if not required. 
Customer PO No.  
The customer purchase order number is printed on the order and on the statements for 
customer reference. Leave this blank if not required. 
Salesperson  
Enter the salesperson for this order, or choose one from the pull-down list. 
Tax 
Select the special sales tax exempt option if this is a customer who is sales-tax exempt (a 
foreign customer, for example). 
Bill To  
Enter the address the order should be sent to. 
Ship To 
Enter the address the products should be sent to. Leave this blank if this is not required. 
Comments 
These comments are printed on the bottom of the order. 
Private Comments 
These are comments for internal use only - they are not printed on the order. 
Order Items 
This is the list of items on the order. Click Add Item to add a new item, or edit and delete 
existing items. 
Add Flat Discount  
Click on this button to add a flat amount as a discount to the entire order. 
Add Percentage Discount 
Click on this button to add a percentage-based discount to the entire order. 
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Add Discount per Item
Click on this button to enable the discount column for each item on the order. Line item 
discounts must be entered as a percentage. 
Subtotal  
This is the total without the tax calculations. 
Total  
This is the sales tax and total display. If you think the sales tax calculation is wrong, please see 
the Tax tab of Options to configure sales tax rates. 
Record  
Click on this button to Record the order. 
Save as Draft  
Click on this button to save the order as a draft. 
Save as Recurring 
Save the order with a schedule of when and how often it is to be sent. When the order is due to 
be sent, Express Accounts will first confirm that the order is to be sent then automatically send 
it using the method was last used (i.e., Print, Email or Fax). 
Record & Fax 
Click on this button to Record the order and fax a copy to the customer. 
Record & Email 
Click on this button to Record the order and email a copy to the customer. 
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Web Access Screen References - Payments and 
Purchases
From the Payments and Purchases dialog, you can record the details of purchase or payment 
transactions and then allocate the amount to two or more accounts. To make a purchase or 
payment entry, click the Transactions menu and select Payment Transaction, or access the 
Payments and Purchases dialog from the control panel by clicking the Payment or Purchase 
Transaction  link on the Purchases tab. The web version of this dialog may be opened with 
the Make a payment  link on the main page or with the Add New Check button on the Check 
List page. 
Transaction Date  
Select the date for this transaction. 
Pay To 
Select the supplier this transaction is for. 
Account  
Select the account this transaction will be applied to. 
Amount 
Enter the amount of the receipt or deposit. 
Transaction Reference 
The appropriate transaction reference id is already entered in this field. If you wish to enter a 
different id you can enter it instead. 
Journal Memo  
Add a note about this transaction that will help you identify the transaction on the journal. 
Account Allocation  
Allocate amounts to the accounts for this entry. Click the Add button to add an account. Select 
an account by number or name by selecting an account from the drop menu. Be sure to add 
both debit and credit accounts and click Record when the account amounts balance each other 
out. 
Out-of-balance amount 
If the debit and credit accounts do not balance, the out of balance amount will be displayed 
beneath the Account Allocation list. 
Record and Create Check 
Click this button to save the payment, and create a check with the payment details for printout.
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Web Access Screen References - Select 
Payments Period
After you click the Payments link from the control panel of the web interface, you will be asked 
to select a time period of payments to view. 
Select Period  
Select a period of payments to view from the pulldown menu. If you want to enter a custom 
period, you must select Custom Period from the menu first.
Start Date  
If you want to view a custom time period, make sure Custom Period is selected in the Select 
Period pulldown menu above. Then, enter a beginning date for the payments range you would 
like to view.
End Date 
Enter an ending date for the payments range you would like to view.
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Web Access Screen References - Payments List
Use the Payments List to manage your payments. To get here, click the Payments link in the 
web interface control panel, then select a range of payments to view based on time period. 
Here, you will see a list of all the payments Express Accounts has created. 
You can use the Period selector to filter the listed payments by date, and the Start and End 
date pickers can be used to fine tune the date period. The Customer selector can also be used 
to further restrict the payment selection to a specific customer. Click Update to filter the 
payments based on the criteria you selected. Users with viewer-only privileges will be unable to 
apply and delete payments. 
You can edit the invoice by clicking on the invoice number, this will open the Edit Invoice page. 
Apply Payment 
Click this button to apply a payment.
Receipt PDF 
Click the Receipt Pdf icon to download a PDF copy of the receipt for an applied payment.
Edit 
Click this button to edit a payment.
Delete 
Click the Delete icon to delete the associated payment.
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Web Access Screen References - Apply Payment
The Apply Payment window is where you fill in the details about payments. To access the 
Apply Payment window, click Apply Payment from the Payments List. Users with viewer-only 
privileges will be unable to edit payment details. 
Date 
Select the payment date. 
Customer 
Choose the Customer from the pull down list, or enter a new customer. 
Invoice  
Enter an invoice to apply the payment to. 
Amount 
Enter the amount of the payment to apply. 
Method 
Select the method of the payment to apply.
Please note that the payment method is only recorded and that Credit Card  payments will not 
be automatically charged to the customer's credit card. 
Reference Number 
Enter a reference number for this payment. 
Record  
Click on this button to Record the payment. 
Deposit Account 
Select the account the payment should be deposited into from the drop menu. 
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Web Access Screen References - Charge Payment
The Charge Payment window is where you can submit a charge to a customer's credit card to 
your configured credit card gateway. 
Payment Account 
This is the gateway account the payment will be sent to.
Customer 
The name of the customer.
Card Type 
The customer's credit card type.
Card Number  
The customer's credit card number.
Customer Info  
This section is filled with the address information of a customer. You may change their 
Address, City, State, ZIP Code, or Country before submitting the payment. Any changes made 
here will also be made to their customer record.
Invoice Number 
The invoice(s) this payment is applied to.
Amount 
The total amount of this payment.
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Web Access Screen References - Payment 
Charge Receipt
This page displays the results of a charge transaction for a payment. If the transaction is 
successful, it will show the transaction reference number. If it is unsuccessful, it will display an 
error message about the problem that occured. 
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Web Access Screen References - Enter Email 
Details
This window is used to email a PDF of an Invoice, Order, Quote, or Purchase Order. 
Email 
Enter the recipient's email address. This field is automatically filled with the selected 
Customer's email address (if available).
Message Comment  
Text entered here will be added to the body of the email generated by Express Invoice. This 
field is optional.
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Web Access Screen References - Items List
Use the Items List to manage your quotes. To get here, click the Items link in the web interface 
control panel. Here, you will see a list of all the items Express Accounts has created. Users 
with viewer-only privileges will be unable to add and delete items. 
Add New Item  
Click this button to add a new item.
Edit 
Click the Edit icon to edit the associated item.
Delete 
Click the Delete icon to delete the associated item.
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Web Access Screen References - Vehicles List
Use the Vehicles List to manage your vehicles. To get here, click the View vehicles link in the 
web interface control panel. Here, you will see a list of all the vehicles Express Accounts has 
created. Users with viewer-only privileges will be unable to add and delete items. 
Add New Vehicle 
Click this button to add a new vehicle.
Edit 
Click the Edit icon to edit the associated vehicle.
Delete 
Click the Delete icon to delete the associated vehicle.
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Web Access Screen References - Vehicles 
Mileage List
Use the Vehicles Mileage List to manage your vehicle mileage records. To get here, click the 
View vehicle mileage link in the web interface control panel. Here, you will see a list of all the 
vehicle mileage records Express Accounts has created. Users with viewer-only privileges will 
be unable to add and delete records. 
Add New Vehicle Mileage  
Click this button to add a new vehicle mileage record.
Edit 
Click the Edit icon to edit the associated vehicle mileage record.
Delete 
Click the Delete icon to delete the associated vehicle mileage record.
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Web Access Screen References - Add/Edit Vehicle
The Add/Edit Vehicle window is where you fill in the details for vehicles. To access the 
Add/Edit Vehicle window, click Add New Vehicle from the Vehicle List or click edit on one of 
the existing vehicles. Users with viewer-only privileges will be unable to add or edit vehicle 
details. 
Vehicle Name  
Enter a name for the vehicle. 
Vehicle Description 
Enter a description of the vehicle. 
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Web Access Screen References - Add/Edit 
Vehicle Mileage
The Add/Edit Vehicle Mileage window is where you fill in the details for vehicle mileage 
records. To access the Add/Edit Vehicle Mileage window, click Add New Vehicle Mileage  
from the Vehicle Mileage List or click edit on one of the existing vehicles. Users with 
viewer-only privileges will be unable to add or edit vehicle mileage records. 
Vehicle 
Enter or select a name for the vehicle. 
Customer 
Enter or select the customer from the list. 
Job Code  
Enter the job code. 
Trip Start Date  
Enter the trip start date. 
Trip End Date  
Enter the trip end date. 
Odometer Start 
Enter the starting odometer reading. 
Odometer End  
Enter the ending odometer reading. 
Total Mileage  
Displays the distance based from start to end odometer reading. 
Notes  
Enter the notes for this vehicle mileage record entry. 
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Web Access Screen References - Add/Edit Item
The Add/Edit Item window is where you fill in the details for items. To access the Add/Edit Item 
window, click Add New Item  from the Items List or click edit on one of the existing items. 
Users with viewer-only privileges will be unable to edit item details. 
Item Code  
Enter the code for the item. 
Item Description 
Enter a description of the item. 
Selling Price 
Enter the selling price of the item. 
Purchase Price 
Enter the cost of the item. 
Tax 
Select the type of tax to apply to orders of this item. 
Income account  
If you have multiple entries in the income statement, select the account here. Default is 
General Sales. This then will be subtotaled in the Accounting Report. 
Expense account 
If you have multiple entries in the income statement select the account here. Default is General 
Products Purchased. This then will be subtotaled in the Accounting Report. 
Manage the inventory stock levels  
Click if you would like to manage the quantities of this item using Express Accounts. 
Current Quantity 
The quantity currently on hand. 
Ideal Quantity  
The quantity you would most like to keep on hand. 
Warning Quantity 
Express Accounts will warn that sock of this item is running low when the quantity entered here 
is reached. 
Save Changes 
Modify the current item and return to the Items List. 
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Web Access Screen References - Customers List
Use the Customers List to manage your quotes. To get here, click the Customers link in the 
web interface control panel. Here, you will see a list of all the customers Express Accounts has 
created. Users with viewer-only privileges will be unable to add and delete customers. 
Add New Customer  
Click this button to add a new customer.
Statement  
Click the Statement icon to prepare a statement for the associated customer.
Edit 
Click the Edit icon to edit the associated customer.
Delete 
Click the Delete icon to delete the associated customer.
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Web Access Screen References - Add/Edit 
Customer
The Add/Edit Customer window is where you fill in the details for customers. To access the 
Add/Edit Customer window, click Add New Customer  from the Customers List or click edit on 
one of the existing customers. Users with viewer-only privileges will be unable to edit customer 
details. 
Customer Name 
Enter the business name of the customer.
Contact Person 
Enter the full name of the person you deal with.
Contact First Name 
This is the first name of the person you deal with or the way you address them.
Address  
Enter the customer billing address. If the customer has a different shipping address you can 
enter that on the Other tab.
Phone  
These are the phone numbers you can use to reach the customer.
Fax 
This is the fax number you can use to fax invoices to the customer.
Email 
This email address is the one used for sending invoices by email if email is the preferred 
method.
Additional Info 
Enter an additional information, such as ABN.
This customer is active 
Check this box to show that this customer is currently active.
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Web Access Screen References - Add/Edit 
Customer Additional Options
The Add/Edit Customer Additional Options window is where you fill in the details for customers. 
To access the Add/Edit Customer window, click Additional Options  from the Edit Customer 
screen. Users with viewer-only privileges will be unable to edit these additional options. 
Shipping Address  
If the customer's preferred shipping address is different from the billing address, then enter it 
here. If the shipping address is the same as the billing address, then leave the shipping 
address empty.
Prefers Invoices By 
Select the method which will be used by Express Accounts to send invoices to this customer 
when generating new recurring invoices.
Set tax exempt for this customer 
When checked, the taxes will not be applied to any transactions for this customer.
Payment Terms  
Select the terms of payment which will appear by default on an invoice created for this 
customer.
Payment Terms Days 
Enter the period of the payment terms.
Salesperson  
This is the name of the salesperson who will be selected by default when an invoice is created 
for this customer.
Customer Notes  
These notes are for internal use only. They can be used, for example, to indicate customer 
history or special terms.
Customer Group 
Select the group which this customer belongs to. To create a new group, enter it into the field.
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Web Access Screen References - Add/Edit 
Customer Credit Card
The Add/Edit Customer Credit Card window is where you fill in the details for a customer's 
credit card. To access the Add/Edit Customer window, click Credit Card from the Edit 
Customer screen. Users with viewer-only privileges will be unable to edit credit card details. 
Card Number  
Enter the customer's credit card number.
CVV Number 
Enter the customer's credit card Verification Number.
Card Type 
Select the customer's credit card type.
Expiry Month  
Enter the customer's credit card Expire Month.
Expiry Year  
Enter the customer's credit card Expiration Year.
Owner First Name  
Enter the credit card holder's First Name.
Owner Last Name 
Enter the credit card holder's Last Name.
Currency Type 
Select the currency type for the customer to pay. This work for Paypal only, for authorize the 
currency type is always USD. 
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Web Access Screen References - Add/Edit 
Customer Additional Info
The Add/Edit Customer Additional Info window is where you fill in the details for customers. To 
access the Add/Edit Customer Additional Info window, click Additional Info from the Edit 
Customer screen. Users with viewer-only privileges will be unable to edit this additional info. 
Opening Balance 
Enter the opening balance of the customer if there is.
Balance Due 
This is the current total balance due for the customer.
Oldest Date Due  
This is the due date of the oldest invoice of the customer.
Last Invoice  
This is the date that the last invoice for the customer was created.
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Web Access Screen References - User Account 
List
Use the User Account List to manage user accounts for the web interface. This feature is only 
accessible to users with administrator privilege. To get here, click the Add/Edit users link on the 
right-side navigation panel of the main page. 
Add New User  
To create a new account, click the Add New User button at the top of the page. This will open 
the Add New User  window where the account details are entered.
Edit 
To edit account settings, click the edit icon.
Delete 
To delete an account, click the delete icon.
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Web Access Screen References - Select Journal 
Period
After you click the View the Journal link from the control panel of the web interface, you will be 
asked to select a time period of journal entries to view. 
Select Journal 
Select a type of journal entry to view from the pulldown menu: General, Payment, Receipts, 
Sales, or Purchases.
Select Period  
Select a period of entries to view from the pulldown menu. If you want to enter a custom 
period, you must select Custom Period from the menu first.
Start Date  
If you want to view a custom time period, make sure Custom Period is selected in the Select 
Period pulldown menu above. Then, enter a beginning date for the journal entry range you 
would like to view.
End Date 
Enter an ending date for the journal entry range you would like to view.
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Web Access Screen References - Journal List
Use the Journal List to manage your journal entries. To get here, click the View the Journal 
link in the web interface control panel, then select a range of entries to view based on time 
period. Here, you will see a list of all the journal entries Express Accounts has created. 
You can refine the contents of this list by using the tabs at the top of the page to select All, 
General, Payment, Receipts, Sales, or Purchases entries. You can use the Period drop menu 
to filter the listed entries by date, and the Start and End date pickers can be used to fine tune 
the date period. The Account drop menu can also be used to further narrow the entries 
displayed to a specific account. If there is a specific journal entry you are looking for, you can 
use the Reference field to type in the reference id of that journal entry. Type it in the field, then 
press enter. This will filter all entries and show those with the reference id you entered. To 
clear the search, simply delete the entry you entered in the Reference field and click outside of 
it. 
Export to CSV 
Click the Export to CSV button to save the entries to a CSV file.
Save to PDF 
click the Save to PDF button to save the journal entries to a PDF file.
Edit 
Click on the pencil icon at the end of an entry on the far right to open the Journal Entry window. 
Here you can edit the details of that entry.
Delete 
Click on the trash can icon to delete that entry. A pop up window will ask you if you are sure 
you want to delete it.
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Web Access Screen References - Select Purchase 
Order Period
After you click the Purchase Orders link from the control panel of the web interface, you will be 
asked to select a time period of purchase orders to view. 
Select Orders  
Select a type of purchase order to view from the pulldown menu: All, Recorded, or Draft.
Select Period  
Select a period of purchase orders to view from the pulldown menu. If you want to enter a 
custom period, you must select Custom Period from the menu first.
Start Date  
If you want to view a custom time period, make sure Custom Period is selected in the Select 
Period pulldown menu above. Then, enter a beginning date for the purchase orders range you 
would like to view.
End Date 
Enter an ending date for the purchase orders range you would like to view.
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Web Access Screen References - Purchase 
Orders List
Use the Purchase Orders List to manage your purchase orders. To get here, click the 
Purchase Orders link in the web interface control panel, then select a range of purchase orders 
to view based on time period. Here, you will see a list of all the purchase orders created in 
Express Accounts. 
You can refine the contents of this list by using the tabs at the top of the page to select Display 
Recorded, Display Draft, or Display All. You can use the Period drop menu to filter the listed 
purchase orders by date, and the Start and End date pickers can be used to fine tune the date 
period. The Supplier drop menu can also be used to further narrow the orders displayed to a 
specific supplier. Click Update to filter the purchase orders based on the criteria you selected. 
Users with viewer-only privileges will be unable to add or delete purchase orders. 
Add New Purchase Order 
Click this button to add a new purchase order.
Edit 
Click this button to edit the selected purchase order.
PDF 
Allows you to save the purchase order as a .pdf document.
Delete 
Click this button to delete the selected purchase order.
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Web Access Screen References - New Accounts 
Payable
The Accounts Payable page is where you can enter a bill you have received for payment at a 
later date. 
Date 
Enter the date, either by typing it in manually or using the calendar widget. 
Due Date 
Enter the due date of this bill. 
Supplier  
Choose the Supplier from the pull down list. 
Supplier address  
Enter the supplier's address. 
Accounts Payable 
Select the type of Accounts Payable with the pull down list. 
Amount 
Enter the total amount for this Accounts Payable entry. 
Reference number 
Enter a reference number for this transaction. 
Memo  
Enter any notes about this bill. 
Account Allocation  
This is where you can allocate an amount towards specific accounts. Click the Add button to 
add a new account. Enter the amount for the account, and select the Tax from the pull down 
list. The trashcan icon can be used to delete an entry. 
Record  
Click on this button to Record the bill. 
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Web Access Screen References - Select Accounts 
Payable Period
After you click the Purchase Orders link from the control panel of the web interface, you will be 
asked to select a time period of purchase orders to view. 
Select Period  
Select a period of bills to view from the pulldown menu. If you want to enter a custom period, 
you must select Custom Period from the menu first.
Start Date  
If you want to view a custom time period, make sure Custom Period is selected in the Select 
Period pulldown menu above. Then, enter a beginning date for the bills range you would like to 
view.
End Date 
Enter an ending date for the bills range you would like to view.
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Web Access Screen References - Accounts 
Payable List
Use the Accounts Payable List to manage your bills. To get here, click the Accounts Payable 
link in the web interface control panel, then select a range of bills to view based on time period. 
Here, you will see a list of all the bills created in Express Accounts. 
You can use the Period drop menu to filter the listed bills by date, and the Start and End date 
pickers can be used to fine tune the date period. The Supplier drop menu can also be used to 
further narrow the bills displayed to a specific supplier. Click Update to filter the bills based on 
the criteria you selected. 
Enter a new Account Payable 
Click this button to add a new payable account.
Edit 
Click this button to edit the selected payable account.
Delete 
Click this button to delete the selected payable account.
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Web Access Screen References - Bill Payments 
List
Use the Bill Payments List to manage your payments of accounts payable. A list of all the 
payments you have entered in Express Accounts is displayed here. To open the Bill Payments 
List list, click the View payments of accounts payable link in the right-side navigation panel 
of the main page. This feature is not available for users with 'viewer' only privilege. 
You can refine the contents of the Payments list by using the interactive filter controls at the 
top of the page. Use the Period drop menu to filter the listed payments by date, and the Start 
and End date pickers can be used to fine tune the date period. The Supplier selector can also 
be used to further restrict the payment selection to a specific supplier. 
Enter Payment 
Click the Enter Payment button to enter a new payment.
Delete 
To delete a payment, click the delete icon.
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Web Access Screen References - Select Bill 
Payment List Period
After you click the View payments of accounts payable link from the control panel of the web 
interface, you will be asked to select a time period of payments to view. 
Select Period  
Select a period of payments to view from the pulldown menu. If you want to enter a custom 
period, you must select Custom Period from the menu first.
Start Date  
If you want to view a custom time period, make sure Custom Period is selected in the Select 
Period pulldown menu above. Then, enter a beginning date for the payments range you would 
like to view.
End Date 
Enter an ending date for the payments range you would like to view.
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Web Access Screen References - Check List
Use the Check List to manage your checks. To get here, click the View Checks link on the 
right-side navigation panel of the main page. 
Add New Check 
To create a new check, click the Add New Check button at the top of the page. This will open 
the Payments and Purchases  window where you can enter the purchase information. Click 
the Record and Create Check button here to record a check and download a PDF copy. 
Edit 
To edit a check, click the edit icon.
Void 
To void an check, click the void icon.
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Web Access Screen References - New Account 
Dialog
The New Account Dialog is where you create new accounts to be added to the Chart of 
Accounts. From the Chart of Accounts dialog, click the Add New Account  button to open the 
New Account Dialog. 
Create New Account 

Account Name 
Enter a name for the account you are creating.
Type 
Select an account type by clicking the radio button next to: Asset, Liability, Equity, Income, 
or Expenses. Then, specify the type using the drop menu to the right of the account type.
Classification for Cash Flow 
The selection you make in this field will be used for the Cash Flow Statement reports. Your 
choices are Operating, Investing or Financing.
Account Number 
Enter an account number. The number of digits in the account must match the digit amount 
set on the Chart of Accounts list, which is four by default.
Default Linked Account for (If available) 
The selection you make in this field will be used as the default account for selected 
transactions.
Opening Balance 
Enter an opening balance for the account, or keep it at zero.
Account is just a Header Account 
If the account is a header account it means that nothing can be posted directly to the 
account but on reports the account prints the subtotals of all accounts below it with the 
same prefix.
Cash Postable  
If an account is cash postable it means it will appear in the list of accounts that payments 
can be made from or deposits made to. Bank and Credit Card accounts usually have this 
option ticked.
Tax Included 
Check this box if payment from this account will include sales tax. The tax will be based on 
values entered on the Tax tab of Options, but can also be adjusted on the Payments and 
Purchases dialog.
Add  
When all the details for the new account have been filled in, click the Add button to add the 
account to the Chart of Accounts list.
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Web Access Screen References - Invoice Records 
Log
Express Invoice keeps a record of actions related to invoices, such as when they were printed, 
faxed or emailed. This can be useful to reference if a question about whether an invoice was 
sent ever arises.
Open the Invoice Records Log from the Invoice List by clicking the Log icon in the invoice entry.
The Invoice Records Log screen displays the logs of the selected record. Click Save Log to 
save the selected log in a file.
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Web Access Screen References - Select Credit 
Notes
After you click the View Credit Notes link from the control panel of the web interface, you will 
be asked to select a time period of credit notes to view. 
Select Credit Notes 
Select a type of credit notes to view from the pulldown menu: recorded or drafts.
Select Period  
Select a period of credit notes to view from the pulldown menu. If you want to enter a custom 
period, you must select Custom Period from the menu first.
Start Date  
If you want to view a custom time period, make sure Custom Period is selected in the Select 
Period pulldown menu above. Then, enter a beginning date for the credit notes range you 
would like to view.
End Date 
Enter an ending date for the credit notes range you would like to view.
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Web Access Screen References - Credit Notes List
Use the Credit Notes List to manage your Express Accounts credit notes. To get here, click the 
View Credit Notes link in the web interface control panel. Here, you will see a list of all the 
credit notes Express Accounts has created. 
You can refine the contents of this list by using the tabs at the top of the page to select 
Recorded, Draft, or All credit notes. You can use the 'Period' selector to filter the listed credit 
notes by date, and the 'Start' and 'End' date pickers can be used to fine tune the date period. 
The 'Customer' selector can also be used to further restrict the credit note selection to a 
specific customer. Click Update to filter the credit notes based on the criteria you selected. 
Users with viewer-only privileges will be unable to add or delete credit notes. 
Add New Credit Note  
Click this button to create a new credit note.
Edit 
Click the Edit icon to edit the associated credit note.
PDF 
Allows you to save your Credit Note as a .pdf document.
Delete 
Click the Delete icon to delete the associated credit note.
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Web Access Screen References - Add/Edit Credit 
Note
The Add/Edit Credit Note window is where you fill in the details for the credit note. To access 
the Add/Edit Credit Note window, click Add New Credit Note  from the Credit Note List or click 
edit on one of the existing credit notes. 
Customer 
Choose the Customer from the pull down list. 
Date 
Select the credit note date. 
Invoice Number 
Choose an existing invoice from the pull down list. 
Salesperson  
Enter the salesperson for this credit note, or choose one from the pull-down list. 
Tax 
Select any special sales tax option eg. if this is a special customer who is sales-tax exempt (for 
example a foreign customer). 
Customer Address  
Enter the customer's address. 
Comments 
These comments are printed on the bottom of the Credit Note. 
Private Comments 
These are comments for internal use only they are not printed on the Credit Note. 
Credit Note Items  
This is the list of items on the credit note. Click on the Add button to add a new item, then click 
within the Item or Description cells to access a drop-menu where you can select an item, or 
type the name of a new item. Remove an item by clicking the trashcan at the right of the item 
entry. 
Add Flat Discount  
Click on this button to add a flat amount as a discount to the entire credit note. 
Add Percentage Discount 
Click on this button to add a percentage-based discount to the entire credit note. 
Add Discount per Item 
Click on this button to enable the discount column for each item on the credit note. Line item 
discounts must be entered as a percentage. 
Save as Draft  
Click on this button to save the credit note as a draft. 
Record & Fax 
Click on this button to Record the credit note and fax a copy to the customer. 
Record & Email 
Click on this button to Record the credit note and email a copy to the customer. 
Record  
Just record the quote. You can print, email, or fax it later, if needed.
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Web Access Screen References - Budget List
Use the Budget List to manage your budgets. To get here, click the View budget link in the web 
interface control panel. Here, you will see a list of all the budgets Express Accounts has 
created. Users with viewer-only privileges will be unable to add and delete items. 
Add New Budget  
Click this button to add a new budget.
Edit 
Click the Edit icon to edit the associated budget.
Delete 
Click the Delete icon to delete the associated budget.
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Web Access Screen References - Create Budget
Use the Create New Budget to start your budget. To get here, click the View Budget link in the 
web interface control panel, then Add New Budget. 
Start 
Start of the budget year.
Balance Sheet (ending balance). 
Choose this to create a Balance Sheet type of budget.
Profit and Loss (all activity for the year). 
Choose this to create a Profit and Loss type of budget.
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Web Access Screen References - Budget Report
Use the Report Budget to start creating your budget reports. To get here, click the Reports, 
then Budget Reports. Click Generate to create the report once you have selected the desired 
budget. 
Select Budget 
Select the budget that you want to create a report.
Description  
The internal description of the budget.
Save As CSV  
Choose this option to save the budget as CSV. Default type is PDF.
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Web Access Screen References - Budget Dialog
Use the Budget tool to edit your budget. To get here, click the View Budget link from the 
control panel's right sidebar, then click the Edit icon of your desired budget. Enter the amount 
you want to allocate for each account on a monthly basis. 
Save Changes 
Save the budget record and return to the budget list.
Cancel 
Closes the budget page and discards any changes made.
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Web Access Screen References - Journal Entry 
Web
From the Journal Entry dialog, you can enter the details of any type of transaction and then 
allocate the amount to two or more accounts. 
Date 
Select the date for this journal entry. 
Journal  
Select the Journal the transaction should be recorded to from the drop menu. 
Reference  
Enter reference id for this entry if you wish to record a reference id different from the auto 
generated id. 
Journal Memo  
Add a note about this journal entry that will help you remember what the entry is for. 
Account Allocation  
Allocate amounts to the accounts for this entry. Click the Add button to add an account. Select 
an account by number or name by selecting an account from the drop menu. Be sure to add 
both debit and credit accounts and click Record when the account amounts balance each other 
out. 
Out-of-balance amount 
If the debit and credit accounts do not balance, the out of balance amount will be displayed 
beneath the Account Allocation list. 
Record  
Click on this button to Record the journal entry. 
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Web Access Screen References - Reconcile 
Account Web
Account  Select the account you wish to reconcile from the pull down list of accounts.
Last Reconciled Date 
The last date the selected account was reconciled will appear here.
Bank Statement Date 
Enter the statement date that appears on your bank statement.
New Statement Balance  
Enter the ending balance that appears on your bank statement.
Calculated Statement Balance 
The number that appears here is the account's balance before reconciliation.
Out of Balance  
If this field contains a value other than zero, you may have errors in your records. As you 
compare your entries with the bank statement, those errors will probably become apparent.
Local Ledger Transactions 
This is the list of account entries that have not yet been reconciled. For manual reconciliation, 
tick the checkbox of each entry that has a matching entry on your bank statement to reconcile 
the entry.
Add a new payment transaction 
Click here to add a new payment transaction.
Add a new receipt transaction 
Click this button to add a new receipt transaction.
Check All  
Click this button to select all account entries in the list.
Uncheck All 
Click this button to deselect all account entries in the list.
Rollback to Previous 
This button allows you to undo the last reconcile for the selected account. You may want to 
rollback if you have done a reconciliation by mistake or you have received more transactions 
that should have been included in the last reconcile. 
Please note that this button will only be enabled when there is a valid reconciliation to rollback 
to and you will only be able to go back at most one reconciliation.
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Web Access Screen References - Select Account 
and Bank Statement
Account  Select the account you wish to reconcile from the pull down list of accounts.
Last Reconciled Date 
The last date the selected account was reconciled will appear here.
Bank Statement Date 
Enter the statement date that appears on your bank statement.
New Statement Balance  
Enter the ending balance that appears on your bank statement.
Calculated Statement Balance 
The number that appears here is the account's balance before reconciliation.
Out of Balance  
If this field contains a value other than zero, you may have errors in your records. As you 
compare your entries with the bank statement, those errors will probably become apparent.
Upload a bank statement file 
Click the Browse  button and select the bank statement file to upload from your computer. 
Express Accounts can only load files in .csv or .ofx format. Click Next to load the statement 
into the Reconcile Account window.
Express Accounts will compare your local ledger with the bank statement and will match 
transactions for reconciliation to save you time. In your local ledger list (the list on top), 
reconciled transactions will be checked off and highlighted in green. Items that remain 
unmatched in your local ledger list may contain errors.
Items that appear in the bank statement list (the lower list), but not in your local ledger list can 
easily be added. Select the entry from the bank statement list and click the Add Transaction  
button. The transaction will be added to the local ledger list and will display as a reconciled 
entry.
In the bank statement list (the lower list), entries that appear in red are highlighted as possible 
recurring transactions. If you select the entry and click Add Transaction, the entry will be 
added to the local ledger list, and will be automatically added to the local ledger list every time 
a bank statement containing the entry is loaded to the Reconcile Account window.
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Web Access Screen References - Customer 
Statement Period Web
Automatically use month or oldest due  Select this option to use the current month or the 
oldest due date of a customer.
Enter Statement Period 
Specify the period for the customer statement (dates are inclusive).
Start Date  
If Enter Statement Period was selected, this specifies the Start date for the customer 
statement (inclusive). 
End Date 
If Enter Statement Period was selected, this specifies the End date for the customer 
statement (inclusive).
Send Email  
You can email a customer statement as a PDF file by clicking the Send Email button. Your 
email settings must be set up before this operation can be completed.
Generate 
You can download a customer statement as a PDF file by clicking the Generate button.
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Web Access Screen References - New/Edit 
Purchase Order
The New/Edit Purchase Order dialog is where you fill in the details for a purchase order. To 
open this dialog, click the Purchases menu  and select New Purchase Order. 
Supplier  
Choose the Supplier from the pull down list, or enter a new supplier. Adding new suppliers 
here will create a new record for the supplier on Suppliers List so you can quickly access every 
time you create purchase orders. 
Date 
Select the purchase order date. 
Tax 
Select the special sales tax exempt option if this is a supplier who is sales-tax exempt (a 
foreign supplier, for example). 
Vendor address 
Enter the vendor's address. 
Ship To 
Enter the address the products should be sent to. Leave this blank if this is not required. 
Comments 
These comments are printed on the bottom of the purchase order. 
Private Comments 
These are comments for internal use only - they are not printed on the purchase order. 
Purchase Order Items 
This is the list of items on the purchase order. Click on the Add button to add a new item, then 
click within the Item or Description cells to access a drop-menu where you can select an item, 
or type the name of a new item. Change the Quantity or Unit Value by typing in a new value. 
Remove an item by clicking the red "X" at the right of the item entry. 
When you enter new items here, they will automatically be added to the Items List  so you can 
quickly add them to orders, quotes and invoices later. 
Add Flat Discount  
Click on this button to add a flat amount as a discount to the entire purchase order. 
Add Percentage Discount 
Click on this button to add a percentage-based discount to the entire purchase order. 
Add Discount per Item 
Click on this button to enable the discount column for each item on the purchase order. Line 
item discounts must be entered as a percentage. 
Subtotal  
This is the total without the tax calculations. 
Total  
This is the sales tax, subtotal and total display. If the sales tax calculation is wrong, please see 
Taxes in the Getting Started section and Options ~ Tax for more information. 
Save as Draft  
Click on this button to save the purchase order as a Draft. 
Record and Fax 
Click on this button to Record the purchase order and fax a copy. 
Record and Email 
Click on this button to Record the purchase order and email a copy. 
Record  
Click on this button to Record or save the purchase order. 
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Screen References - Refunds List
Use this screen to manage your refunds. Here you will see a list of all the refunds which 
Express Accounts has processed. 
You can refine the contents of this list by using the interactive filter controls below the main 
button bar. You can use the 'Period' selector to filter the listed refunds by date, and the 'Start' 
and 'End' date pickers can be used to fine tune the date period. The 'Customer' selector can 
also be used to further restrict the refund selection to a specific customer. 
New 
Click this button to create a new refund.
Delete 
To delete refund(s), select the refund(s) you wish to remove from the list, and click this button.
Edit 
Click this button to edit the currently selected refund. This only applies to one refund at a time.
Preview 
Click this button to see how the refund will appear when printed, saved as a PDF document, or 
emailed to a customer.
Print 
Click this button to print the currently selected refund(s).
Email 
Use this button to send one or more selected refund(s) as a PDF document to a recipient via 
email. You will asked to provide an email address.
Fax 
Use this button to send one or more selected refund(s) to a recipient via fax. You will asked to 
provide a fax number.
Save 
Click this button to save the currently selected refund(s) as a PDF file on your computer.
Charge Credit Card 
Click this if you want to refund the customer on their credit card. You must have set the 
payment account (Credit card gateway) in Options on the Payments tab, as well as entered the 
customer's custom credit card information in the listing. 
Find Refund 
Use this dialog box to search for a desired Refund in the list. You can search by Date, Refund 
id number or Customer.
Find Next Refund  
The commands Find Refund and Find Next Refund work together. The Option to use Find Next 
Refund appears after you use Find Refund. Find Next Refund Will find the next Refund with 
the same search criteria you entered in Find Refund.
When using Find Next Refund, after you have scrolled through all Refunds with matching 
search criteria from Find Refund, A pop-up window will notify that "No more refunds matching 
'(SEARCH CRITERIA)' could be found."
Note: If you delete the search criteria from the text box in Find Refund and click OK, a pop-up 
window will notify "No matching '' could be found.". The Find Next Refund function will now be 
grayed out and unselectable. The Find Next Refund function will be available again after you 
use Find Refund.
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Web Access Screen References - Recurring Order 
Schedule
After you click the Save As Recurring button from the order dialog of the web interface, you will 
be asked to select a schedule of the order. 
Start Date  
Select the date when the recurring order will start.
Interval 
Select the interval of the recurring order. Choose from weekly, fortnightly, monthly, bimonthly, 
quarterly, 6 months, annually, or every 2 years for the interval.
Replace the string %period% in any description with dates.  
If you want to have the recurring date in the description, enabling this option will replace the 
text "%period" to the recurring date.
Update the prices of any items which have been changed. 
Enable this option to allow the prices of any items which have been changed.
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Web Access Screen References - Select 
Customers
Check All  
Check this box if you want to select or deselect all customers.
Select Customers 
This is the list of the customers that you want to generate reports.
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Web Access Screen References - Select 
Customers List Period
Check All  
Check this box if you want to select or deselect all customers.
Select Customers 
This is the list of the customers that you want to generate reports.
Select Period  
Select a period of invoices to view from the pulldown menu. If you want to enter a custom 
period, you may select any of the choices and then modify the dates.
Start Date  
For a custom time period, enter a beginning date for the invoice range you would like to view.
End Date 
Enter an ending date for the invoice range you would like to view.
Save Report as CSV 
Select this to save the report as a CSV file.
Sort by Column  
Select the column to use for sorting the Invoices. Choose either Descending or Ascending to 
set the sorting order.
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Web Access Screen References - Select Accounts 
List Period
Select Account 
This is the list of the accounts that you want to generate reports.
Select Period  
Select a period of trasnactions to view from the pulldown menu. If you want to enter a custom 
period, you may select any of the choices and then modify the dates.
Start Date  
For a custom time period, enter a beginning date for the transaction range you would like to 
view.
End Date 
Enter an ending date for the transaction range you would like to view.
Save Report as CSV 
Select this to save the report as a CSV file.
Sort by Column  (when available) 
Select the column to use for sorting the transactions. Choose either Descending or Ascending 
to set the sorting order. 
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Screen References - Budget List
Use this screen to manage your budget records. A list of all the budgets you have entered in 
Express Accounts is displayed here. To open the Budget list, click the View menu and select B
udget.  
Add  
Click the Add button on the toolbar to create a new budget record.
Delete 
To delete a budget record, select the budget record(s) you wish to remove from the list, and 
click the Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected budget record. You can only 
edit one budget record at a time.
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Screen References - Budget Main
Use this screen to edit your budget record. 
Copy Across 
Click the Copy Across button to copy the currently selected budget cell value across the row. 
(Desktop version only)
Adjust Row Value... 
Click the Adjust Row Value button to edit the currently selected budget cell value and either 
increase or decrease the amount by the given percentage. (Desktop version only)
Clear  
Click the Clear button to delete all values in the budget dialog. (Desktop version only)
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Screen References - Adjust Row Value
Use this screen to increase or decrease your budget value. 
Start 
Select from either "First Month" or "Currently Selected Month" where the adjusting of values 
would start.
Adjust each monthly amount in this row  
Select either Increase or Decrease. Default is Increase
Enter Percentage 
Enter a valid percentage amount. This will determine the percentage it will adjust the value of 
the currently selected entry.
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Screen References - Create Budget
Use the Create New Budget to start your budget. To get here, click the View, then Budget. To 
start creating a budget, click on the Add button. 
Start 
Start of the budget year.
Balance Sheet (ending balance). 
Choose this to create a Balance Sheet type of budget.
Profit and Loss (all activity for the year). 
Choose this to create a Profit and Loss type of budget.
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Screen References - New/Edit Invoice
The New/Edit Invoice dialog is where you fill in the details for an invoice. To open this dialog, 
click the Invoice  icon on the toolbar of the Home, Sales, or Banking tab.

Billing Tab
Located in the upper right corner, the Billing tab is where you enter information relating to 
the customer you are billing.

Customer 
Choose the Customer from the pull down list, or enter a new customer. Adding new 
customer here will create a new record for the customer on Customer List so you can 
quickly access every time you create quotes, orders and invoices. 
Bill To  
Enter the address the invoice should be sent to. 
Customer PO No.  
The customer purchase order number is printed on the invoice and on the statements for 
customer reference. Leave this blank if it is not required. 
Customer Tax 
Select the special sales tax exempt option if this is a customer who is sales-tax exempt (a 
foreign customer, for example). 

Shipping Tab
Click the Shipping tab, behind the Billing tab, to enter shipping details for the customer.

Ship To 
Enter the address the products should be sent to. Leave this blank if this is not required. 
Same as billing
Check this box to input the same address for the shipping address as you listed on the 
Billing tab.
Ship By  
Select the shipping method from the drop-menu, or enter a new shipping method. The Ship 
By detail will be printed on the invoice for customer reference. Leave this blank if not 
required. 
Tracking Ref No. 
The tracking reference number refers to the shipping method, and is printed on the invoice 
for customer reference. Leave this blank if not required. 
Shipping  
Enter any shipping costs associated with the invoice in the field. If any tax should be applied 
to the shipping, select the appropriate tax rate from the drop menu. Tax rates must be set 
up on the Options ~ Tax tab before they will be available here.

Invoice Tab
The Invoice tab is in the upper right corner of the Invoice window and is where you can 
select to create an invoice from a previous quote, order or draft, as well as enter any other 
relevant invoice information.

Create From 
You can use an existing Quote, Order or draft Invoice to create a new invoice. When you 
select a type from the pull down list, Express Accounts will show a new window where you 
can select a specific Quote, Order or Draft Invoice. 
Date 
Select the invoice date. 
Terms 
The payment terms are used to calculate the payment due date. 

155

customerslist.html
tax.html


Salesperson
Enter the salesperson for this invoice, or choose one from the pull-down list. 
Invoice Number 
This number is automatically generated by Express Accounts, but can be changed when 
creating a new invoice. However, when editing an invoice, the number cannot be changed.
Deposit Account 
Select the invoice payment deposit account from the drop-down list. 
Invoice Items  

This is the list of items on the invoice. Click inside the item list to add a new item, or select 
an existing item, and update the quantity invoiced. If the invoice is created from an order, 
the items are not editable. 
Add Discount
Click the Add Discount button to apply a discount either to the entire invoice, or to a line 
item. See the Apply Discount help topic for more information about discounting. 
Comments Tabs 

Comments
These comments are printed on the bottom of the invoice above the Notes and Foot 
comments. 
Private Comments 
These are notes for internal use only - they are not printed on the invoice. 
Note Comment 
These notes are printed on the bottom of the invoice above the Foot comments.
[Default] "Please contact us for more information about payment options."  
Foot Comment  
These foot comments are printed on the bottom of the invoice.
[Default] "Thank you for your business." 
Total  

This is the sales tax and total display. If you think the sales tax calculation is wrong, please 
see the Tax tab of Options. 
Record  
Click on this button to Record the invoice. To select the action (to Print, Email or Fax the 
invoice), click on the pull down list. You can also save the invoice as a draft, save as a 
recurring invoice, or preview the invoice. You can also select to Record with Payment, so 
the invoice will be recorded as paid. The invoice will always be recorded even when the 
actions of Print, Email or Fax, may have been cancelled or failed to complete. 

Note: If Inventoria Application Integration or stock level management is enabled, all 
invoices created from recurring invoices will cause a stock quantity change, even if the 
recurring invoice was originally an order for which a quantity change has been recorded. 
Creating a separate invoice directly from that order will not result in an extra quantity 
change. 

Invoice Options 
Click the Invoice Options button to open the configuration options for invoices, where you 
can change the appearance of the final invoice, change heading titles, and preview the look 
of the final invoice.
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Screen References - New/Edit Credit Note
The New/Edit Credit Note dialog is where you fill in the details for a credit note. To open this 
dialog, click the Credit Note  menu item in the Sales  menu
Create From
To create a new credit note from a previous invoice, or draft credit note, select the type from 
the drop-menu to open the invoice list, sort draft credit notes list. Click the invoice, or credit 
note you need, then click Select to fill the details in on the new credit note.
Credit Note Customer
Either type the name of the customer, or use the drop menu to select a previous customer. 
Adding a new customer into this field will create a record for that customer, which you can 
complete later with their contact details from the Customer List.
Customer Address
Enter the customer address.
Date
Select the Credit Note date.
Salesperson
Enter the salesperson for this credit note, or choose one from the pull-down list.
Invoice
This field displays the invoice to which this Credit Note has been applied.
Tax
Select any special sales tax option, e.g., if this is a special customer who is sales-tax exempt 
(for example a foreign customer).
Deposit Account 
Select a deposit account for the transaction from the drop-down menu. 
Credit Note Items
This is the list of items on the credit note. Click on the Add button to add a new item, then click 
within the Item or Description cells to access a drop-menu where you can select an item, or 
type the name of a new item. New items will automatically be added to the Items List . Change 
the Quantity or Unit Value by typing in a new value. Remove an item by clicking the 'trash' icon 
at the left of the item entry.
Add Discount
Click the Add Discount  button to apply a discount either to all items, or to a line item. See the 
Apply Discount help topic for more information about discounting. 
Comments
These notes are printed on the bottom of the Credit Note.
Private Comments
These are notes for internal use only they are not printed on the Credit Note.
Total
This is the sales tax and total display. If you think the sales tax calculation is wrong, please see 
the Tax tab of Options.
Record
Click on this button to view options for Recording a Credit Note. Click on the pull down list and 
select an action. You can Record and Print, Record and Fax, or Record and Email. You can 
also select to Record Only, Save as Draft or Preview the Credit Note.
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Screen References - New/Edit Sales Order
The New/Edit Sales Order dialog is where you fill in the details for an order. To open this 
dialog, click the Sales menu and select New Sales Order, or click the Create new Sales 
Order link in the explorer bar on the Sales tab
Quote Number 
If you want to use a previous quote to create the sales order, choose the quote from the pull 
down list. For a new sales order, leave the pull down display blank. 
Customer 
Choose the Customer from the pull down list, or enter a new customer. Adding new customer 
here will create a new record for the customer on Customer List so you can quickly access 
every time you create quotes, orders and invoices. 
Date 
Select the order date. 
Terms 
The payment terms are used to calculate the payment due date. 
Salesperson  
Enter the salesperson for this order, or choose one from the pull-down list. 
Save changes to this customer (if available)  
Tick this if you want the selected customers address to be the introduced "Bill To" address. 
Bill To  
Enter the address the order should be sent to. 
Ship To 
Enter the address the products should be sent to. Leave this blank if this is not required. 
Customer PO No.
The customer purchase order number is printed on the order and on the statements for 
customer reference. Leave this blank if not required. 
Tax 
Select the special sales tax exempt option if this is a customer who is sales-tax exempt (a 
foreign customer, for example). 
Ship By  
Select the shipping method from the drop-menu, or enter a new shipping method. The Ship By 
detail will be printed on the order for customer reference. Leave this blank if not required. 
Tracking Ref No. 
The tracking reference number refers to the shipping method, and is printed on the order for 
customer reference. Leave this blank if not required. 
Order Items 
This is the list of items on the order. Click on the Add button to add a new item, then click 
within the Item or Description cells to access a drop-menu where you can select an item, or 
type the name of a new item. Change the Quantity or Unit Value by typing in a new value. 
Remove an item by clicking the red "X" at the right of the item entry. 
When you enter new items here, they will automatically be added to the Items List  so you can 
quickly add them to orders, quotes and invoices later.
Add Discount
Click the Add Discount button to apply a discount either to the entire invoice, or to a line item. 
See the Apply Discount help topic for more information about discounting. 
Comments 
These notes are printed on the bottom of the order. 
Private Comments 
These are notes for internal use only - they are not printed on the order. 
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Total
This is the sales tax, subtotal and total display. If the sales tax calculation is wrong, please see 
Taxes in the Getting Started section and Options ~ Tax for more information. 
Save and Preview 
Save the order, and preview how the Sales Order will look by clicking the button in the lower 
left corner of the window.
Convert to Invoice / Edit Invoice  
If there is not yet an invoice for this sales order the Convert to Invoice button will be shown, if 
there is already an invoice then the Edit Invoice button will be shown. 

Convert to Invoice 
You can quickly turn the sales order into an invoice by clicking this button. Doing so will 
save a copy of the sales order in the Sales Order List  with a status of "Invoiced." 
Edit Invoice 
Edit the existing invoice for this order. 
Record  

Click on this button to Record or save the order. To record and print, fax, or email click on the 
pull down list and select an action. You can also select to Record with Payment, so the order 
will be recorded as paid, or select to record as recurring if the order should be created on a 
schedule. 
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Screen References - New/Edit Purchase Order
The New/Edit Purchase Order dialog is where you fill in the details for a purchase order. To 
open this dialog, click the Purchases menu  and select New Purchase Order.
Order Supplier 
Choose the Supplier from the pull down list, or enter a new supplier. Adding new suppliers 
here will create a new record for the supplier on Suppliers List so you can quickly access every 
time you create purchase orders. 
Date 
Select the purchase order date. 
Vendor address 
Enter the vendor's address. 
Ship To 
Enter the address the products should be sent to. Leave this blank if this is not required. 
Tax 
Select the special sales tax exempt option if this is a supplier who is sales-tax exempt (a 
foreign supplier, for example). 
Purchase Order Items 
This is the list of items on the order. Click on the Add button to add a new item, then click 
within the Item or Description cells to access a drop-menu where you can select an item, or 
type the name of a new item. Change the Quantity or Unit Value by typing in a new value. 
Remove an item by clicking the red "X" at the right of the item entry. 
When you enter new items here, they will automatically be added to the Items List  so you can 
quickly add them to orders, quotes and invoices later.
Comments 
These comments are printed on the bottom of the purchase order. 
Private Comments 
These are comments for internal use only - they are not printed on the purchase order. 
Total  
This is the sales tax, subtotal and total display. If the sales tax calculation is wrong, please see 
Taxes in the Getting Started section and Options ~ Tax for more information. 
Save and Preview 
Click this button to save any changes to the purchase order and preview how the purchase 
order will look like before printing. 
Record  
Click on this button to Record or save the order. To record and print, fax, or email click on the 
pull down list and select an action. 
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Screen References - New/Edit Accounts Payable
The New/Edit Accounts Payable dialog is where you can enter a bill you have received for 
payment at a later date. To open this dialog, click the Purchases menu  and select Enter 
Accounts Payable, or click the Enter Payable  icon on the toolbar of the Home  tab, Purchas
es  tab, Banking tab, or Reports tab. 
Supplier  
Choose the Supplier from the pull down list, or enter a new supplier. Adding new suppliers 
here will create a new record for the supplier on the Suppliers List so you can quickly access 
them every time you create purchase orders. 
Date 
Select the date. 
Vendor address 
Enter the vendor's address. 
Ship To 
Enter the address the products should be sent to. Leave this blank if this is not required. 
Tax 
Select the special sales tax exempt option if this is a supplier who is sales-tax exempt (a 
foreign supplier, for example). 
Accounts Payable Items 
This is the list of items on the bill. Click on the Add button to add a new item, then click within 
the Item or Description cells to access a drop-menu where you can select an item, or type the 
name of a new item. Change the Quantity or Unit Value by typing in a new value. Remove an 
item by clicking the red "X" at the right of the item entry. 
When you enter new items here, they will automatically be added to the Items List  so you can 
quickly add them to orders, quotes and invoices later. 
Private Notes 
These are notes for internal use only. 
Total  
This is the sales tax, subtotal and total display. If the sales tax calculation is wrong, please see 
Taxes in the Getting Started section and Options ~ Tax for more information. 
Record  
Click on this button to Record bill. 
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Screen References - New/Edit Quote
The New/Edit Quote dialog is where you fill in the details for a quote. To open this dialog, click 
the Sales menu and select New Quote.
Customer 
Choose the Customer from the pull down list, or enter a new customer. Adding new customer 
here will create a new record for the customer on Customer List so you can quickly access 
every time you create quotes, orders and invoices. 
Date 
Select the quote date. 
Salesperson  
Enter the salesperson for this quote, or choose one from the pull-down list. 
Bill To  
Enter the address the quote should be sent to. 
Ship To 
Enter the address the products should be sent to. Leave this blank if this is not required. 
Tax 
Select the special sales tax exempt option if this is a customer who is sales-tax exempt (a 
foreign customer, for example). 
Quote Items  
This is the list of items on the quote. Click on the Add button to add a new item, then click 
within the Item or Description cells to access a drop-menu where you can select an item, or 
type the name of a new item. Change the Quantity or Unit Value by typing in a new value. 
Remove an item by clicking the 'trash' icon at the left of the item entry. 
When you enter new items here, they will automatically be added to the Items List  so you can 
quickly add them to orders, quotes and invoices later.
Add Discount
Click the Add Discount button to apply a discount either to the entire quote, or to a line item. 
See the Apply Discount help topic for more information about discounting. 
Comments 
These notes are printed on the bottom of the quote. 
Private Comments 
These are notes for internal use only - they are not printed on the quote. 
Total  
This is the sales tax, subtotal and total display. If the sales tax calculation is wrong, please see 
Taxes in the Getting Started section and Options ~ Tax for more information. 
Save and Preview 
Click this button to see how the quote will appear when printed, saved as a PDF document, or 
emailed to a customer. 
Convert to Invoice / Edit Invoice  
If there is not yet an invoice for this quote the Convert to Invoice button will be shown, if there 
is already an invoice then the Edit Invoice button will be shown. 

Convert to Invoice 
Convert the quote to an invoice. The quote status will be upgraded to Invoiced in the 
system, and the New Invoice window will appear with the details from the quote filled in. 
Edit Invoice 
Edit the existing invoice for this quote. 
Record  

Click on this button to Record or save the quote. To record and print, fax, or email click on the 
pull down list and select an action. 
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Screen References - Reconcile Account
When it is time to reconcile your Express Accounts records with your bank statement, use the 
Account Reconciliation. You can reconcile manually, or upload your electronic bank statement 
into Express Accounts for faster reconciliation. To open the Reconcile Account window, click 
the Transactions menu and select Reconcile Account, or press Ctrl+E. 
The Reconcile Account window is split into two sections. At the top is the Local Ledger 
Transactions where your unreconciled transaction records entered in Express Accounts are 
displayed. At the bottom is where your bank statement is displayed, if loaded. 
Local Ledger Transactions 
Account  
Select the account you wish to reconcile from the pull down list of accounts. 
Last Reconciled Date 
The last date the selected account was reconciled will appear here. 
Bank Statement Date 
Enter the statement date that appears on your bank statement, or select a date from the 
calendar drop-down. 
New Statement Balance  
Enter the ending balance that appears on your bank statement. 
Calculated Statement Balance 
The number that appears here is the account's balance before reconciliation. 
Out of Balance  
If this field contains a value other than zero, you may have errors in your records. As you 
compare your entries with the bank statement, those errors will probably become apparent. 
List of account entries 
This is the list of account entries that have not yet been reconciled. For manual reconciliation, 
tick the checkbox of each entry that has a matching entry on your bank statement to reconcile 
the entry. For electronic reconciliation, you'll need to load your bank statement into the 
reconciliation window (see below). Entries that match up automatically will be checked off and 
will appear in green. To match an entry to an entry in the bank statement transaction's list, click 
in the Bank's Memo column for the local entry and select the bank entry that matches from the 
drop menu that appears. 
If, during reconciliation, you find errors in your local ledger transactions list, double click the 
entry to view the entry on the journal, then select the entry and click Edit. 
Add a new payment transaction 
Click here to add a new payment transaction. If you discover a missing payment entry, clicking 
this button will allow you to enter the transaction without exiting the reconciliation session. 
Add a new receipt transaction 
Click this button to add a new receipt transaction. If you discover a missing receipt entry, 
clicking this button will allow you to enter the transaction without exiting the reconciliation 
session. 
Bank Statement's Transactions  
This is the list of bank statement transactions. Entries will not appear in this list until you load a 
bank statement into the current reconciliation. Entries that match automatically will be checked 
off and displayed in green. To match an entry to an entry in the local ledger transactions list, 
click in the Ledger's Ref column for the bank entry and select the local ledger entry that 
matches. Entries that appear in red are highlighted as possible recurring fee transactions. If 
you select the entry and click Add Transaction, the entry will be added to the local ledger list, 
and will be automatically added to the local ledger list every time a bank statement containing 
the entry is loaded to the Reconcile Account dialog. 
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Load a bank statement
Click the Load a bank statement to load an external bank statement in CSV or OFX format. 
You can use either one of the following formats: 
1. DATE - JOURNAL MEMO - AMOUNT. Wherein a negative amount corresponds to 

Payments, and Deposits otherwise.
2. DATE - JOURNAL MEMO - DEPOSITS - PAYMENTS. Using this format requires a zero 

(0) value for blank entries (either deposit or payment).
Add Transaction  
This button allows you to quickly add an entry from your bank statement to your local ledger. 
Select an entry in the bank transactions list and click the Add Transaction button to open the 
Payment or the Receipts dialog. 
Rollback to Previous 
This button allows you to undo the last reconcile for the selected account. You may want to 
rollback if you have done a reconciliation by mistake or you have received more transactions 
that should have been included in the last reconcile. 
Please note that this button will only be enabled when there is a valid reconciliation to rollback 
to and you will only be able to go back at most one reconciliation. 
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Screen References - Journal Entry
From the Journal Entry dialog, you can enter the details of any type of transaction and then 
allocate the amount to two or more accounts. To make a manual journal entry, click the Transa
ctions menu  and select Manual Journal Entry, or press Ctrl+J, or access the Journal 
entry dialog from the Journal dialog by clicking the Add  button on the Journal toolbar. 
Date 
Select the date for this journal entry. 
Journal  
Select the Journal the transaction should be recorded to from the drop menu. 
Reference  
Enter reference id for this entry if you wish to record a reference id different from the auto 
generated id. 
Journal Memo  
Add a note about this journal entry that will help you remember what the entry is for. 
Account Allocation  
Allocate amounts to the accounts for this entry. Click in the table to add an account. Select an 
account by number or name by clicking in the either the Number or Name cells and select an 
account. Be sure to add both debit and credit accounts and click Record when the account 
amounts balance each other out. 
Out-of-balance amount 
If the debit and credit accounts do not balance, the out of balance amount will be displayed 
beneath the Account Allocation list. 
Use Template  
Before any information is entered into the Journal Entry dialog, the Use Template button will be 
available. Click this button to fill in the journal entries with details from a transaction template 
you have previously created. 
Save As Template  
You can make a template of transactions you make repeatedly to save yourself time. To create 
a new template, first fill in the details of the transaction on the Journal Entry, then click the 
Save As Template button at the bottom left of the dialog. You'll be prompted to name the 
template, and then the details will be saved to a list you can access next time you need to 
apply the transaction to the journal. 
Record  
Click on this button to save the journal entry.
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Screen References - Accounts Payable
The Accounts Payable dialog is where you can enter a bill you have received for payment at a 
later date. To open this dialog, click the Purchases menu  and select Enter Accounts 
Payable, or click the Enter Payable  icon on the toolbar of the Home  tab, Purchases tab, Ba
nking  tab, or Reports tab. 
Date 
Select the date for this transaction. 
Due Date 
Select the due date for this transaction. 
Supplier  
Enter the supplier the account payable is owed to. 
Supplier Address  
Enter the supplier's address. 
Accounts Payable 
Select the account this transaction will be applied to. 
Balance 
The balance of the account selected above will be displayed in this field for your reference. 
Amount 
Enter the amount of the transaction. 
Reference number 
Add an optional reference number that will appear in the Accounts Payable list, and will appear 
in a Payment made against this Accounts Payable. 
Memo  
Add a note about this transaction that will help you identify the transaction on the journal. 
Account Allocation  
Allocate amounts to the accounts for this entry. Click in the table to add an account. Select an 
account by number or name by clicking in the either the Number or Name cells and select an 
account. Be sure to add both debit and credit accounts and click Record when the account 
amounts balance each other out. 
Record  
Click Record button to save the bill. 
Out-of-balance amount 
If the debit and credit accounts do not balance, the out of balance amount will be displayed 
beneath the Account Allocation list. 
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Screen References - Link Purchase Orders
The Link Purchase Orders dialog is where you can edit the outstanding purchase orders of the 
chosen supplier. Use the pull down list to switch between purchase orders, and the item list to 
edit the order contents. Changes to purchase orders will only be saved when you click the Finis
h  button. 
Purchase Order 
Select the purchase order to edit.
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Screen References - Payments and Purchases
From the Payments and Purchases dialog, you can record the details of purchase or payment 
transactions and then allocate the amount to two or more accounts. To make a purchase or 
payment entry on the Home  tab, click Make a payment in the left sidebar under the Transacti
ons  menu. You can also go to the Purchases tab and click the Payment  button on 
the top toolbar, or click the Immediate payment or purchase block. The web version of this 
dialog may be opened with the Make a payment  link on the main page or with the Add New 
Check button on the Check List page. 
Transaction Date  
Select the date for this transaction. 
Pay To 
Select the supplier this transaction is for. You can open the Suppliers List window to select a 
supplier, or create a new supplier, by clicking the Suppliers List button. 
Account  
Select the account this transaction will be applied to. 
Account Balance  
The balance of the account selected above will be displayed in this field for your reference. 
Method 
Select the method of payment for this transaction. Payment methods for your business are 
configured in the Options -> Payments page. 
Amount 
Enter the amount of the receipt or deposit. 
Reference Number 
This is an optional field you can use to better manage your payments, such as an invoice 
number provided by a supplier. If you are entering the payment as a check, this reference 
number will appear on the check during printing. 
Transaction Reference 
The appropriate transaction reference id is already entered in this field. If you wish to enter a 
different id you can enter it instead. 
Check No. 
This field is only available if "Check" is selected as the payment method. Check numbers are 
automatically generated by Express Accounts, but you can enter a different number if required. 
Journal Memo  
Add a note about this transaction that will help you identify the transaction on the journal. 
Account Allocation  
Allocate amounts to the accounts for this entry. Click in the table to add an account. Select an 
account by number or name by clicking in the either the Number or Name cells and select an 
account. Be sure to add both debit and credit accounts and click Record when the account 
amounts balance each other out. 
Out-of-balance amount 
If the debit and credit accounts do not balance, the out of balance amount will be displayed 
beneath the Account Allocation list. 
Use Template (Desktop version only) 
Before any information is entered into the Journal Entry dialog, the Use Template button will be 
available. Click this button to fill in the receipt or deposit entry with details from a transaction 
template you have previously created. 
Save As Template (Desktop version only) 
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You can make a template of transactions you make repeatedly to save yourself time. To create 
a new template, first fill in the details of the transaction on the Receipt and Deposits dialog, 
then click the Save As Template button at the bottom left of the dialog. You'll be prompted to 
name the template, and then the details will be saved to a list you can access next time you 
need to apply the transaction to the journal. 
Record Options 
When you are ready to apply your payment, you can select from the recording options at the 
bottom of the window. Click the main part of the button to simply record payment, or select 
Record and Print Check by clicking the arrow on the right side of that button. 
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Screen References - Receipts and Deposits
From the Receipts and Deposits dialog, you can record the details of receipt or deposit 
transactions and then allocate the amount to two or more accounts. To make a receipt or 
deposit entry, click the Transactions menu and select Receive a Payment. In the web 
interface, click the Receive a payment link in the right-side navigation panel of the main page. 
Transaction Date  
Select the date for this transaction. 
Deposit Account 
Select the account this transaction will be applied to. 
Balance (Desktop version only)  
The balance of the account selected above will be displayed in this field for your reference. 
Amount 
Enter the amount of the receipt or deposit. 
Reference Number 
A payment received that can be cataloged with an optional reference number. A reference 
number is also usually provided by the supplier. 
Check Number  
The current Check prefix and/or Check number are displayed. You can change either to suit 
your needs. The number will increment by one each time a check is entered. 
Transaction Reference 
The appropriate transaction reference id is already entered in this field. If you wish to enter a 
different id you can enter it instead. 
Journal Memo  
Add a note about this transaction that will help you identify the transaction on the journal. 
Account Allocation  
Allocate amounts to the accounts for this entry. Click in the table to add an account. Select an 
account by number or name by clicking in the either the Number or Name cells and select an 
account. Be sure to add both debit and credit accounts and click Record when the account 
amounts balance each other out. 
Out-of-balance amount 
If the debit and credit accounts do not balance, the out of balance amount will be displayed 
beneath the Account Allocation list. 
Use Template (if available)  
Before any information is entered into the Journal Entry dialog, the Use Template button will be 
available. Click this button to fill in the receipt or deposit entry with details from a transaction 
template you have previously created. 
Save As Template (if available)  
You can make a template of transactions you make repeatedly to save yourself time. To create 
a new template, first fill in the details of the transaction on the Receipt and Deposits dialog, 
then click the Save As Template button at the bottom left of the dialog. You'll be prompted to 
name the template, and then the details will be saved to a list you can access next time you 
need to apply the transaction to the journal. 
Record  
Click on this button to Record your receipt or deposit transaction. 
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Screen References - Report View
From the report view, you can preview, print, save, email, or fax a report. All report windows 
will have the same options, which are described below. To view reports, click the Reports tab 
and select the type of report you would like to view.
Preview 
Click the Preview button to preview the report as it will appear in a pdf file or on a printed page. 
If the preview looks different than the printout, you may want to check your paper setting on the 
Regional tab of the Options dialog.
Print 
Click the Print button to send the report to the printer.
Save 
You can save a report as a PDF or CSV file by clicking the Save button.
Email 
You can email a report as a PDF file by clicking the Email button. Your email settings must be 
set up before this operation can be completed, which can be done on the Other tab of the 
Options dialog in the Send Settings section. 
Fax 
You can send a report by Fax as a PDF file by clicking the Fax button. Your fax settings must 
be set up before this operation can be completed, which can be done on the Other tab of the 
Options dialog in the Send Settings section.
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Screen References - Chart of Accounts List
Use this screen to manage your accounts: the number assigned to an account, the type of 
account, if it is a header account, and if it is an account open at the bank. The accounts are 
displayed in a list. To open the Chart of Accounts, from the Home tab  click the View icon in 
the toolbar and select Chart of Accounts.  To edit the account properties, double-click the 
account to open the Account Properties dialog. 
New 
Click this button to create a new account or add a new default account.
Edit 
Click this button to edit the account properties, such as account number and type, the name, 
and opening balance, of the account selected in the list. This only applies to one account at a 
time.
Delete 
To delete accounts, select the account(s) you wish to remove from the list, and click this 
button. You can delete any account as long as it hasn't been used in a transaction.
Create Default (Desktop version only) 
This adds a default account list to the Chart of Accounts. If you already have a default list, then 
you would not see any difference when clicking on this option.
Restore (Desktop version only) 
Click this button to restore the currently selected account. This only applies to one account at a 
time. To view deleted accounts, make sure the 'Also show deleted accounts' checkbox is ticked.
Number of digits in account number (Desktop version only)  
You can define the number of digits for an account number. Each account created will be 
required to have an account number with the number of digits specified here. 
Also show recently deleted accounts (Desktop version only)  
Tick this checkbox if you would like to view accounts that have recently been deleted. When 
this box is checked, deleted accounts will appear in the list highlighted in pink. 
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Screen References - Invoices List
Use this screen to manage your invoices. A list of all the invoices you have created in Express 
Accounts is displayed here. To open the Invoices list, click the View menu and select Invoices
.  
Invoice  

Under the Invoice menu you have the following actions with their short cut keys.
Find Invoice - Ctrl + F 
Use this dialog box to search for a desired Invoice in the list. You can search by Date, 
Invoice number, Order or Customer.
Find Next Invoice - F3  
The commands Find Invoice and Find Next Invoice work together. The Option to use Find 
Next Invoice appears after you use Find Invoice. Find Next Invoice Will find the next Invoice 
with the same search criteria you entered in Find Invoice.
When using Find Next Invoice, after you have scrolled through all Invoices with matching 
search criteria from Find Invoice, A pop-up window will notify that "No more invoices 
matching '(SEARCH CRITERIA)' could be found."
Note: If you delete the search criteria from the text box in Find Invoice and click OK,a 
pop-up window will notify "No matching '' could be found.". The Find Next Invoice function 
will now be grayed out and unselectable. The Find Next Invoice function will be available 
again after you use Find Invoice.
For the following actions you must first have an Invoice selected from your list.
Print Invoice - Ctrl + P 
This command will open a Print dialog window and allow you to print your invoice or safe as 
a .pdf document.
Print Preview - Ctrl + Shift + P 
The Print Preview window displays the Invoice as it will be printed by the printer.
Email Invoice - Ctrl + E  
Allows you to send the Invoice to an email recipient.
Show Log - Ctrl + L 
This dialog box displays the logs of the selected record.
Apply Payment - Ctrl + Y 
This window allows you to Add or Edit payments received.
Apply Credit Note - Ctrl + C  
The Apply Credit Note window is where you can apply a customer's credit notes to their 
overdue invoices.
Import Invoices from CSV 
External data can be imported into Express Accounts using csv files. A window will open 
that allows you to choose the CSV file you want to import from where you have it saved.
Packing Slip  
Under the Packing Slip menu you will find options for including a Packing Slip in your order. 
You must have an invoice selected to perform the following actions.
Preview Packing Slip - Ctrl + Shift + S 
The Preview Packing Slip window displays the Packing Slip as it will be printed by the 
printer.
Print Packing Slip - Ctrl + S 
This command will open a Print dialog window and allow you to print your Packing Slip or 
save it as a .pdf document.
Email Packing Slip  
Allows you to send a Packing Slip to an email recipient.
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Fax Packing Slip
Allows you to send a Packing Slip via a telephone fax number.
Save As PDF 
Allows you to save your Packing Slip as a .pdf document.
Shipping Label  
Under this menu you will find options for creating a Shipping Label in your order. You must 
have an invoice selected to perform the following actions and specify shipping instructions.
Preview Shipping Label 
The Preview Shipping Label window displays the Shipping Label as it will be printed by the 
printer.
Print Shipping Label  
This command will open a Print dialog window and allow you to print your Shipping Label or 
save it as a .pdf document.
Email Shipping Label  
Allows you to send a shipping label to an email recipient.
Fax Shipping Label  
Allows you to send a shipping label via a telephone fax number.
Save As PDF 
Allows you to save your shipping label as a .pdf document.
Help 
The Help menu contains a link to the Express Accounts Help documentation, links for the 
Express Accounts webpage, technical support, related programs, and other links you might 
find useful.
You can refine the contents of the Invoices list by using the interactive filter controls below 

the main toolbar. Use the Period drop menu to filter the listed invoices by date, and the Start 
and End date pickers can be used to fine tune the date period. The Customer selector can also 
be used to further restrict the invoice selection to a specific customer, and the Display Invoices 
selector lets you choose between recorded or draft invoices only. 
New 
Click the New button on the toolbar to create a new invoice.
Copy  
Clicking the Copy button will create a new invoice and fill in the customer and item information 
automatically using the selected invoice.
Delete 
To delete invoices, select the invoice(s) you wish to remove from the list, and click the Delete 
button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected invoice. You can only edit one 
invoice at a time.
Preview 
Click the Preview button on the toolbar to see how the currently selected invoice will appear 
when printed, saved as a PDF document, or emailed to a customer.
Print 
Click the Print button on the toolbar to print the currently selected invoice(s).
Email 
Click the Email button on the toolbar to send one or more selected invoice(s) as a PDF 
document to a recipient via email. You will be asked to provide an email address. Your email 
settings must be set up before this operation can be completed, which can be done on the 
Other tab of the Options dialog in the Send Settings section.
Fax 
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Use the Fax button on the toolbar to send one or more selected invoice(s) to a recipient via 
fax. You will be asked to provide a fax number. Your fax settings must be set up before this 
operation can be completed, which can be done on the Other tab of the Options dialog in the 
Send Settings section.
Save 
Click the Save button on the toolbar to save the currently selected invoice(s) as a PDF file on 
your computer.
Payment  
Click the Payment button on the toolbar to receive a payment for the selected invoice.
Credit Note  
Click the Credit Note button on the toolbar to apply a credit note towards the selected invoice.
Packing Slip  
Click the Packing Slip menu to view options for creating a packing slip for the currently 
selected invoice. Packing slips can be previewed, printed, emailed, faxed, or saved.
Shipping Label  
Click the Shipping Label menu to view options for creating a shipping label for the currently 
selected invoice. Shipping labels can be previewed, printed, emailed, faxed, or saved.
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Screen References - Select Invoice List
Use this screen to select an invoice. A list of all the invoices you have created in Express 
Accounts is displayed here. To open the Invoices list, click the View menu and select Invoices
.  
You can refine the contents of the Invoices list by using the interactive filter controls below the 
main toolbar. Use the Period drop menu to filter the listed invoices by date, and the Start and 
End date pickers can be used to fine tune the date period. The Customer selector can also be 
used to further restrict the invoice selection to a specific customer, and the Display Invoices 
selector lets you choose between recorded or draft invoices only. 
Select 
Click the Select button on the toolbar to select the highlighted invoice.
Find Invoice - Ctrl + F  
Use this dialog box to search for a desired Invoice in the list. You can search by Date, Invoice 
number, Order, Customer or Salesperson. 
Find Next Invoice - F3  
The commands Find Invoice and Find Next Invoice work together. The Option to use Find Next 
Invoice appears after you use Find Invoice. Find Next Invoice Will find the next Invoice with the 
same search criteria you entered in Find Invoice. 
When using Find Next Invoice, after you have scrolled through all Invoices with matching 
search criteria from Find Invoice, A pop-up window will notify that "No more invoices matching 
'(SEARCH CRITERIA)' could be found." 
Note: If you delete the search criteria from the text box in Find Invoice and click OK, a pop-up 
window will notify "No matching '' could be found.". The Find Next Invoice function will now be 
grayed out and unselectable. The Find Next Invoice function will be available again after you 
use Find Invoice. 

176



Screen References - Quotes List
Use this screen to manage your customer quotes. A list of all the quotes you have created in 
Express Accounts is displayed here. To open the Quotes list, click the View menu and select 

 
Quote  

Under the Quote menu you have the following actions with their short cut keys.
New Quote  
This option will open the Edit Quote dialog with a new empty quote.
Copy Quote 
This option will create a new Quote and fill in the customer and item information 
automatically using the selected Quote.
Delete Quote(s)  
This option will delete the selected quotes from the quotes list.
Edit Quote  
This option will open the Edit Quote dialog with the selected quote.
Create Order 
This option will create an Order from your Quote.
Create Invoice 
This option will create an Invoice from your Quote.
Find Quote - Ctrl + F 
Use this dialog box to search for a desired Quote in the list. You can search by Date, Quote, 
or Customer.
Find Next Quote - F3 
The commands Find Quote and Find Next Quote work together. The option to use Find 
Next Quote appears after you use Find Quote. Find Next Quote Will find the next Quote 
with the same search criteria you entered in Find Quote.
When using Find Next Quote, after you have scrolled through all Quotes with matching 
search criteria from Find Quote, A pop-up window will notify that "No more quotes matching 
'(SEARCH CRITERIA)' could be found."
Note: If you delete the search criteria from the text box in Find Quote and click OK, a 
pop-up window will notify "No matching '' could be found.". The Find Next Quote function 
will now be grayed out and unselectable. The Find Next Quote function will be available 
again after you use Find Quote.
For the following actions you must first have a Quote selected from your list.
Print Quote - Ctrl + P 
This command will open a print dialog window and allow you to print your Quote or safe as 
a .pdf document.
Print Preview - Ctrl + Shift + P 
The Print Preview window displays the Quote as it will be printed by the printer.
Email Quote - Ctrl + E 
Allows you to send the Quote to an email recipient.
Fax Quote 
Allows you to send a Quote via a telephone fax number.
Save As PDF 
Allows you to save your Quote as a .pdf document.
Import Quotes from CSV 
External data can be imported into Express Accounts using csv files. A window will open 
that allows you to choose the CSV file you want to import from where you have it saved.
Help 
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The Help menu contains a link to the Express Accounts Help documentation, links for the 
Express Accounts webpage, technical support, related programs, and other links you might 
find useful.
You can refine the contents of the Quotes list by using the interactive filter controls below 

the main toolbar. Use the Period drop menu to filter the listed quotes by date, and the Start and 
End date pickers can be used to fine tune the date period. The Customer selector can also be 
used to further restrict the quote selection to a specific customer, and the Display Quotes 
selector lets you choose between recorded or draft quotes only. 
New 
Click the New button on the toolbar to create a new quote.
Copy  
Clicking the Copy button will create a new quote and fill in the customer and item information 
automatically using the selected quote.
Delete 
To delete quotes, select the quote(s) you wish to remove from the list, and click the Delete 
button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected quote. You can only edit one 
quote at a time.
Order 
Click the Order button on the toolbar to create a new Order using the currently selected quote. 
The information for the new Order will be filled in using the selected quote.
Invoice  
Click the Invoice button on the toolbar to create a new Invoice using the currently selected 
quote. The information for the new Invoice will be filled in using the selected quote.
Preview 
Click the Preview button on the toolbar to see how the currently selected quote will appear 
when printed, saved as a PDF document, or emailed to a customer.
Print 
Click the Print button on the toolbar to print the currently selected quote(s).
Email 
Click the Email button on the toolbar to send one or more selected quote(s) as a PDF 
document to a recipient via email. You will be asked to provide an email address. Your email 
settings must be set up before this operation can be completed, which can be done on the 
Other tab of the Options dialog in the Send Settings section.
Fax 
Use the Fax button on the toolbar to send one or more selected quote(s) to a recipient via fax. 
You will be asked to provide a fax number. Your fax settings must be set up before this 
operation can be completed, which can be done on the Other tab of the Options dialog in the 
Send Settings section.
Save 
Click the Save button on the toolbar to save the currently selected quote(s) as a PDF file on 
your computer.
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Screen References - Select Quote List
Use this screen to select a quote. A list of all the quotes you have created in Express Accounts 
is displayed here. To open the Quotes list, click the View menu and select Quotes.  
You can refine the contents of the Quotes list by using the interactive filter controls below the 
main toolbar. Use the Period drop menu to filter the listed quotes by date, and the Start and 
End date pickers can be used to fine tune the date period. The Customer selector can also be 
used to further restrict the quote selection to a specific customer, and the Display Quotes 
selector lets you choose between recorded or draft quotes only. 
Select 
Click the Select button on the toolbar to selected the highlighted quote.
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Screen References - Sales Orders List
Use this screen to manage your customer sales orders. A list of all the sales orders you have 
created in Express Accounts is displayed here. To open the Sales Orders list, click the View 
menu and select Sales Orders. 
Order 

Under the Order menu you have the following actions with their short cut keys.
Convert this order to an invoice 
This option will create your Order into an Invoice.
Find Order - Ctrl + F  
Use this dialog box to search for a desired Order in the list. You can search by Date, Order 
number, Quote or Customer.
Find Next Order - F3 
The commands Find Order and Find Next Order work together. The Option to use Find Next 
Order appears after you use Find Order. Find Next Order Will find the next Order with the 
same search criteria you entered in Find Order.
When using Find Next Order, after you have scrolled through all Orders with matching 
search criteria from Find Invoice, A pop-up window will notify that "No more orders matching 
'(SEARCH CRITERIA)' could be found."
Note: If you delete the search criteria from the text box in Find Order and click OK, a pop-up 
window will notify "No matching '' could be found.". The Find Next Order function will now be 
grayed out and unselectable. The Find Next Order function will be available again after you 
use Find Order.
For the following actions you must first have an Order selected from your list.
Print Order - Ctrl + P 
This command will open a Print dialog window and allow you to print your Order or safe as 
a .pdf document.
Print Preview - Ctrl + Shift + P 
The Print Preview window displays the Order as it will be printed by the printer.
Email Order - Ctrl + E 
Allows you to send the Order to an email recipient.
Fax Order 
Allows you to send an Order via a telephone fax number.
Save As PDF 
Allows you to save your Order as a .pdf document.
Import Orders from CSV 
External data can be imported into Express Accounts using csv files. A window will open 
that allows you to choose the CSV file you want to import from where you have it saved.
Help 
The Help menu contains a link to the Express Accounts Help documentation, links for the 
Express Accounts webpage, technical support, related programs, and other links you might 
find useful.
You can refine the contents of the Sales Orders list by using the interactive filter controls 

below the main toolbar. Use the Period drop menu to filter the listed sales orders by date, and 
the Start and End date pickers can be used to fine tune the date period. The Customer selector 
can also be used to further restrict the sales order selection to a specific customer, and the 
Display Sales Orders selector lets you choose between recorded or draft sales orders only. 
New 
Click the New button on the toolbar to create a new sales order.
Delete 
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To delete sales orders, select the sales order(s) you wish to remove from the list, and click the 
Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected sales order. You can only edit 
one sales order at a time.
Invoice  
Click the Invoice button on the toolbar to create a new Invoice using the currently selected 
order. The information for the new Invoice will be filled in using the selected order.
Preview 
Click the Preview button on the toolbar to see how the currently selected sales order will 
appear when printed, saved as a PDF document, or emailed to a customer.
Print 
Click the Print button on the toolbar to print the currently selected sales order(s).
Email 
Click the Email button on the toolbar to send one or more selected sales order(s) as a PDF 
document to a recipient via email. You will be asked to provide an email address. Your email 
settings must be set up before this operation can be completed, which can be done on the 
Other tab of the Options dialog in the Send Settings section.
Fax 
Use the Fax button on the toolbar to send one or more selected sales order(s) to a recipient via 
fax. You will be asked to provide a fax number. Your fax settings must be set up before this 
operation can be completed, which can be done on the Other tab of the Options dialog in the 
Send Settings section.
Save 
Click the Save button on the toolbar to save the currently selected sales order(s) as a PDF file 
on your computer.
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Screen References - Select Sales Orders List
Use this screen to select a sales order. A list of all the sales orders you have created in 
Express Accounts is displayed here. To open the Sales Orders list, click the View menu and 
select Sales Orders. 
You can refine the contents of the Sales Orders list by using the interactive filter controls below 
the main toolbar. Use the Period drop menu to filter the listed sales orders by date, and the 
Start and End date pickers can be used to fine tune the date period. The Customer selector 
can also be used to further restrict the sales order selection to a specific customer, and the 
Display Sales Orders selector lets you choose between recorded or draft sales orders only. 
Select Order  
Click the Select button on the toolbar to select the highlighted sales order.
Find Order - Ctrl + F 
Use this dialog box to search for a desired Order in the list. You can search by Date, Order 
number, Quote, Customer or Salesperson. 
Find Next Order - F3 
The commands Find Order and Find Next Order work together. The Option to use Find Next 
Order appears after you use Find Order. Find Next Order Will find the next Order with the 
same search criteria you entered in Find Order. 
When using Find Next Order, after you have scrolled through all Orders with matching search 
criteria from Find Invoice, A pop-up window will notify that "No more orders matching 
'(SEARCH CRITERIA)' could be found." 
Note: If you delete the search criteria from the text box in Find Order and click OK, a pop-up 
window will notify "No matching '' could be found.". The Find Next Order function will now be 
grayed out and unselectable. The Find Next Order function will be available again after you 
use Find Order. 
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Screen References - Purchase Orders List
Use this screen to manage your purchase orders. A list of all the purchase orders you have 
created in Express Accounts is displayed here. To open the Purchase Orders list, click the Vie
w menu  and select Purchase Orders. 
You can refine the contents of the Purchase Orders list by using the interactive filter controls 
below the main toolbar. 

Use the Period drop menu to filter the listed purchase orders by date, and the Start and End 
date pickers can be used to fine tune the date period. 
The Supplier selector can also be used to further restrict the purchase order selection to a 
specific supplier 
The Display Purchase Orders selector lets you choose between recorded or draft purchase 
orders only. 
The Status selector can be used to filter 'Open' or 'Received' purchase orders. 
New (if available)  

Click the New button on the toolbar to create a new purchase order.
Delete (if available) 
To delete purchase orders, select the purchase order(s) you wish to remove from the list, and 
click the Delete button on the toolbar.
Select (if available) 
Click the Select button on the toolbar to selected the highlighted purchase order.
Edit 
Click the Edit button on the toolbar to edit the currently selected purchase order. You can only 
edit one purchase order at a time.
Preview 
Click the Preview button on the toolbar to see how the currently selected purchase order will 
appear when printed, saved as a PDF document, or emailed to a customer.
Print (if available) 
Click the Print button on the toolbar to print the currently selected purchase order(s).
Email 
Click the Email button on the toolbar to send one or more selected purchase order(s) as a PDF 
document to a recipient via email. You will be asked to provide an email address. Your email 
settings must be set up before this operation can be completed, which can be done on the 
Other tab of the Options dialog in the Send Settings section.
Fax 
Use the Fax button on the toolbar to send one or more selected purchase order(s) to a 
recipient via fax. You will be asked to provide a fax number. Your fax settings must be set up 
before this operation can be completed, which can be done on the Other tab of the Options 
dialog in the Send Settings section.
Save 
Click the Save button on the toolbar to save the currently selected purchase order(s) as a PDF 
file on your computer.
Bill  
Click the Bill button on the toolbar to convert currently selected purchase order easily into 
bills/accounts payable records. You can only convert one purchase order to bill at a time.
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Screen References - Accounts Payable List
Use this screen to manage your accounts payable. A list of all the accounts payable you have 
entered in Express Accounts is displayed here. To open the Accounts Payable list, click the Vie
w menu  and select Accounts Payable. 
You can refine the contents of the Accounts Payable list by using the interactive filter controls 
below the main toolbar. Use the Period drop menu to filter the listed accounts payable by date, 
and the Start and End date pickers can be used to fine tune the date period. The Supplier 
selector can also be used to further restrict the accounts payable selection to a specific 
supplier, and the Display Purchase Orders selector lets you choose between recorded or draft 
purchase orders only. 
New 
Click the New button on the toolbar to enter a new accounts payable.
Delete 
To delete accounts payable, select the accounts payable you wish to remove from the list, and 
click the Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected accounts payable. You can 
only edit one accounts payable at a time.
Payment (if available)  
Click this button to apply payment for the selected account payable bill.
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Screen References - Select Account Payable List
Use this screen to select an account payable. A list of all the accounts payable you have 
entered in Express Accounts is displayed here. To open the Accounts Payable list, click the Vie
w menu  and select Accounts Payable. 
You can refine the contents of the Accounts Payable list by using the interactive filter controls 
below the main toolbar. Use the Period drop menu to filter the listed accounts payable by date, 
and the Start and End date pickers can be used to fine tune the date period. The Supplier 
selector can also be used to further restrict the accounts payable selection to a specific 
supplier, and the Display Purchase Orders selector lets you choose between recorded or draft 
purchase orders only. 
Select 
Click the Select button on the toolbar to select the highlighted account payable.
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Screen References - Payments of Accounts 
Payable
Use this screen to manage your payments of accounts payable. A list of all the payments you 
have entered in Express Accounts is displayed here. To open the Payments list, click the View 
menu and select Payments of Accounts Payable. 
You can refine the contents of the Payments list by using the interactive filter controls below 
the main toolbar. Use the Period drop menu to filter the listed payments by date, and the Start 
and End date pickers can be used to fine tune the date period. The Supplier selector can also 
be used to further restrict the payment selection to a specific supplier. 
New 
Click the New button on the toolbar to enter a new payment.
Delete 
To delete payments, select the payment(s) you wish to remove from the list, and click the 
Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected payment. You can only edit 
one payment at a time.
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Screen References - Customers List
Use this screen to manage your customer records. A list of all the customers you have entered 
in Express Accounts is displayed here. To open the Customer list, click the View menu and 
select Customers.  
Note that when the Customers List is accessed through the Invoice, Order, Quotes, New Credit 
Notes and Receipt windows that the Invoice, Quote, Order, Payment, and Statement buttons 
and some menus and menu items will not be displayed in the the list window. 
Select (if available) 
Click the Select button to select a supplier for entry into a form.
Add  
Click the Add button on the toolbar to create a new customer record.
Delete 
To delete a customer record, select the customer record(s) you wish to remove from the list, 
and click the Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected customer record. You can only 
edit one customer record at a time.
Quote (if available)  
Click this button to create a new quote for the selected customer.
Order (if available) 
Click this button to create a new order for the selected customer.
Invoice (if available)  
Click this button to create a new invoice for the selected customer.
Payment (if available)  
Click this button to receive a payment for the selected customer.
Statement (if available)  
This menu button provides various statement actions for the currently selected customer. 
● Print - Print a statement for the customer directly to a printer.
● Print Preview - View the customer's statement as it would be printed, but on your 

computer's screen instead.
● Email - Send a statement for the selected customer in PDF format via email. You will be 

asked to provide an email address. Your email settings must be set up before this 
operation can be completed, which can be done on the Other tab of the Options dialog in 
the Send Settings section.

● Fax - Send a statement for the selected customer via fax. You will be asked to provide a 
fax number. Your fax settings must be set up before this operation can be completed, 
which can be done on the Other tab of the Options dialog in the Send Settings section.

● Save as PDF - Save a statement as a PDF file on your computer.
Save 
Click this button to save records of all customers. 
● Save as PDF - Save records as a PDF file on your computer.
● Save as CSV - Save records as a CSV file on your computer.
Display Customers Group 
Click on this drop down to filter and view only customers belonging to a specific customer 
group.
To create customer groups, see the Customer Groups List topic under the Screen References 
section of this help manual.
Display inactive customers 
Check this box to include any inactive customers in the customer list.
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The inactive customers will be highlighted with a colored background.
Customer menu  
Click the Customer menu to view options for adding, editing and deleting customers; creating 
quotes, orders, invoices, and applying payments; emailing or phoning a customer; finding a 
customer in the list; managing customer groups, importing customers from CSV, Outlook or 
another business, or exporting the customer list; recalculating the customer balance; and 
printing an envelop with the customer's address on it.
Report menu 
Click the Report menu to print, preview, email, fax, save a pdf or csv report of the list of 
customers.
Shipping Label (if available)  
Click the Shipping Label menu to view options for creating a shipping label for the currently 
selected customer. Shipping labels can be previewed, printed, emailed, faxed, or saved.
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Screen References - Suppliers List
Use this screen to manage your supplier records. A list of all the suppliers you have entered in 
Express Accounts is displayed here. This list is also displayed when you want to select a 
supplier to enter into a form, such as the Payments and Purchases form. 
Select (shown only when selecting a supplier for a form) 
Click the Select button to select a supplier for entry into the Payments and Purchases form.
Add  
Click the Add button on the toolbar to create a new supplier record.
Delete 
To delete a supplier record, select the supplier record(s) you wish to remove from the list, and 
click the Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected supplier record. You can only 
edit one supplier record at a time.
Find Supplier 
Select this option to open the Find Supplier window. From here, enter the Supplier name you 
want to search for to locate it in the list.
Find Next Supplier  
Select this option to find the next Supplier in the list with the last term searched for, or use the 
shortcut F3 to locate the next Supplier in the list.
Email (if available) 
Click the Email button on the toolbar to send an email to the currently selected supplier.
Call (if available) 
Click the Call button on the toolbar to call the currently selected supplier. Clicking this button 
will open Express Talk, a VoIP Softphone. You can learn more about Express Talk at 
http://www.nch.com.au/talk/index.html
Export Data for Mail Merge (if available)  
Use this option to export your suppliers list if you need to use it for mail merge. Please see 
Mail Merge for more details. 
Import Suppliers from CSV 
This option is only available from the desktop version of Express Accounts. It is also not 
available from the Supplier menu when the Supplier list is opened from the Payments and 
Purchases form.
You can import a list of suppliers you have used previously to save time entering new suppliers 
into Express Accounts. To import a list, open the Suppliers list, click the Supplier  menu and 
click Import Suppliers from CSV. Browse to the CSV file and click Open. The Match CSV 
Fields dialog will open in Express Accounts. You'll need to match up the columns from the CSV 
file with headings in Express Accounts. For more information on how to do this, see the help 
topic Match CSV Fields in the Screen References section of this manual. 
Statement (if available)
This menu button provides various statement actions for the currently selected supplier. 
● Print - Print a statement for the supplier directly to a printer.
● Print Preview - View the supplier's statement as it would be printed, but on your computer's 

screen instead.
● Email - Send a statement for the selected supplier in PDF format via email. You will be 

asked to provide an email address. Your email settings must be set up before this 
operation can be completed, which can be done on the Other tab of the Options dialog in 
the Send Settings section.
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● Fax - Send a statement for the selected supplier via fax. You will be asked to provide a fax 
number. Your fax settings must be set up before this operation can be completed, which 
can be done on the Other tab of the Options dialog in the Send Settings section.

● Save as PDF - Save a statement as a PDF file on your computer.
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Screen References - Payments List
Use this screen to manage your customer payments. A list of all the payments you have 
received in Express Accounts is displayed here. To open the Payments list, click the View 
menu and select Payments.  
You can refine the contents of the Payments list by using the interactive filter controls below 
the main toolbar. Use the Period drop menu to filter the listed payments by date, and the Start 
and End date pickers can be used to fine tune the date period. The Customer selector can also 
be used to further restrict the payment selection to a specific customer. 
Payment  

Under the Payment menu you have the following actions with their short cut keys.
Charge Credit Card - Ctrl + C  
This function uses the customer’s credit card on file to charge the amount specified in the 
payment record. Once the charge has gone through, a reference number is generated in 
the payment record.
Find Payment - Ctrl + F  
Use this dialog box to search for a desired Payment in the list. You can search by Date, 
Payment number, or Customer.
Find Next Payment - F3 
The commands Find Payment and Find Next Payment work together. The Option to use 
Find Next Payment appears after you use Find Payment. Find Next Payment Will find the 
next Payment with the same search criteria you entered in Find Payment.
When using Find Next Payment, after you have scrolled through all Payments with 
matching search criteria from Find Payment, A pop-up window will notify that "No more 
Payments matching '(SEARCH CRITERIA)' could be found."
Note: If you delete the search criteria from the text box in Find Payment and click OK, a 
pop-up window will notify "No matching '' could be found.". The Find Next Payment function 
will now be grayed out and unselectable. The Find Next Payment function will be available 
again after you use Find Payment.
New 

Click the New button on the toolbar to enter a new customer payment.
Delete 
To delete payments, select the payment(s) you wish to remove from the list, and click the 
Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected payment. You can only edit 
one payment at a time.
Refund  
Click this button to apply a refund on the selected payment. 
Preview 
Click the Preview button on the toolbar to see how the currently selected payment will appear 
when printed, saved as a PDF document, or emailed to a customer.
Print 
Click the Print button on the toolbar to print the currently selected payment(s).
Email 
Click the Email button on the toolbar to send one or more selected payment(s) as a PDF 
document to a recipient via email. You will be asked to provide an email address. Your email 
settings must be set up before this operation can be completed, which can be done on the 
Other tab of the Options dialog in the Send Settings section.
Fax 
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Use the Fax button on the toolbar to send one or more selected payment(s) to a recipient via 
fax. You will be asked to provide a fax number. Your fax settings must be set up before this 
operation can be completed, which can be done on the Other tab of the Options dialog in the 
Send Settings section.
Save 
Click the Save button on the toolbar to save the currently selected payment(s) as a PDF file on 
your computer.
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Screen References - Enter New Column Name
Use this dialog box to edit the column name. 
Enter New Column Name 
Enter a new column name that will replace current column name.
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Screen References - Refund
The Express Accounts Refund window allows you to apply a refund on the selected payment. 
In payments list dialog, select a payment, click "Payments" in menu bar and select Refund. Cus
tomer Refund  
Date:  
Enter the date the refund for the refund 
Customer:  
Select the customer from the drop-menu, or enter a new customer using the customer button 
to the right of the drop-menu. 
Amount: 
If you selected a customer, this field will automatically fill with the customer's account balance. 
If the payment does not match this number, enter the exact amount paid. 
Method:  
Select how the refund was made. 
Reference Number:  
Enter the reference number. Leave this field blank if you charge by credit card online; the 
reference number will generate automatically after success. If you do not charge by credit card, 
entering a reference number is optional, but can help you keep soft references between 
refunds and invoices. 
Record: 
Click on this button to Record the payment. To select the action (Record and Print) click on the 
pull down list. 
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Screen References - Items List
Use this screen to manage your items records. A list of all the items you have entered in 
Express Accounts is displayed here. To open the Items list, click the View menu and select Ite
ms.  
Select (if available) 
Use the select button to add the selected items to the items list.
Add  
Click the Add button on the toolbar to create a new item record.
Delete 
To delete a item record, select the item(s) you wish to remove from the list, and click the Delete 
button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected item record. You can only edit 
one supplier record at a time.
Print to 
You can print the document by clicking the Print To button.
This will open the Select Report Value to Sort By dialog which allows you to choose which 
column to sort the Items by.
From here the View button will open the generated report with the choice to email, fax, print 
and save the report. 

Item menu
In addition to the options on the toolbar, the Item menu also includes options for the following:

Find Item 
Select this option to open the Find Item window. From here, enter the item name you want to 
search for to locate it in the list.
Find Next Item  
Select this option to find the next item in the list with the last term searched for, or use the 
shortcut F3 to locate the next item in the list.
Import Items from CSV 
To import items into Express Accounts from a CSV list, select this option.
Import Items from other Business  
To import items from another Express Accounts business, select this option.
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Screen References - Vehicle List
Use this screen to manage your vehicles. A list of all the vehicles you have entered in Express 
Accounts is displayed here. To open the Vehicle list, click the View menu and select Vehicle 
List. 
You can view all the mileage records for a vehicle in this list by selecting a vehicle, clicking the 

 menu, then selecting View Trips  (you can also right-click a vehicle and select View 
trips for selected vehicle). This will open the Vehicle Mileage List window filled with only the 
mileage records for the selected vehicle. 
Select (if available) 
Click the Select button to select a vehicle for mileage records.
Add  
Click the Add button on the toolbar to create a new vehicle.
Delete 
To delete a vehicle, select the vehicle(s) you wish to remove from the list, and click the Delete 
button on the toolbar. Deleting a vehicle with associated mileage records will ask if you want to 
delete the mileage records as well.
Edit 
Click the Edit button on the toolbar to edit the currently selected vehicle. You can only edit one 
vehicle at a time.
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Screen References - Vehicle Mileage List
Use this screen to manage your vehicle mileage records. A list of all the mileage records you 
have entered in Express Accounts is displayed here. To open the Mileage list, click the View 
menu and select Mileage List. 
Add  
Click the Add button on the toolbar to add mileage for a vehicle.
Delete 
To delete a mileage record, select the record(s) you wish to remove from the list, and click the 
Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected mileage record. You can only 
edit one record at a time.
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Screen References - Print Preview
The Preview window displays each page of the document as it will be printed by the printer.
Edit (if available) 
You can edit this document by clicking the Edit button.
This will close the preview window and open the edit Invoice dialog in order for you to modify 
the current record.
Email 
You can email this document by clicking the Email button.
This will open a window to enter the recipient's email address(es) and an optional message, 
and will send an email to the entered address(es) with the document as an attachment. 
Print (if available) 
You can print the document by clicking the Print button.
This will open the printer selection and settings dialog where you can select which pages of the 
document to print. 
Fax (if available) 
You can fax this document by clicking the Fax button.
This will open a window to enter the desired fax number, and will fax the document to the 
entered number. 
Save PDF (if available) 
If you want to save the record in PDF, you can do so in Save PDF button.
This will open a file browser window and will let you choose where you want the PDF file to be 
saved.
Set Recurring (if available) 
If you want to save the current invoice to a recurring invoice, you can do so via Set Recurring 
button.
This will open the Recurring Invoice Schedule window for you to set the options related to a 
recurring invoice.
Apply Payment (if available) 
If you want to apply a payment to the current invoice, you can do so via Apply Payment button.
This will open the Payment Method window for you to specify the payment mode and verify 
amount to be paid.
Set Logo (if available)  
If you haven't set the business logo, you can do so via Set Logo button.
This will open a file browser dialog where you can search and select your business logo.
Delete (if available) 
This will ask for you confirmation before deleting the invoice record.
Invoice Layout (if available) 
If you want to apply some customizations on your invoice, you can do so via Invoice Layout 
button.
This will open the Invoice Style page of your Options window.
Previous and Next (if available) 
Use the Previous and Next buttons to view each page of the document when there is more 
than one page to print. 
Close The Close button closes the window. 
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Screen References - Recurring Invoices List
Use this screen to manage your recurring invoices. A list of all the recurring invoice schedules 
you have created in Express Accounts is displayed here. To open the Recurring Invoices list, 
click the View menu and select Recurring Invoices. 
New 
Click the New button on the toolbar to create a new recurring invoice. This will open the New 
Invoice window, which you should fill out like a normal invoice and save as a recurring invoice 
to set the invoicing schedule.
Delete 
To delete recurring invoices, select the recurring invoice(s) you wish to remove from the list, 
and click the Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected recurring invoice. You can only 
edit one recurring invoice at a time.
Schedule  
Click the Schedule button on the toolbar to view and/or change the schedule for the selected 
recurring invoice, or to change the action taken when the invoice is generated (email, fax, print, 
save, etc.).
Preview 
Click the Preview button on the toolbar to see how the recurring invoice will appear when 
printed, saved as a PDF document, or emailed to a customer.
Show Log 
Select this option from the Invoice menu to view the log related to the selected recurring 
invoice. The log will show information about past activity related to the selected recurring 
invoice.
Find Recurring Invoice 
Select this option to open the Find Recurring Invoice window. From here, enter the invoice 
name you want to search for to locate it in the list.
Find Next Recurring Invoice 
Select this option to find the next invoice in the list with the last term searched for, or use the 
shortcut F3 to locate the next invoice in the list.
Run  
Click the Run button on the toolbar to generate all currently due invoices for the selected 
recurring invoice, according to its schedule.
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Screen References - Recurring Orders List
Use this screen to manage your recurring sales orders. A list of all the recurring sales order 
schedules you have created in Express Accounts is displayed here. To open the Recurring 
Orders list, click the View menu and select Recurring Orders.  
New 
Click the New button on the toolbar to create a new recurring sales order. This will open the 
New Order window, which you should fill out like a normal sales and save as a recurring sales 
order to set the order schedule.
Delete 
To delete recurring sales orders, select the recurring order(s) you wish to remove from the list, 
and click the Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected recurring sales order. You can 
only edit one recurring sales order at a time.
Schedule  
Click the Schedule button on the toolbar to view and/or change the schedule for the selected 
recurring sales order, or to change the action taken when the order is generated (email, fax, 
print, save, etc.).
Preview 
Click the Preview button on the toolbar to see how the sales order will appear when printed, 
saved as a PDF document, or emailed to a customer.
Find Recurring Order 
Select this option to open the Find Recurring Order window. From here, enter the order name 
you want to search for to locate it in the list.
Find Next Recurring Order  
Select this option to find the next order in the list with the last term searched for, or use the 
shortcut F3 to locate the next order in the list.
Run  
Click the Run button on the toolbar to generate all currently due sales orders for the selected 
recurring sales order, according to its schedule.
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Screen References - Credit Notes List
Use this screen to manage your credit notes. Here you will see a list of all the credit notes 
entered into Express Accounts. To open the Credit Notes list, click the View menu and select 

 
You can refine the contents of this list by using the interactive filter controls below the main 
button bar. You can use the 'Period' selector to filter the listed credit notes by date, and the 
'Start' and 'End' date pickers can be used to fine tune the date period. The 'Customer' selector 
can also be used to further restrict the credit notes selection to a specific customer. 
Select (Only available when the list is accessed from Apply Credit Note window) 
Click this button to apply the selected Credit Note to the Apply Credit Note window.
New (if available)  
Click this button to create a new credit note.
Delete (if available) 
To delete credit notes, select the credit note(s) you wish to remove from the list, and click this 
button.
Edit (if available) 
Click this button to edit the currently selected credit note. This only applies to one credit note at 
a time. Editing is not allowed to already applied credit notes.
Apply (if available)  
Click this button to apply the currently selected credit note towards an existing invoice.
Undo Credit (if available) 
Click this button to undo the credit applied to invoices from the selected credit note.
Preview 
Click this button to see how the credit note will appear when printed, saved as a PDF 
document, or emailed to a customer.
Print 
Click this button to print the currently selected credit note(s).
Email 
Use this button to send one or more selected credit note(s) as a PDF document to a recipient 
via email. You will asked to provide an email address.
Fax 
Use this button to send one or more selected credit note(s) to a recipient via fax. You will 
asked to provide a fax number.
Save 
Click this button to save the currently selected credit note(s) as a PDF file on your computer.
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Screen References - Salesperson List
Use this screen to manage your salespeople. A list of all the salespeople Express Accounts is 
aware of is shown here. To open the Salesperson list, click the View menu and select Salespe
ople.  
Add  
Click this button to add a new salesperson record.
Delete 
To delete salesperson records, select the salesperson you wish to remove from the list, and 
click this button.
Edit 
Click this button to edit the currently selected salesperson record.
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Screen References - View Journal
Use this screen to manage your journals. A list of all the journal entries you have made in 
Express Accounts is displayed here. To open the Journal, click the View menu and select Jour
nal.  To view a specific journal, from the Home tab  click on the journal's tab under the 
toolbar. 
You can refine the contents of the Journal list by using the interactive filter controls below the 
main toolbar. Use the Period drop menu to filter the listed journal entries by date, and the Start 
and End date pickers can be used to fine tune the date period. The Account selector can also 
be used to further restrict the journal entry selection to a specific account, and the Ref filter 
further restricts the journal view to a specific reference number. 
Add  
Click the Add button on the toolbar to create a new journal entry.
Delete 
To delete a journal entry, select the journal entry(s) you wish to remove from the list, and click 
the Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected journal entry. You can only 
edit one journal entry at a time.
Preview 
Click the Preview button on the toolbar to see how the journal will appear when printed, saved 
as a PDF document, or emailed.
Print 
Click the Print button on the toolbar to print the current journal view.
Email 
Use this button to send the current journal view as a PDF document to a recipient via email. 
You will be asked to provide an email address. Your email settings must be set up before this 
operation can be completed, which can be done on the Other tab of the Options dialog in the 
Send Settings section.
Fax 
Use this button to send the current journal view to a recipient via fax. You will be asked to 
provide a fax number. Your fax settings must be set up before this operation can be 
completed, which can be done on the Other tab of the Options dialog in the Send Settings 
section.
Save 
Click the Save button on the toolbar to save the current journal view as a PDF file on your 
computer.
Import transactions from CSV  
Click this link to start the importing process from a CSV (Comma-separated values) format file 
to the journal list. Importing will fail if the entries are not balanced, or if any of the required 
information is blank or missing. Reqiured fields are: Journal, Reference, Description, Account, 
and Debit Amount or Credit Amount.
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Screen References - View Journal - General 
Ledger Transactions
A list of transactions that has been allocated to a specific account is displayed here. 
Delete 
To delete a journal entry, select the journal entry(s) you wish to remove from the list, and click 
the Delete button on the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected journal entry. You can only 
edit one journal entry at a time.
Refresh  
Click the Refresh button on the toolbar to refresh the journal list after a change has been made.
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Screen References - Checks List
Use this screen to manage your checks. A list of all the checks you have created in Express 
Accounts is displayed here. To open the Checks list, click the View menu and select Checks. 
New 
Click the New button on the toolbar to create a new check. This will open the Payments and 
Purchases window, which you should fill out like a normal payment and save as a recurring 
sales order to set the order schedule.
Void 
To void checks, select the check(s) you wish to void from the list, and click the Void button on 
the toolbar.
Edit 
Click the Edit button on the toolbar to edit the currently selected check. You can only edit one 
check at a time.
Preview 
Click the Preview button on the toolbar to see how the check will appear when printed, saved 
as a PDF document, or emailed.
Print 
Click the Print button on the toolbar to print the currently selected check(s).
Email 
Click the Email button on the toolbar to send one or more selected check(s) as a PDF 
document to a recipient via email. You will be asked to provide an email address. Your email 
settings must be set up before this operation can be completed, which can be done on the 
Other tab of the Options dialog in the Send Settings section.
Fax 
Click the Fax button on the toolbar to send one or more selected check(s) to a recipient via fax. 
You will be asked to provide a fax number. Your fax settings must be set up before this 
operation can be completed, which can be done on the Other tab of the Options dialog in the 
Send Settings section.
Save 
Click the Save button on the toolbar to save the currently selected check(s) as a PDF file on 
your computer.
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Screen References - New Account Dialog
The New Account Dialog is where you create new accounts to be added to the Chart of 
Accounts. To locate this dialog, click the View icon in the toolbar and select Chart of 
Accounts.  From the Chart of Accounts dialog, click the New icon in the toolbar to open the 
New Account Dialog.
Add a new account from the list of Standard Default Accounts, or create an entirely new 
account from this dialog.
Use Standard Default Accounts

Select the type of account you would like to add by checking it, then click the Add 
Account(s) button to add it to the Chart of Accounts
Create New Account
Account Name
Enter a name for the account you are creating.
Type
Select an account type by clicking the radio button next to: Asset, Liability, Equity, Income, 
or Expenses. Then, specify the type using the drop menu to the right of the account type.
Classification for Cash Flow
The selection you make in this field will be used for the Cash Flow Statement reports. Your 
choices are Operating, Investing or Financing.
Account Number
Enter an account number. The number of digits in the account must match the digit amount 
set on the Chart of Accounts list, which is four by default.
Default Linked Account for (If available)
The selection you make in this field will be used as the default account for selected 
transactions.
Opening Balance
Enter an opening balance for the account, or keep it at zero.
Account is just a Header Account
If the account is a header account it means that nothing can be posted directly to the 
account but on reports the account prints the subtotals of all accounts below it with the 
same prefix.
Cash Postable
If an account is cash postable it means it will appear in the list of accounts that payments 
can be made from or deposits made to. Bank and Credit Card accounts usually have this 
option ticked.
Tax Included
Check this box if payment from this account will include sales tax. The tax will be based on 
values entered on the Tax tab of Options, but can also be adjusted on the Payments and 
Purchases dialog.
Add
When all the details for the new account have been filled in, click the Add button to add the 
account to the Chart of Accounts list.
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Screen References - Find Key String
Use this dialog box to search for a desired string in the list. Press Ctrl+F  from the list window 
to open this dialog. 
Enter the search term here  
Enter the desired search term in the text box provided below to find the matching data in the 
list window.
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Screen References - Enter New Group Name
Use this dialog box to create or edit a customer group name. To open this dialog, open the 
Customers list from the Home tab  by clicking the View icon and selecting Customers,  then 
click the Customer menu  and select Manage Customer Groups, then click the Add  icon, or 
double-click an entry to edit the customer group name. 
Enter New Group Name  
Enter a new group name that will replace current group name.

208



Screen References - Customer Groups List
Use this screen to manage your customer groups. Here, you will see a list of all the customer 
groups you have created in Express Accounts. You can also use this list to create new 
customer groups. To open the Customer Groups List, click the View menu and select Custom
ers.  From the Customer menu, select Manage Customer Groups. Alternatively, this 
screen can be accessed from a customer's record, accessed from the Customer List on the 
Other tab by clicking the customer folder icon next to the customer groups drop-menu. 
Once you have create customer groups, you can assign them to individual customer records 
on the Other tab of their customer record. See the Customer List topic in the Screen 
References section of this manual for more information about managing customer records. 
Select (if available) 
Click the Select button to add the selected customer group to the customer record.
Add  
Click the Add  button to create a new customer group.
Delete 
To delete customer groups, select the customer groups(s) you wish to remove from the list, 
and click the Delete button.
Edit 
Click the Edit button to edit the currently selected customer group in the list. This only applies 
to one customer group at a time.
Additionally, the following functions are available from the Customer Group menu:

Find Customer Group  
Select this option to open the Find Customer Group window. From here, enter the group 
name you want to search for to locate it in the list.
Find Next Customer Group 
Select this option to find the next customer group in the list with the last term searched for, 
or use the shortcut F3 to locate the next group in the list.

209

customerslist.html


Screen References - Non-invoiced Cash Sale
The Non-invoiced Cash Sale window is where you quickly create an invoice, receive payment, 
and print a receipt for a transaction from one window. To access the Non-invoiced Cash Sale 
window, click Non-invoiced cash sale block on the main or sales screen, or click Enter 
non-invoiced cash sale  from the left sidebar on the Sales screen. 
Invoice Items  
This is the list of items on the invoice. Click inside the list to add a new item. You can modify 
Item, Description, Qty, Price by clicking them. You can also use a bar code scanner to add 
new items. 
Add Item  
Click this button to enter an item in the item list. 
Remove Item  
Click this button to remove the selected item in the item list. 
Add Discount  
Input a discount amount. Note that this field is only available when discounts are enabled in 
Options . 
Discount(%) 
Input a number for discount without the % sign. E.g., 20 means 20% discount. 
Deposit Account 
Select a deposit account for the transaction from the drop menu. 
Salesperson  
Enter the salesperson for this non-invoiced cash sale, or choose one from the pull-down list. 
Comments 
These comments are printed on the bottom of the receipt. 
Private Comments 
These are comments for internal use only - they are not printed on the receipt. 
Total  
This is the total display. 
Record Cash 
Click on this button to Pay by Cash and Record the Transaction. To select the action (to Pay 
by Credit Card, Check or Create an Invoice) click on the pull down list. 
Pay by credit card. You will need to input the customer's credit card information and use the 
default setting to charge by credit card. Credit card payments can be configured from 
Options->Credit Card Gateways. 
Pay by check. You will need to input the check number. 
Save to invoice without collecting payment for the transaction. 
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Screen References - Shipping Label
Use this dialog box to set shipping instructions that will be printed on a shipping label. 
Please enter Shipping instructions 
Enter an instructions that will be printed on a shipping label.
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Screen References - Change Customer Group
Use this dialog box to change the group membership of a customer. 
Select New Customer Group.  
Select a customer group from the dropdown.
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Screen References - Change Salesperson
Use this dialog box to change the salesperson associated with a customer. 
Select New Salesperson. 
Select a salesperson from the dropdown.
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Screen References - Browse Transaction File 
Dialog
Use this dialog box to browse for the bank statement's transaction file (CSV/OFX). 
Bank file: 
You can browse for your bank statement's transaction file in CSV or OFX format.
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Screen References - Import Transaction
Use this dialog box to select which of the bank statement's transactions to import. Select the 
transactions by enabling the checkbox on the left side. 
Account  
Choose the account from the drop down list in to which the selected transactions will be 
imported in to.
Import 
Click this button to start the importing process. Users must be able to select at least one 
transaction from the list.
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Screen References - Apply Discount Quote
Fixed flat discount to the whole quote Select this option to add a flat amount as a discount 
to the entire quote. 
Fixed percentage discount to the whole quote 
Select this option to add a percentage-based discount to the entire quote. Currently this type of 
discount must be added after all other items in order to calculate the amount correctly. 
Apply line-by-line discounts to specific items 
Select this option to enable the discount column for each item on the quote. 

216



Screen References - Apply Discount Order
Fixed flat discount to the whole order  Select this option to add a flat amount as a discount 
to the entire order. 
Fixed percentage discount to the whole order  
Select this option to add a percentage-based discount to the entire order. Currently this type of 
discount must be added after all other items in order to calculate the amount correctly. 
Apply line-by-line discounts to specific items 
Select this option to enable the discount column for each item on the order. 
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Screen References - Apply Discount Credit Note
Fixed flat discount to the whole credit note Select this option to add a flat amount as a 
discount to the entire credit note. 
Fixed percentage discount to the whole credit note 
Select this option to add a percentage-based discount to the entire credit note. Currently this 
type of discount must be added after all other items in order to calculate the amount correctly. 
Apply line-by-line discounts to specific items 
Select this option to enable the discount column for each item on the credit note. 
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Screen References - Apply Discount Cash Sale
Fixed flat discount to the whole cash sale Select this option to add a flat amount as a 
discount to the entire cash sale. 
Fixed percentage discount to the whole cash sale  
Select this option to add a percentage-based discount to the entire cash sale. Currently this 
type of discount must be added after all other items in order to calculate the amount correctly. 
Apply line-by-line discounts to specific items 
Select this option to enable the discount column for each item on the cash sale. 
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Screen References - Custom Reports
The Custom Reports window is where you can create, edit, share and print customized reports 
for purposes such as tax filing. To access the Custom Reports window, click the Custom 
Reports block on the reports tab screen, or click Custom Reports from the left sidebar on the 
Reports tab. 
The Custom Reports window is divided into two main sections: Field Entry and Report Text. 
Please refer to the topics below and the help under related windows and dialogs for more 
in-depth information.
Toolbar 

New (Report)  
Click the New button on the toolbar to create a new report form. A sample report form will 
be created and listed in the Report Form pull-down list under the toolbar. You can then 
modify the new report form to your requirements. 
Edit (Report)  
Click the Edit button on the toolbar to edit the report text of the selected report form.
Delete (Report)  
Click the Delete button on the toolbar to delete the selected report form. Caution:  This 
action is permanent. Deleted report forms cannot be recovered.
Import 
Import lets you import a report form into your form list. The report form to be imported must 
be an EAF file generated by Express Accounts. This is useful for sharing forms between 
separate installations of Express Accounts.
Export  
Click this button to export or to back up the selected report form. Exported report forms can 
be imported later, or they can be shared with other users and on Express Accounts online 
forums.
Preview 
Click this button to preview the generated report text before printing.
Print 
Click this button to open the system's print dialog for printing the generated report.
Save 
Click this button to save the generated report text into a PDF file. Note: If you wish to save it 
as a simple text file, please do so by copying the report text and pasting it in the text-editor 
of your choice. 
Email 
Click the Email button to send the report to an email. The generated report will be sent as 
an attachment to the email.
Fax 
You can send a report by Fax as a PDF file by clicking the Fax button. Your fax settings 
must be set up before this operation can be completed, which can be done on the Other tab 
of the Options dialog in the Send Settings section. 
Report Form Parameters (under the toolbar) 
Report Form 
This drop menu lists all the available report forms from the active business. New report 
forms are automatically added to this list when the New button is clicked in the toolbar. 
Rename  
Click the Rename button to rename the selected report form. This must be unique and must 
not contain any of the following characters: /\<>|:*?
Period 
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Select a time period for the report from the pull-down-list. This will ensure account balances 
are pulled from the time period you are reporting on.
Start 
When "Select Period" is selected in the Period drop-menu, you can select a start date from 
the date picker to generate the report for a specific time period. This is also an in-built field 
and can be accessed by typing the field name PERIODSTART in the report text. 
End 
When "Select Period" is selected in the Period drop-menu, you can select an end date from 
the date picker to generate the report for a specific time period. This is also an in-built field 
and can be accessed by typing the field name PERIODEND in the report text. 
Field Entry 

This section contains the user-defined fields list. Each row in the list displays the attributes of a 
field such as field name, its value or formula, and the current estimate or evaluated value. You 
will create fields to represent the values that will appear on your final report, or in other field 
equations. Each field has a field type (viewed by double-clicking the field), which determines 
the value displayed. Please see the Add/Edit Field Dialog topic for more information about field 
types. 
Double-click on a row to view other attributes of the field or to edit it. A row displayed in red 
indicates an error in evaluating the field. The reason for an error can be viewed by 
double-clicking the field row. 
You can add, edit or delete a field by clicking the respective buttons from the bottom of the 
panel. 
A field's estimated value can be substituted in the Report Text section by using the field name 
in square brackets, e.g., [Field1]. 
There are few in-built system fields which cannot be modified or deleted:
PERIODSTART - Start date of the report.
PERIODEND - End date of the report.
COMPANYNAME - Name of the currently active business.
COMPANYADDR - Address of the currently active business. 

Add (Field) 
Click this button to add a field to the selected report form.
Edit (Field) 
Click this button to edit the selected field.
Delete (Field) 
Click this Delete button to delete the selected field(s). Deleted fields cannot be recovered.
Report Text 

The Report Text section lets you write the text for your report with the desired formatting, and 
is where you designate how the field values you created in the Field Entry section are 
displayed. To edit the text, click the Edit Report  button at the bottom of the window, then type 
in the Report Text pane. Click Save Report to save your changes to the report text. 
To enter field text into the Report Text, enclose the field name in square brackets, e.g., 
[Field1]. When the report is generated, the value will replace the field place holders. 
The report is generated as a simple text/pdf file without any style or formatting to keep it simple 
for the majority of users. However, technically advanced users can easily create the reports in 
csv, html or xml format.

Edit/Save Report  
This button toggles between 'Edit Report' and 'Save Report' modes allowing user to either 
edit the text or save the report.
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Screen References - Add/Edit Field Dialog
This dialog is used for entering or editing the field properties of a field in the report form. Every 
field generates an estimate (currency amount or text) to be substituted in the report. There are 
different types of fields, such as currency value (e.g., $125.99, $55.0), simple expression (e.g., 
Field1 + Field2), etc, described in more detail below. Each field contains four basic properties, 
which are described below. 
Field name:
Enter a field name. A field name is required to substitute the estimated value in the Report Text 
section. Field names must be unique and different from other field names in a report. It must 
always start with an alphabetic character and contain only alpha-numeric characters. Symbols 
such as /\<>|*? and spaces are not allowed. For example: ABC, Field1, a12, line1, and 
TotalAssets are valid field names; however, 123, 1a, 2?, $total, line_1, my field, etc. are invalid 
field names. 
Field type:
Select a field type from the pull-down list. Each field type is described below:
Currency Value:  This can be used for entering a specific amount or value. E.g., $12, 123.45, 
etc. 
Account Balance: This is the most important field as it can be used to extract account balances 
from Express Accounts. See the 'Field value' section below for examples. 
Simple Expression:  This allows user to perform arithmetic operations. The allowed operators 
are +, -, *, and / for addition, subtraction, multiplication and division respectively. E.g., Field1 + 
Field2 gives you sum of existing fields Field1 and Field2. 
Comparison Expression:  This can be used to compare two different field values or 
expressions, and then to enter an amount in the report based on the comparison. See the 
'Field value' section below for examples. 
True/False Value: This can be used for entering a boolean type (True/False, Yes/No) value in 
the report. This can be very useful for checkboxes and answering Yes/No type questions in the 
report form. See the 'Field value' section below for examples. 
Rounding: This can be used for rounding an expression or amount in the report form. See the 
'Field value' section below for examples. 
Field value:
Enter a field value. The format for field value differs with field type. However, it is 
recommended to click the Edit Value  button to enter the field value, except for currency and 
simple expression types when the button is disabled. Formats for some field types are 
explained below: 
Account Balance: "[Account number/type]:[PERIODSTART]:[PERIODEND]" It is strongly 
recommended you click the Edit Value button to enter or edit this field value, so that you don't 
have to worry about typing the format correctly.
E.g., typing 4110:PERIODSTART:PERIODEND gives you the balance of account number 
4110 for the date period defined on main window of the report form. PERIODSTART always 
begins 00:00:00th hours of the start day and PERIODEND ends 23:59:59 (i.e. last second) of 
the day. You can also get the account balance for different date periods, e.g., 
4110:2013-01-01:2013-12-31. Date formats entered here must be in YYYY-MM-DD format. 
Similarly, 1110:PERIODSTART: gives you the balance of account number 1110 at the start 
(00:00:00th hour) of defined start date and, 1110::PERIODEND gives you the balance of 
account number 1110 at the end (23:59:59th hour) of defined end date. 
Comparison Expression: "[Left expression]:[Comparison operator]:[Right expression]":[True 
state expression]:[False state expression]
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 It is strongly recommended you click the Edit Value button to enter or edit this field value, so 
that you don't have to worry about typing the format correctly.
E.g., Field1:>:Field2:Field1:Field2 decodes to - "If Field1 is greater than Field2, then the field 
value is Field1, or else field value is Field2." 
True/False Value: "[0/1]:[Text]" 
E.g., 1:Yes can be used to answer a form question with a 'Yes' text value. Similarly, 0:N 
answers the form question with letter 'N'. 
Rounding: "[Rounding rule]:[Rounding interval]:[expression]" It is strongly recommended you 
click the Edit Value button to enter or edit this field value, so that you don't have to worry about 
typing the format correctly.
E.g., U:1.00:5.45 rounds up 5.45 to 6.00. Similarly, D:1.00:5.45 rounds down 5.45 to 5.00, and 
u:1.00:Field1 rounds Field1 to the closest dollar value, if the value is in middle of interval, it 
rounds up. 
Field description:
This is an optional field. Enter text that would best describe the field, or any personal note 
about the field you'd like to remember. This field will not be displayed in the field or the report.
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Screen References - Authorize Account Settings
Authorize Account Settings
Login:
Enter a login ID you've obtained from Authorize.Net
Transaction Key:
Enter a transaction key you've obtained from Authorize.Net
Gateway URL:
Enter the Authorize.Net gateway. It should be https://secure.authorize.net/gateway/transact.dll 
for a normal account, or https://test.authorize.net/gateway/transact.dll for a test account.
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Screen References - Eway Account Settings
Eway Account Settings
CustomerID:
Enter a customer ID you've obtained from Eway.
Gateway URL:
Enter the Eway gateway. Typical URLs are 
https://www.eway.com.au/gateway_cvn/xmltest/testpage.asp for a test account, and 
https://www.eway.com.au/gateway_cvn/xmlpayment.asp for a live account.
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Screen References - Paypal Payflow Pro Account 
Settings
Paypal Account Settings (Payflow Pro / PayPal Payments Pro)
Partner:
Enter the PayPal partner (usually PayPal). Use the same credentials you would use to log in to 
https://manager.paypal.com.
Merchant Login:
Enter your merchant login
User:
Usually this is the same as the merchant login
Password:
Enter the password to your PayPal merchant account
This is a test account (see help)
Check this to use test mode instead of running live transactions. To use test mode, you may 
need to create a sandbox account at https://sandbox.paypal.com and then enter your sandbox 
email address at http://manager.paypal.com under Service Settings -> Hosted Checkout Pages 
-> Setup. (Source: 
https://www.paypalobjects.com/webstatic/en_US/developer/docs/pdf/payflowgateway_guide.pdf
19 July 2013 p.50)
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Screen References - Paypal Account Settings
Paypal Account
API Username:
Enter an API user name you've obtained from PayPal
API Password:
Enter an API password you've obtained from PayPal
Gateway URL:
Enter the PayPal gateway. Usually, https://api-3t.paypal.com/nvp
API Credentials
Client Side SSL
Select this option if you are using a certificate.
3-token Authentication
Select this option if you are using a signature.
Signature:
Signature for 3-token Authentication
Certificate Password:
Password of the Certificate file for Client Side SSL
Full file path of Certificate file for Client Side SSL.
Test Connection
Click this to check the connection to the gateway using the credentials provided.
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Screen References - Account Settings
If you are using a third-party credit card gateway DLL, enter the full URL-encoded login string 
here.
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Screen References - Back Up Data
It is essential that you backup your data regularly just in case something goes wrong. Please 
select one of the options below. 
Backup Options
Back up to a Network Folder
This is a good option if you are working in an office. Ask your Network Administrator to create a 
safe folder on the shared server. Select this folder and click Backup. The entire application 
folder will be copied to that folder. If something goes wrong (like a hard drive crash) you just 
copy back the folder and everything will be restored.
Back up to a Removable Drive
As an alternative use this option to backup to an external USB hard drive or USB key flash 
drive. Please consider using MEO to encrypt the files if using removable media.
Backup Schedule
The backup can be scheduled to run at the same time every day. 
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Screen References - Restore Data
Restore the data from a scheduled or manual backup. 
Restore scheduled backup
Select this option to restore from a backup created by the backup scheduler.
Restore Point:
Select a restore point from the list of backups.
Restore manual backup
Select this option to select a directory where you manually backed up your data.
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Screen References - Fax Number
Please enter the telephone number for the fax to send to.
Remember this fax number
Tick 'Remember this fax number' to save the number for use in the future.
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Screen References - Email Address
Please enter the email address you want to send to. This needs to be the full email address, 
e.g. tom.jones@example.net . To send to multiple email addresses, separate each address 
with a comma.For problems with sending an email, please refer to this page.
Remember this email address
If this option is available, tick 'Save this as email ...' to save the email address for use in the 
future.
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Screen References - Fax Settings
To send faxes you need an electronic gateway to send direct from your PC using email 
protocols. Click on the recommended gateways link for more information.
Gateway domain (after @):
To send faxes you must enter the gateway domain (that is the part after @). For example to 
send a fax to [FaxNumber]@yourfaxco.com enter yourfaxco.com as the domain.
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Screen References - User Account
Each web interface account is identified by its email address. To set up or edit a user account, 
click the Options icon in the toolbar, click the Web Access tab, and click the Add  button to 
set up a new user account, or select an existing user account and click the Edit button. 
Display name:
Enter the user name. This is used for display purposes on the Web Access tab.
Email address:
This is used to uniquely identify the user. The user will enter their email when they log in to the 
web interface. The email address is also used by the user to recover a lost or forgotten 
password.
Password:
Enter the password for this user. The user will use this password to log in to the web interface. 
They can change their password in the web interface by clicking the Change Password link 
under Actions in the right sidebar.
Password Again:
Enter the password for this user again, to make sure it has been entered correctly.
Account enabled
Check this option to enable the account. If the account is disabled, the user will not be able to 
access the web interface.
User privileges
Administrator
Checking this option will allow this user to modify others user's preferences and to 
add/edit/remove transactions.
User
Checking this option allows this user to be able to add/edit/remove transactions.
Viewer
Checking this option allows this user to view transactions, but does not allow them to 
add/edit/remove transactions.
Organizations
This is the list of organizations that the user can access. The list contains any businesses that 
have been set up through the program. Users with Administrator privileges are allowed to 
access all organizations.
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Screen References - Print Preview
The Preview window displays each page of the document as it will be printed by the printer. 
Print (if available) 
You can print the document by clicking the Print button.
This will open the printer selection and settings dialog where you can select which pages of the 
document to print. 
Previous and Next 
Use the Previous and Next buttons to view each page of the document when there is more 
than one page to print. 
Close 
The Close button closes the window. 
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Screen References - Details for Exporting to EDI
This dialog allows you to set data needed for sending EDI document. 
Sender qualifier
Sender qualifier and identifier must uniquely identify you as a supplier.
Receiver qualifier
Receiver qualifier and identifier must uniquely identify a receiver of invoice(s).
Application Codes
Application sender and receiver codes must uniquely identify the sender and receiver of the 
invoice(s). Same as Sender identifier and Receiver ID qualifier respectively.
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Screen References - Apply Discount
Fixed flat discount to the whole invoice
Select this option to add a flat amount as a discount to the entire invoice.
Fixed percentage discount to the whole invoice
Select this option to add a percentage-based discount to the entire invoice. Currently this type 
of discount must be added after all other items in order to calculate the amount correctly.
Apply line-by-line discounts to specific items
Select this option to enable the discount column for each item on the invoice.
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Screen References - Text Attributes
This window is where you adjust the text settings for a block of text on the invoice, which is an 
option accessible from the Options ~ Page Styles page.
Font:
Select the font face for the text.
Size:
Select the font size for the text.
Style:
Select if the text should be bold or italicized.
Color:
Click inside the color box to select a new text color.
Alignment:
Select right, center or left alignment for the text.
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Screen References - Closed-To-Date
This dialog allows a user to enable/disable closed-to-date feature, and specify closed-to-date. 
To open this dialog, click Closed-to-date... link from Accounts  menu from the main page. 
Enable closed-to-date
Select this option to activate closed-to-date feature. Once activated, new transaction entries 
will only be allowed for dates after closed date.
Closed-to-date:
Enter the date for closed-to-date feature. When enabled, no new transaction entries will be 
allowed for dates up until this date.
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Screen References - Making Tax Digital for VAT
This dialog allows a user to grant authorization to the application to connect to HMRC, and be 
able to submit and retrieve VAT returns. (For users in the United Kingdom only) 
Authorize application
Select this option to authorize application to connect to HMRC.
Retrieve VAT obligations
Select this option to retrieve vat obligations.
Submit VAT Returns
Select this option to submit vat return for period.
View VAT Returns
Select this option to retrieve a submitted VAT return.
Retrieve VAT liabilities
Select this option to retrieve VAT liabilities. (Not yet supported)
Retrieve VAT payments
Select this option to retrieve VAT payments. (Not yet supported)

240



Screen References - Submit VAT Returns
This is the dialog for submitting VAT returns for a specific period. 
Period:
The VAT period that this obligation belongs to
VAT due on sales and other outputs:
VAT due on sales and other outputs. This corresponds to box 1 on the VAT Return form. The 
value must be between -9999999999999.99 and 9999999999999.99
VAT due on acquisitions from other EC Member States:
VAT due on acquisitions from other EC Member States. This corresponds to box 2 on the VAT 
Return form. The value must be between -9999999999999.99 and 9999999999999.99
Total VAT due (the sum of boxes 1 and 2):
Total VAT due (the sum of vatDueSales and vatDueAcquisitions). This corresponds to box 3 
on the VAT Return form. The value must be between -9999999999999.99 and 
9999999999999.99
VAT reclaimed on purchases and other inputs (including acquisitions from the EC):
VAT reclaimed on purchases and other inputs (including acquisitions from the EC). This 
corresponds to box 4 on the VAT Return form. The value must be between 
-9999999999999.99 and 9999999999999.99
Net VAT to be paid to HMRC or reclaimed by you (difference between boxes 3 and 4):
The difference between totalVatDue and vatReclaimedCurrPeriod. This corresponds to box 5 
on the VAT Return form. The value must be between 0.00 and 99999999999.99
Total value of sales and all other outputs excluding any VAT:
Total value of sales and all other outputs excluding any VAT. This corresponds to box 6 on the 
VAT Return form. The value must be in pounds (no pence) between -9999999999999 and 
9999999999999
Total value of purchases and all other inputs excluding any VAT (including exempt 
purchases):
Total value of purchases and all other inputs excluding any VAT (including exempt purchases). 
This corresponds to box 7 on the VAT Return form. The value must be in pounds (no pence) 
between -9999999999999 and 9999999999999
Total value of all supplies of goods and related costs, excluding any VAT, to other EC 
member states:
Total value of all supplies of goods and related costs, excluding any VAT, to other EC member 
states. This corresponds to box 8 on the VAT Return form. The value must be in pounds (no 
pence) between -9999999999999 and 9999999999999
Total value of all acquisitions of goods and related costs, excluding any VAT, from other 
EC member states:
Total value of acquisitions of goods and related costs excluding any VAT, from other EC 
member states. This corresponds to box 9 on the VAT Return form. The value must be in 
pounds (no pence) between -9999999999999 and 9999999999999
When you submit this VAT information you are making a legal declaration that the 
information is true and complete.\n A false declaration can result in prosecution.
This is a declaration that the user has finalised their VAT return.
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Screen References - Select Period for VAT Return
This is the dialog for selecting period to retrieve a submitted VAT return. 
Period:
Select the VAT period that this obligation belongs to
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Screen References - Payment
The Express Accounts Payments window allows you to Add or Edit payments received. To 
apply a new payment, click the Sales tab and click the Receipt  icon on the toolbar, or press C
trl+Y.  To edit an existing payment, first open the Payments list by clicking the View menu 
and selecting Payments,  then select the payment you need to edit, and click the Edit button in 
the toolbar. 
Customer Payment
Date:
Enter the date the payment was received (not the date of the invoice).
Customer:
Select the customer from the drop-menu, or enter a new customer using the customer button 
to the right of the drop-menu.
Amount:
If you selected a customer, this field will automatically fill with the customer's entire account 
balance. If the payment does not match this number, enter the exact amount paid instead. 
The payment amount will be distributed across the unpaid invoices listed below, completing the 
oldest invoices first. You may manually redistribute applied amounts in the invoice list. Any 
unapplied amount will be shown as Unapplied amount remaining. 
Method:
Select how the payment was made. Available options are Cash, Check, Credit Card, Bank 
Deposit, and Other
Reference number:
Enter the reference number. Leave this field blank if you charge by credit card online; the 
reference number will generate automatically after success. If you do not charge by credit card, 
entering a reference number is optional, but can help you keep soft references between 
payments and invoices. 
Deposit account:
Select an account from the drop menu to apply the payment to.
Charge customer via online credit card gateway
Check this if you want to charge the customer by credit card. You must have set up the pay 
account in Options on the Credit Card Gateways tab, as well as entered the customer's credit 
card information for this option to be enabled. 
Invoices
Unapplied amount remaining:
This is the total amount remaining that has not been applied toward any invoices.

List of Invoices
This is the list on invoices that you can apply the payment amount to. The applied amounts will 
automatically be filled in starting with the oldest invoice, if you wish you may adjust the applied 
amounts for each invoice by clicking on the Applied field, or the edit icon for each invoice. 

Show paid invoices
Check this if you wish to show paid invoices in the invoice list view. The paid invoices will be 
highlighted with a gray background and will not have a Due  amount. 
Record
Click on 'Record Only' button to apply and save the payment. To record and print, click on the 
pull down list and select the action.
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Screen References - Refunds and Returns
The Refunds and Returns Dialog. Refunds can be paid to the customers with a negative 
balance. To adjust the balance of the customers with a positive balance, the options are: a) 
edit an existing customer's invoice, b) issue a credit note for the customer.
Select Customer
The list of customers. Only the customers with invoices in the last 12 months are listed.
Adjust Invoice
Edit the invoices for the selected customer.
Issue Credit Note
Issue Credit Note for the selected customer.
Pay the Customer Refund
Open new refund window and set the amount to refund the customer.

244



Screen References - Apply Credit Note
The Apply Credit Note window is where you can apply a customer's credit notes to their 
overdue invoices. Select a credit note from the pull-down list to load the information, or you can 
click the button on the right to open the Credit Note List window, where you can select from 
pre-existing credit notes or create a new one. Once you have selected a credit note, the 
Invoices list will fill with all the invoices assigned to the customer. Enter the amount you wish to 
apply against each invoice in the Applied column; this column will automatically be filled in 
using the amount of the credit note you selected. 
Customer Payment
Date:
Enter the date the payment was received (not the date of the invoice).
Credit Note:
Select the credit note from the drop-menu. You can use the buttons to the right of this field to 
look at the list of credit notes and edit the selected credit note.
Customer:
The customer of the selected credit note. This field is filled automatically once you select a 
credit note to apply; the listed invoices are for this specific customer.
Amount:
This field will automatically be filled once you select a credit note to apply.
Deposit account:
Select the account the credit should be applied to.
Invoices
Unapplied Amount Remaining:
This is the total amount which has not yet been applied to any invoices.
Show paid Invoices
Check this if you wish to show paid Invoices in the Invoice list view.
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Screen References - Enter Payments of Accounts 
Payable
The Express Accounts Payments window allows you to Enter or Edit payments. To enter a 
new payments of Accounts Payable, click Enter Payments of Accounts Payable from the Pu
rchases  menu. To edit an existing payment, first open the Payments list by clicking View 
and selecting Payments of Accounts Payable, then select the payment you need to edit, and 
click the Edit button in the toolbar. 
Payment
Date:
Enter the date the payment was made (not the date of the bill).
Supplier:
Select the supplier from the drop-menu. You also have the option of leaving this field blank if 
you enter a bill number.
Account paid from:
Select the account from which this payment will be made. You may also create a new account.
Method:
Select how the payment was made.
Amount:
If you selected a supplier or bill number, this field will automatically fill with the supplier's 
account balance. If the payment does not match this number, enter the exact amount paid.
Reference number:
Enter the reference number. Entering a reference number is optional.
Check no.:
Enter a check number. This is only applicable if you select Check as a payment method. 
Express Accounts will automatically increment check numbers for you.
Journal memo:
Add a note about this transaction that will help you identify it in the journal.
Bills
This is the total amount remaining that has not been applied to any invoices.
Record  
Click on this button to Record the payment. 
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Screen References - Vehicle
The Vehicle dialog is where you enter the name and description for a new vehicle.
Vehicle Name:
Enter the vehicle name.
Vehicle Description:
Enter the vehicle description.
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Screen References - Vehicle Mileage
The Vehicle Mileage dialog is where you enter the information pertaining to the mileage 
accrual of a vehicle.
Vehicle:
You can either type in the name of a vehicle, or select one from the drop menu. Adding a new 
vehicle into this field will create a new record for that vehicle.
Customer:
Enter the customer to associate this trip with. You can either type in the name of a customer, 
or select one from the drop menu. Adding a new customer into this field will create a new 
record for that customer, which you can complete later with their contact details. Entering a 
customer is optional, and can be used for mileage reports.
Job Code:
Enter a job code for this trip, to be used for your reference and in mileage reports. A customer 
has to be entered in order to enter a job code.
Trip Start Date:
Enter the trip start date.
Trip End Date:
Enter the trip end date.
Odometer Start:
Enter the starting odometer reading for this trip.
Odometer End:
Enter the ending odometer reading for this trip.
Total Mileage:
This field will be automatically calculated once the Odometer Start and Odometer End fields 
are filled.
Notes:
Enter any notes pertaining to the trip. This field is optional.
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Screen References - Mileage Reports
Select Period
Select the date range over which to generate the mileage report.
Vehicle Mileage Summary
This is a summary report which sums all the mileage for each vehicle, over the selected time 
period.
Detailed Mileage Report
This is a detailed report which displays every individual trip for each vehicle, over the selected 
time period.
Vehicle Mileage Customer Report
This is a detailed report which displays all the mileage associated with a customer and/or job 
code, over the selected time period. This information can be used to bill customers for vehicle 
mileage costs.
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Screen References - Account Transfer
Transfer from account:
Select the account to transfer an amount from. Upon selecting an account from this list, the 
current account balance will be displayed.
Transfer to account:
Select the account to transfer an amount into.
Amount to transfer:
Enter the amount to transfer. This number cannot be greater than the current balance of the 
account being transferred from.
Date:
Enter the date of the account transfer. This cannot be a future date.
Record: 
Click on this button to Record the transfer. 
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Screen References - Recurring Invoice Schedule
Invoices that are sent on a recurring basis can be set up on a recurring schedule through 
Express Accounts. To create a recurring invoice schedule, fill out an invoice as usual, click the 

 button and then select the Save as Recurring from the Record Invoice dialog. 
Start date:
Enter the date when the invoice should first be generated.
Interval:
Select how often the invoices should issue.
Action:
Select the action that should be done after invoice has been recorded, if the invoice should be 
printed, emailed, or faxed.
Replace the string %period% in any description with dates
It is sometimes useful to print the actual billing period on the invoice to the customer to explain 
what period the invoice is for. To do this enter descriptions with the word "period" circumfixed 
with percentage symbols, i.e., %period%, that way whenever a recurring invoice is issued, the 
%period% will be replace with the actual dates of the invoice.
Update the prices of any items that have been changed
If this is ticked, whenever a recurring invoice is recorded it will check if the item price has 
changed. If it has, the invoice prices will be updated.
Automatically charge customer by credit card
If this is ticked, and the invoice payment method is set to Credit Card, the customer will be 
charged automatically by credit card at every invoice interval. To enable credit card payments, 
the customer's credit information must be recorded on the Credit Card tab of their customer 
record (see Customer~Credit Card), and the credit card gateway must be configured in 
Options (see Options~Credit Card Gateways). 
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Screen References - Recurring Order Schedule
Sales orders that are sent on a recurring basis can be set up on a recurring schedule through 
Express Accounts. To create a recurring order schedule, fill out the sales order as usual, click 
the Record button at the bottom and then select the Save as Recurring option from the 
Record drop-menu at the bottom. 
Start date:
Enter the date when the order should first be generated.
Interval:
Select how often the orders should issue.
Action:
Select the action that should be done after order has been recorded, if the order should be 
printed, emailed, or faxed.
Replace the string %period% in any description with dates
It is sometimes useful to print the actual billing period on the order to the customer to explain 
what period the order is for. To do this enter descriptions with the word "period" circumfixed 
with percentage symbols, i.e., %period%, that way whenever a recurring order is issued, the 
%period% will be replace with the actual dates of the order.
Update the prices of any items that have been changed
If this is ticked, whenever a recurring order is recorded it will check if the item price has 
changed. If it has, the sales order prices will be updated.
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Screen References - Statement Period
The Statement Period dialog allows you to select a time period for generating a customer 
statement. This dialog opens when a customer is selected from the Customers List and the 
Statement button is clicked in the toolbar. 
Automatically use month or oldest due
If this option is selected the date will be the earlier of this month (if more than half way), last 
month or one month prior to the oldest invoice due date.
Enter statement period
If this option is selected, you can explicitly enter the period for the invoice.
Start date:
Enter the date (inclusive) from which transactions are shown on the statement, or select the 
start date from the calendar icon.
End date:
Enter the date (inclusive) to which transactions are shown on the statement, or select the end 
date from the calendar icon.
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Screen References - Customer Statements
The Customer Statements dialog allows you to select multiple customers to generate 
statements for within a certain time period. There are five methods for generating statements: 
print, print preview, email, fax, or saving as a PDF. The method you choose will apply to every 
customer selected in the list. 
Customer Filter
Check All
Check this box if you want to select or deselect all customers
Select Customers:
This is the list of the customers that Express Accounts will generate statements for.
Sort by Date
If this checkbox is selected, then the invoices on statements will be sorted by date instead of 
invoice number.
Select Period
Automatically use month or oldest due
If this option is selected, the date will be the earlier of this month (if more than half way), last 
month, or one month prior to the oldest invoice due date.
Enter statement period
If this option is selected, you can explicitly enter the period for the invoice.
Start date:
Enter the date (inclusive) from which transactions are shown on statements, or select the start 
date from the calendar icon.
End date:
Enter the date (inclusive) to which transactions are shown on statements, or select the end 
date from the calendar icon.
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Screen References - Multiple Businesses
A single installation of Express Accounts can manage many businesses. Each business runs 
as if it is an entirely different install-separated from the other businesses kept in Express 
Accounts. Every single setting can be changed for each business. Each business has it own 
customers, items, payments and, of course, invoices. 
To add a business, from the File menu select Invoice -> Multiple Businesses. Then click the 
Add New Business button. After you click Add the Quick Start Wizard will run. 
To delete a business, from the File menu select Invoice -> Multiple Businesses. Highlight the 
business you want to delete and click the Delete Business button. 
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Screen References - Account Properties
The Account Properties dialog is where you manage information about each account in the 
Chart of Accounts. This dialog is opened from the Chart of Accounts list by double clicking an 
existing account in the list. Open the Chart of Accounts list by clicking the View menu and 
selecting Chart of Accounts. The web version of this dialog may be opened with the Add New 
Account  button on the Chart of Accounts List page. 
Account
Number:
This is the account number given to the account on creation or from the default accounts list. 
The account number can be changed only if there aren't any transactions for this account.
Type:
The type of the account, Asset, Liability, Equity, Income or Expense, is set when you create 
the account. It cannot be changed later. If you have made a mistake, delete the account and 
create a new one.
Subclass:
The subclass of the Income or Expense account.
Classification for cash flow:
The selection you make in this field will be used for the Cash Flow Statement reports. Your 
choices are Operating, Investing or Financing.
Name: 
Enter the name of the account as you would like it to appear on all reports.
Header account (for subtotals only, no posting)
If the account is a header account it means that nothing can be posted directly to the account 
but on reports the account prints the subtotals of all accounts below it with the same prefix.
Cash postable (e.g., bank or credit card)
If an account is cash postable it means it will appear in the list of accounts that payments can 
be made from or deposits made to. Bank and Credit Card accounts usually have this option 
ticked.
Tax included
Check this box if payment from this account will include sales tax. The tax will be based on 
values entered on the Tax tab of Options, but can also be adjusted on the Payments and 
Purchases dialog.
Opening balance:
If you are bringing this account from another accounting system, enter the opening balance as 
at the date the accounts were transferred. Manually changing an opening balance is not 
recommended after the initial setup. Accounts payable and accounts receivable opening 
balances can be changed through respective suppliers and customers opening balances.
Default linked account for:
(If available) The selection you make in this field will be used as the default account for 
selected transactions.
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Screen References - Select Template
Templates can be used for common Payments and Purchases Transactions and for 
Receipt and Deposit Transactions . To select a template you have already created, click the Us
e Template  button in the lower right corner of the Payments and Purchases dialog or the 
Receipts and Deposits dialog. To create a new template, see Name Template in the Screen 
References section of this manual. 
Select template
Select the template you wish to use and click the Load button.
Delete Template
Select the template(s) you wish to remove and click the Delete button.
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Screen References - Name Template
Templates can be used for Payments and Purchases Transactions and for 
Receipt and Deposit Transactions . To create a new template, enter a payment transaction 
(see the Payments and Purchases topic in the Screen References) or a receipt or deposite 
transaction (see the Receipts and Deposits topic in the Screen References), but before you 
record the transaction, click the Save As Template  button in the lower left of the dialog. 
Name:
Enter the name for the template. The template will be saved and the transaction recorded 
when you click OK.

258

cashtxn.html
recmoney.html
cashtxn.html
recmoney.html


Screen References - Select Date
Select date
For reports displaying data for a single day, such as the Balance Sheet, you will need to select 
the date for the report. Fixed period choices available are today, yesterday, end of last month, 
or end of last year. Or, you can choose Select from the menu, and then specify a specific date 
by entering it in the Date field, or selecting the date from the calendar. 
Date:
Enter the date or click the calendar button to display a date selector.
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Screen References - Select Period for the Report
Select period
For reports that display data over a period of time, such as the Invoice report, Salesperson 
report, or the Cash Flow statement, you will need to specify which dates the report should 
span. Select the period for the report from the drop menu. Fixed period choices available are 
the today, this month or last month, this quarter or last quarter, this year or last year, this fiscal 
year or last fiscal year. Or you can choose Select from the drop menu, and then enter a Start 
Date and End Date in the fields for the period of the report.
Start date:
Enter the date (inclusive) that the period will start from. Click the down arrow to display a 
calendar from which the start date can be selected.
End date:
Enter the date (inclusive) that the period will end on. Click the down arrow to display a calendar 
from which the end date can be selected.
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Screen References - Select Report Value to Sort 
By
Use the Sort by Column pulldown list to select the column that the report will sort with. This is 
dependent on the report being generated, and a default choice will be selected for each report.
Use the radio buttons to select which direction the report will sort: Ascending (from low to high) 
or Descending (from high to low).
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Screen References - Select Period with Sort for 
the Report
Select period
Select period:
Select the period for the report from the drop menu. Fixed period choices available are: today, 
this month, last month, this quarter, last quarter, this year, last year, this fiscal year, and last 
fiscal year. Or you can choose Select from the drop menu, and then enter a Start Date and 
End Date in the fields for the period of the report.
Start date:
Enter the date (inclusive) that the period will start from. Click the down arrow to display a 
calendar from which the start date can be selected.
End date:
Enter the date (inclusive) that the period will end on. Click the down arrow to display a calendar 
from which the end date can be selected.
Report Sorting
Use the Sort by Column pulldown list to select the column that the report will sort with. This is 
dependent on the report being generated, and a default choice will be selected for each report.
Use the radio buttons to select which direction the report will sort: Ascending (from low to high) 
or Descending (from high to low).
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Screen References - Select Period and Customers 
for the Report
Select Period
Select Period:
Select the period for the report from the drop menu. Fixed period choices available are: today, 
this month, last month, this quarter, last quarter, this year, last year, this fiscal year, and last 
fiscal year. Or you can choose Select from the drop menu, and then enter a Start Date and 
End Date in the fields for the period of the report.
Start Date:
Enter the date (inclusive) that the period will start from. Click the down arrow to display a 
calendar from which the start date can be selected.
End Date:
Enter the date (inclusive) that the period will end on. Click the down arrow to display a calendar 
from which the end date can be selected.
Report Sorting
Use the Sort by Column pulldown list to select the column that the report will sort with. This is 
dependent on the report being generated, and a default choice will be selected for each report.
Use the radio buttons to select which direction the report will sort: Ascending (from low to high) 
or Descending (from high to low).
Customer Filter
Check All
Check this box if you want to select or deselect all customers
Select Customer:
This is the list of the customers that you need to generate reports.

263



Screen References - Select Periods for the Report
For reports that compare the data of two periods of time, such as the Income Statement 
Analysis report, you will need to specify which dates the report should span. 
This period
Select the first period for the report. Fixed period choices available are the today, this month or 
last month, this quarter or last quarter, this year or last year, this fiscal year or last fiscal year. 
Or you can choose Select from the drop menu, and then enter a Start Date and End Date in 
the fields for the first period of the report.
Start date:
Enter the date (inclusive) that the period will start from. Click the down arrow to display a 
calendar from which the start date can be selected.
End date:
Enter the date (inclusive) that the period will end on. Click the down arrow to display a calendar 
from which the end date can be selected.
Previous period
Select the second period for the report. Fixed period choices available are the today, this 
month or last month, this quarter or last quarter, this year or last year, this fiscal year or last 
fiscal year. Or you can choose Select from the drop menu, and then enter a Start Date and 
End Date in the fields for the first period of the report. 
Start date:
Enter the date (inclusive) that the period will start from. Click the down arrow to display a 
calendar from which the start date can be selected.
End date:
Enter the date (inclusive) that the period will end on. Click the down arrow to display a calendar 
from which the end date can be selected.
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Screen References - Select Account and Period
For the reports Account Enquiry and Reconciliation Report, found by clicking the Report menu 
and selecting Other Reports, you will be prompted to select which account the report should be 
generated for. 
Select account and period
Select the account and period for the report. Select one of the preset periods from the 
drop-menu, or you can choose "Select Period" and then enter any start date and end date you 
like in the boxes below for the period of the report. 
Start date:
Enter the date (inclusive) that the report period will start from. Clicking the down arrow will 
display a calendar from which the start date can be selected.
End date:
Enter the date (inclusive) that the report period will end on. Clicking the down arrow will display 
a calendar from which the end date can be selected.
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Screen References - Select Budget
For the Budget Report, found by clicking the Report menu and selecting Other Reports, you 
will be prompted to select which budget the report should be generated for. 
Select Budget
Select the budget for the report. 
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Screen References - Report Items per Customer
For the Items per Customer report, you will need to specify the customer and which dates the 
report should span. 
Generate Report for Items per Customer
Select Customer:
Select the customer for the report.
Select Period:
Select the period for the report. Fixed period choices available are the current month, the 
previous month, the current calendar year. Or you can choose Select and then enter any Start 
Date and End Date you like in the boxes below for the period of the report.
Start Date:
Enter the date (inclusive) the report period will start from. Clicking the down arrow will display a 
calendar from which the start date for the report can be selected.
End Date:
Enter the date (inclusive) the report period will end on. Clicking the down arrow will display a 
calendar from which the end date for the report can be selected.
Report Sorting
Use the Sort by Column pulldown list to select the column that the report will sort with. This is 
dependent on the report being generated, and a default choice will be selected for each report.
Use the radio buttons to select which direction the report will sort: Ascending (from low to high) 
or Descending (from high to low).
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Screen References - Accounts Receivable Aging 
Report
Report Sorting
Use the Sort by Column pulldown list to select the column that the report will sort with. This is 
dependent on the report being generated, and a default choice will be selected for each report.
Use the radio buttons to select which direction the report will sort: Ascending (from low to high) 
or Descending (from high to low).
Customer Filter
Check All
Check this box if you want to select or deselect all customers
Select Customer:
This is the list of the customers that you want to generate reports.
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Screen References - Report Customer Sales
Generate Report for Customer Sales
Check All
Check this box if you want to select or deselect all customers
Select Customer:
This is the list of the customers that you need to generate reports.
Select Period:
Select the period for the report. Fixed period choices available are the current month, the 
previous month, the current calendar year. Or you can choose Select and then enter any Start 
Date and End Date you like in the boxes below for the period of the report.
Start Date:
Enter the date (inclusive) the report period will start from. Clicking the down arrow will display a 
calendar from which the start date for the report can be selected.
End Date:
Enter the date (inclusive) the report period will end on. Clicking the down arrow will display a 
calendar from which the end date for the report can be selected.
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Screen References - Choose Businesses and 
Report
To view a balance sheet, income statement, cash flow statement for more than one business, 
select the businesses and report type from this dialog. The dialog can be opened from the 
Reports List on the Reports tab. 
Businesses
A list of all the businesses set up through Express Accounts appears in the Businesses section 
of this dialog. Select the business you want to consolidate reports for by checking the box next 
to the business name.
If your businesses are in different currencies, the report will be in the currency of the current 
business selected in Multiple Businesses. You will want to update the information in the 
Currency and Rate columns. Updating these columns does not change the currency of each 
business, it is used to enter an exchange rate, so that the calculations will be correct for the 
active currency. To select a new currency, click the currency cell, and a drop-menu will appear. 
If your currency does not appear in the list, type it into the field. To enter a new rate, type the 
new rate into the rate cell.
Reports
A list of reports is displayed in the lower window. Select the report that you want to view. 
Select Date: For reports displaying data for a single day, such as the Balance Sheet, you will 
need to select the date for the report. Fixed period choices available are today, yesterday, end 
of last month, or end of last year. Or, you can choose Select from the menu, and then specify a 
specific date by entering it in the Date field, or selecting the date from the calendar.
Date:  
Enter the date or click the calendar button to display a date selector.
Save Report as CSV: 
You can save your report in a spreadsheet file format.
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Screen References - Select Report
The Select Report dialog is where you can view all the report types available in Express 
Accounts, and where you select a report to view. To view the full report list, click the Report 
menu and select Other Reports. To view a report in the list, select it and click the View 
button. 
● Unpaid Accounts Report - view a list of all customers with an outstanding balance.
● Invoices Report - view a list of all invoices created during a specified time period.
● Quotes Report - view a list all quotes created during a specified time period.
● Orders Report - view a list all orders created during a specified time period.
● Sales Invoice Payment Report - view a list of all invoice payments received during a 

specified time period.
● Salesperson Report - view a list of salespeople, their dollar amount in sales, and the 

percentage of total sales they made during a specified time period.
● Item Sales Report - view a list of all items sold, and the dollar amount the item generated 

during a specified time period.
● Inventory Report - view a list of all inventory items, their unit value, and the total value of 

your on-hand inventory.
● Balance Sheet - view a summary of the business's assets, liabilities and equity from a 

specified date.
● Chart Of Accounts - view a list of all the accounts in the Chart of Accounts, including the 

account number and type, and whether entries to the account debit or credit the account.
● Income Statement - also referred to as a Profit and Loss Statement, or P & L. View a report 

of the business's revenue during a specified time period.
● Income Statement Analysis - view a comparison of revenue generated by the business 

during two specified time periods.
● Account Enquiry - view the transactions on any account and its balance for a specified time 

period.
● Cash Flow Statement - view the cash generated during a specified time period.
● Trial Balance - view the balances of your credit and debit accounts over a period of time to 

check for accounting errors.
● Reconciliation Report - view all transactions that have been reconciled during a specified 

time period.
● Items Per Customer Report - view a list of items ordered by a customer during a specified 

time period.
● Accounts Payable Report - view a list of all accounts payable during a specified time period.
● Payments of Accounts Payable Report- view a list of all payments to accounts payable 

during a specified time period.
● Customers Report - view a list of all customer balances.
● Customer Sales Report - view a list of all customer sales both invoices and paid during a 

specified time period.
● Sales Tax Report - view a comprehensive report of the taxes your company collected and, 

if specified in Options ~ Sales Tax, the taxes your company has paid towards purchases.
● Mileage Reports - select one of three types of mileage reports (generated for a specified 

time period): a general summary showing the mileage accrual of all vehicles, a detailed 
mileage report showing each trip for a vehicle, and a customer report showing all the 
mileage associated with a customer.

● Consolidated Reports - select a business and choose to view the balance sheet, income 
statement, or cash flow statement for that business.
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● Accounts Receivable Aging Report - view a report for outstanding balances according to 
the amount of time they have been outstanding. Report can be be filtered by customer.

● Budget Report - select a budget and view the differences between the actual and allocated 
amounts.

● Custom Reports - select this to begin creating customized reports for your business. 
Please see the Custom Reports help page for more information on how to use this feature.
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Screen References - Select Period for the Report
Select period
For reports that display data over a period of time and an option to select a report sub-type, 
such as the Sales Tax Report (Accrual and Cash basis), you will need to specify which dates 
the report should span. Select the period for the report from the drop menu. Fixed period 
choices available are the today, this month or last month, this quarter or last quarter, this year 
or last year, this fiscal year or last fiscal year. Or you can choose Select from the drop menu, 
and then enter a Start Date and End Date in the fields for the period of the report. A pulldown 
list for report type is also provided. 
Start date:
Enter the date (inclusive) that the period will start from. Click the down arrow to display a 
calendar from which the start date can be selected.
End date:
Enter the date (inclusive) that the period will end on. Click the down arrow to display a calendar 
from which the end date can be selected.
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Screen References - New Item
Item code:
Enter a unique short (but memorable) code for this item.
Item description:
Enter the full description of the item.
Unit value:
This is the price of one of the item.
Quantity:
Input the quantity of the item.
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Screen References - Pay by Cash
The Pay by Cash dialog is used during a Non-Invoiced Cash Sale. To complete a non-invoiced 
cash sale, from the Sales tab click the Enter non-invoiced cash sale link in the sidebar, 
enter the items being sold, and select Record Cash from the Record drop-menu at the bottom. 
Amount due:
This field shows amount due.
Change due:
Change due value will show the amount of change owed back to the customer. The value will 
display automatically once the Cash field (below) has been filled in.
Cash:
Enter the amount paid by a customer. If the customer has given an amount over the amount 
due, the change due will be displayed in the Change due field (above).
Print receipt
Check this checkbox if you want to print a receipt.
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Screen References - Pay by Credit Card
The Pay by Credit Card dialog is used during a Non-Invoiced Cash Sale. To complete a 
non-invoiced credit card sale, from the Sales tab click the Enter non-invoiced cash sale link 
in the sidebar, enter the items being sold, and select Record Credit  from the Record 
drop-menu at the bottom. In order to receive credit card payments through Express Accounts, 
a credit card gateway should be configured on the Credit Card Gateways tab of the Options 
dialog. 
Credit card information
Card number:
Enter the customer's credit card number.
Card verification number:
Enter the customer's credit card Verification Number, usually found on the back of the card.
Expiration month:
Enter the customer's credit card expiration month.
Expiration year:
Enter the customer's credit card expiration year.
Cardholder name:
Enter the credit card holder's full name.
Billing Address (Optional)
Customer name:
Enter the name of the customer.
Enter the customer billing address.
Amount due:
Select the account the payment should be applied to.
Print receipt
Check this box to print a receipt.
Configure Payment Gateway
Click here to set up a credit card gateway
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Screen References - Pay by Check
The Pay by Check dialog is used during a Non-Invoiced Cash Sale. To complete a 
non-invoiced check sale, from the Sales tab click the Enter non-invoiced cash sale link in 
the sidebar, enter the items being sold, and select Record Check from the Record drop-menu 
at the bottom. 
Check number:
Enter the check number.
Amount due:
This field shows amount due.
Print receipt
Check this checkbox if you want to print a receipt.
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Screen References - Choose Payment Method
The Choose Payment Method dialog appears when an Invoice is recorded with payment. It is 
used to designate payment type before the invoice and payment are recorded. 
Payment method
Cash
Select the Cash option if the customer paid by cash.
Check
Select the Check option if the customer paid by check, then enter the check number in the field 
below the check option (below).
Check number:
Input the check number if the customer paid by check and the Check option is selected 
(above).
Credit card
Select the Credit card option if the customer is paying by credit card. The card information is 
pre-filled using the information stored in the customer record, and any changes to this 
information will be saved back to the customer record. A credit card gateway must also be 
configured (found in the Credit Card Gateway tab of Options). 
Charge Customer via online Credit Card Gateway
Check this option if you want to charge the customer by credit card via an online Credit Card 
Gateway. For the payment to process successfully, you must have configured a Credit Card 
Gateway (found in the Credit Card Gateway tab of Payment Options).
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Screen References - Save Customer
The Save Customer dialog appears after an invoice is recorded if, during invoice creation, a 
customer was selected and then manually changed. You have the option of changing the 
name of the customer record permanently, creating a new separate customer record, or not 
taking action. 
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Screen References - Email to Many
It is possible to email several invoices at once. From the View menu,  select Invoices to bring 
up the invoices list. Select multiple invoices using the Shift or Ctrl keys and then click the Email

Send email to
Send all invoices to this email address
Send all data to a specified email address.
Send to the customer's email address
Send data to the customer's email address record. If customer does not have an email 
address
Prompt for the email address
This option will ask for an email address from the user.
Skip customer
Don't send when no email address was provided.
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Screen References - Select Customer
It is possible to combine two or more quotes or orders and convert them to an invoice. If the 
user selects two or more quotes or orders from different customers, they will be warned that 
different customers have been selected, and then given the option to select which customer 
the quotes or orders should be recorded to.
To view the Orders list, select the Sales Orders->View menu option. To view the Quotes list, 
select the Quotes->View menu option. Select two or more quotes or orders using the Shift or 
Ctrl keys, then click the Invoice icon on the toolbar. When prompted, select which customer 
account the invoice should be recorded to.
Customer:
Select a customer from the list.
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Screen References - Run Automatic Statements
When the time comes to run automatic statements for your customers, a link will appear in the 
sidebar. Once the link is clicked, the user will be asked to select the appropriate method for 
Automatic Statements to execute. 
Select method
Email if an email exists, otherwise print
When this option is selected, the statement will be emailed to the customer if the customer 
record contains an email address. Otherwise, the statement will be printed so it can be 
delivered to the customer by other means.
Print statements to the printer for everyone
Select this option to print all statements.
Email statements to the customer (Prompt if no email)
When this option is selected, the statement will be emailed to the customer if their customer 
record contains an email address. Otherwise, Express Account will prompt you for an email 
address. If no email address is provided, the statement will not be created. 
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Screen References - Salesperson
The Salesperson dialog is where you enter the name for a new salesperson record. To add a 
new salesperson, click the View menu,  select Salespeople, and then click the Add  icon on 
the toolbar. Salesperson records will also be created automatically if a new name is entered on 
a quote, sales order, or invoice. 
Salesperson information
Name:
Enter the salesperson name.
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Screen References - Tax Rate
The Tax Rate dialog is where new tax rate details for invoice computation can be entered, or 
existing tax rate details can be edited. Access the Tax Rate dialog by opening the Options 
dialog, click the Tax tab, and click Add  to create a new tax rate, or select an existing tax rate 
and click Edit to edit tax rate details. 
Tax Name:
Enter the tax name. This is used for display purposes.
Simple Tax Rate (%):
This is the rate to be used for invoice computations.
Combined Tax Rate:
Create a tax group composed of simple taxes.
Compounding so rate 2 is applied after rate 1
When this option is enabled, tax rate 1 is applied on item-value, then tax rate 2 is applied on 
top of total that has already been taxed with tax rate 1. When the option is disabled, both tax 
rate 1 and tax rate 2 are applied on item-value.
Show zero percent
Enable this checkbox if the user wants to print zero percent tax rates in Invoices. (Applicable in 
EU and UK only.)
Sales tax collected account:
Select the account you would like any sales tax collected to be allocated to.
Sales tax paid account:
Select the account you would like any sales tax paid to be allocated to.
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Screen References - Import Items from Other 
Business
The Import Items from other Business dialog lets you transfer items from other Express 
Accounts businesses into the current one. To import items into the current Express Accounts 
business, click the View menu and select Items.  In the Item menu, select Import Items 
from Other Business. 
Businesses
A list of all the businesses set up through Express Accounts is listed in the Businesses section 
of this dialog. Select the business where you want to import data from. 
Items
When a business is selected in the top window, a list of that business's items is displayed in 
the lower window. To select the items that you want to be copied, make sure their boxes are 
checked. 
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Screen References - Import Customers from 
Other Business
The Import Customers from Other Business dialog lets you transfer items from other Express 
Accounts businesses into the current one. To import customers into the current Express 
Accounts business, click the View menu and select Customers.  In the Customer menu, 
select Import Customers from Other Business . 
Businesses
A list of all the businesses set up through Express Accounts is listed in the Businesses section 
of this dialog. Select the business where you want to import data from. 
Customers
When a business is selected in the top window, a list of that business's customers is displayed 
in the lower window. To select the customers that you want to be copied, make sure their 
boxes are checked. 
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Screen References - Linked Accounts
The Linked Accounts dialog appears when Express Accounts is missing information about 
crucial accounts. In order to create invoices, customer payments, and business purchases, 
Express Accounts requires account numbers for the following accounts: Deposit Account, 
Accounts Receivable, Accounts Payable, Income Account, Expense Account, Freight 
Collected, Freight Paid, Sales Tax Collected, and Sales Tax Paid. You can enter your new 
account numbers/description, or you can select from existing accounts in the Chart of Accounts
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Screen References - Edit Accounts
The Express Accounts Edit Payment window allows you to edit applied payments. 
Applied:
Payment amount to apply to this invoice.
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Screen References - Invoice Records Log
Express Accounts keeps a record of actions related to invoices, such as when they were 
printed, faxed or emailed. This can be useful to reference if a question about whether an 
invoice was sent ever arises.
Open the Invoice Records Log from the Invoice List by right clicking an invoice and selecting S
how Logs  from the right-click menu.
This dialog box displays the logs of the selected record. Click Save As to save the selected log 
in a file.
Click Print to print the log.
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Screen References - Email Address
Please enter the email address you want to send to. This needs to be the full email address, 
e.g., tom.jones@example.net . To send to multiple email addresses, separate each address 
with a comma. For problems with sending an email, please refer to this page. 

Remember this email address
If this option is available, check 'Save this email ...' to save the email address for use in the 
future. 

Attach or Include Invoice
You may choose whether to have the invoice attached to the email as a PDF file, or to include 
it within the email as an HTML document. 
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Screen References - Email Address - Payment
Please enter the email address you want to send to. This needs to be the full email address, 
e.g., tom.jones@example.net . To send to multiple email addresses, separate each address 
with a comma. For problems with sending an email, please refer to this page. 

Remember this email address
If this option is available, check 'Save this email ...' to save the email address for use in the 
future. 

Attach or Include Payment
You may choose whether to have the payment attached to the email as a PDF file, or to 
include it within the email as an HTML document. 
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Screen References - Email Address - Refund
Please enter the email address you want to send to. This needs to be the full email address, 
e.g., tom.jones@example.net . To send to multiple email addresses, separate each address 
with a comma. For problems with sending an email, please refer to this page. 

Remember this email address
If this option is available, check 'Save this email ...' to save the email address for use in the 
future. 

Attach or Include Refund
You may choose whether to have the refund attached to the email as a PDF file, or to include it 
within the email as an HTML document. 
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Screen References - Adjust Row Value
This dialog is used for adjusting the row values of the budget.
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Screen References - Browse transaction file
Bank file:
You can browse for your bank statement's transaction file in CSV or OFX format.
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Screen References - Edit Account Value
This dialog can be used for entering an account balance from ExpressAccounts for a specified 
period or a point of time. 
Account:
Select an account or account type from pull-down-list.
Period:
Select a period or point of time from the pull-down-list.
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Screen References - Edit Comparison Expression 
Value
This dialog can be used for entering a comparison type expression in the report form. It allows 
you to compare two different field values or expressions, and enter an amount in the report 
form based on those comparison. 
Enter the left-side expression or amount.
Select a comparison type.
Enter the right-side expression or amount.
Value when above condition is true:
Enter an expression or an amount to be substituted in the report text, when above condition is 
valid or true.
Value when above condition is false:
Enter an expression or an amount to be substituted in the report text, when above condition is 
invalid or false.
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Screen References - Edit True/False Value
This dialog can be used for entering a boolean type (True/False, Yes/No) value in the report. 
This can be very useful for checkboxes and answering Yes/No type questions in the report. 
Select state:
Select True or False state.
Value name:
Enter the desired text for current state. You can also enter unicode characters and symbols.

297



Screen References - Edit Rounding Value
This dialog can be used for rounding an expression or amount in the report. 
Rounding Rule:
Select a rounding rule.
Rounding Interval:
Select a rounding interval.
Expression to round:
Enter an expression or an amount. E.g., Field1+Field2, 259.66, etc.
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Screen References - Rename Report Form
This dialog is used for renaming the report form name.
New report form name:
Enter a report form name. It must contain valid file name characters as the report form's file 
name will be same as the report form name.
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Screen References - Column Order
Column Order window allows you to change the Invoice item list's headers ordering. 
Contains the list of available column headers (ordered from left to right).
Move Up
Move the column header to a higher order.
Move Down
Move the column header to a lower order.
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Screen References - Item ~ Item
The Item tab of the Item dialog is where you enter or edit an item's description and price 
details. To edit an existing item, click the View menu,  select Items,  select the item you wish 
to edit and click Edit. New items can be created in quotes, orders and invoices and then edited 
with more detail in this way. New items can also be created using the Item dialog by clicking 
the View menu,  selecting Items,  and clicking Add  in the toolbar. 
Item code:
Enter a short, unique (but memorable) code for this item. This will not be displayed on invoices, 
quotes and orders.
Item description:
Enter the full item description you want to display on invoices, quotes and orders.
Unit selling price (or rate):
This is the selling price for a single unit of the item.
Unit purchase price (or cost):
This is the purchase price or cost for a single unit of the item.
Tax:
Select the tax rate that applies to the item. If the only option you see is 'None,' you need to 
configure the Tax Options first (click the Options icon from the main window, then click the Tax 
tab).
Income account:
If you have multiple entries in the income statement, select the account here. Default is 
General Sales. This then will be subtotaled in the Accounting Report.
Expense account:
If you have multiple entries in the income statement select the account here. Default is General 
Products Purchased. This then will be subtotaled in the Accounting Report.
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Screen References - Item ~ Inventory
The Inventory tab of the Item dialog is where you enter or edit an item's inventory levels. To 
edit an item's inventory, click the View menu,  select Items,  select the item you wish to edit 
and click Edit, then click the Inventory tab. 
Manage the inventory stock levels
Tick (Check) this if you want to manage the inventory stock levels.
Current quantity:
This is the current quantity of the item.
Ideal quantity:
This is the ideal quantity of the item.
Warning quantity:
This is the warning quantity of the item. Express Accounts will notify you went the quantity gets 
to this level.
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Screen References - Supplier ~ Supplier
The Supplier dialog is where you enter or edit a supplier's contact information. When a supplier 
has been entered into Express Accounts, they will be available for selection in the Supplier 
drop-menu when creating purchase orders or paying bills. To create a new supplier record 
from the desktop version, click the View menu, select Suppliers,  and click Add  in the toolbar. 
To create a record from the web interface, click the Supplier Lists  link, then click the Add 
New Supplier  button at the top of the screen. 
Supplier name:
Enter the business name of the supplier, such as Acme, Inc.
Contact person:
Enter the full name of your contact person in the supplier's company.
Contact first name:
This is the first name of the person you deal with, or the way you address them.
Address:
Enter the supplier's address.
Phone (primary):
This phone number can be used to call the supplier directly from Express Accounts, by clicking 
the Call button.
Phone (alternative):
Enter the supplier's alternate phone number.
Fax:
This fax number is used for sending purchase orders by fax.
Email:
This email address is the one used for sending purchase orders by email, if email is the 
preferred method.
VAT registration number:
Supplier's VAT registration number
Set tax exempt for this supplier
Check this if you wish to not apply taxes on any transaction of this supplier.
Additional info:
Enter an additional information, such as ABN.
Payment terms: (if available)
Select the terms of payment which will appear by default on an accounts payable created for 
this supplier.
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Screen References - Supplier ~ Info
Opening balance:
Enter the opening balance of the supplier.
Balance due:
This is the current total balance due to the supplier
Last order:
This is the date that the last purchase order for the supplier was created.
Orders
Search Orders
Click on this button to search for all orders belonging to this supplier.
This is the list of orders belongs to the supplier. To view an order, double click on it.
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Screen References - Customer ~ Customer
The Customer tab of the Customer dialog is where you enter or edit a customer's primary 
contact information. To edit an existing item, click the View menu,  select Customers,  select 
the customer you wish to edit and click Edit. New customers can be created while filling out 
quotes, orders and invoices and edited with more detail in this way. New customers can also 
be created using the Customer dialog by clicking the View menu,  selecting Customers,  and 
clicking Add  in the toolbar. 
Customer name:
Enter the business name of the customer, such as Acme, Inc.
Contact person:
Enter the full name of your contact person with the customer.
Contact first name:
This is the first name of the person you deal with, or the way you address them.
Use mailing address as shipping address
Check this box to use the customer's billing address as their shipping address.
Enter the customer billing address. If the customer has a different shipping address you can 
enter that on the Other tab.
VAT registration number:
Enter the customer's VAT registration number
Phone (primary):
Enter the customer's primary phone number.
Phone (alternative):
Enter the customer's alternate phone number.
Fax:
Enter the customer's fax number.
Email:
This email address is the one used for sending invoices by email if email is the preferred 
method.
Additional Printed Info:
Enter any additional information to be printed on invoices, such as ABN.
This customer is active
Check this box to show that this customer is currently active.
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Screen References - Customer ~ Credit Card
The Credit Card tab of the Customer dialog is where you store a customer's credit card number 
for accepting credit card payments. Open this tab by clicking the View menu,  selecting Custo
mers,  and clicking the Credit Card tab. This tab must be filled out before you can 
accept credit card payments from customers, as well as the Credit Card Gateway tab of 
Options (see Options~Credit Card Gateway). 
Card number:
Enter the customer's credit card number.
Card verification number:
Enter the customer's credit card Verification Number. This is usually a 3-digit number found on 
the back of the card.
Card type:
Select the customer's credit card type.
Expiration month:
Select the customer's credit card expiration month.
Expiration year:
Select the customer's credit card expiration year.
Card holder first name:
Enter the credit card holder's First Name.
Card holder last name:
Enter the credit card holder's Last Name.
Currency type:
Select the currency type for the customer to pay. This works for Paypal only, for authorize the 
currency type is always USD.
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Screen References - Customer ~ Other
The Other tab of the Customer dialog stores additional information about the customer, such 
as their shipping address, and several options that will appear by default when creating 
invoices for this customer. Open this tab by clicking the View menu,  selecting Customers,  
and clicking the Other tab. 
Shipping address:
If the customer's preferred shipping address is different from the billing address, enter it here. If 
the shipping address is the same as the billing address, click the 'Use mailing address as 
billing address' checkbox on the Customer page.
Prefers invoices by:
Select the method which Express Accounts should use to send invoices to this customer when 
generating new recurring invoices.
Set tax exempt for this customer
Check this if you wish to not apply taxes on any transaction for this customer.
Payment terms:
Select the terms of payment which will appear by default on an invoice created for this 
customer.
Salesperson:
This is the name of the salesperson who will be selected by default when an invoice is created 
for this customer.
Customer notes:
These notes are for internal use only. They can be used, for example, to indicate the 
customer's history or for special terms.
Customer group:
Select the group that this customer belongs to. To manage customer groups, use the button to 
the right of the Customer group field.

307



Screen References - Customer ~ Info
The Info tab of the Customer dialog stores information about the customer's account. Open this 
tab by clicking the View menu,  selecting Customers,  and clicking the Info  tab. 
Opening balance:
Enter the opening balance of the customer, if they have one.
Balance due:
This is the current total balance due for the customer.
Oldest due date:
This is the due date of the oldest invoice of the customer.
Last invoice:
This is the invoice number of the last invoice created for this customer.
Invoices
Search Invoices
Click on this button to search for all invoices belonging to this customer. The invoices will 
appear in the table beneath this button.
This is the list of invoices belonging to the customer. To populate the list, click the Search 
Invoices button above this table. To view an invoice, double click on it.
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Screen References - Express Accounts Quick 
Start Wizard ~ Quick Start: Business Details
The Quick Start Wizard runs when Express Accounts is first installed and when a new 
business is set up. 
Business name:
Enter the name of the business.
Address:
Enter the address of your business.
Contact details:
Enter the contact details you want to appear on invoices, reports, and other documents. For 
example, phone, fax and email address.
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Screen References - Express Accounts Quick 
Start Wizard ~ Quick Start: Chart of Accounts
Use the default chart of accounts for a business.
This is the recommended option if you are starting a new set of accounts. The Express 
Accounts default list is pre-configured and suitable for most businesses. You can modify or add 
accounts as required later.
Checking Account Opening Balance:
Enter the initial checking account balance.
Credit Card Account Opening Balance:
Enter the initial credit card account balance.
Create a new chart of accounts list manually.
Use this option if you want to create your own chart of accounts list with your own numbering 
system. This takes more time to set up, but may be suitable if you already have a bookkeeping 
system.
Import chart of accounts from the primary business
Use this option to copy the chart of accounts already entered into Express Accounts under the 
primary business.
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Screen References - Express Accounts Quick 
Start Wizard ~ Quick Start: Business Type
Select the radio button which best describes your business. This only affects the labels on 
invoices and can be changed later either in the Business  section in Options or under Invoice
Text  in the Invoice  section in Options. 
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Screen References - Express Accounts Quick 
Start Wizard ~ Express Accounts Quick Start 
Wizard
The Regional Settings window allows you to choose region-specific symbols, unit of 
measurement and other formats for your business. 
Currency symbol:
This is the symbol used for money in your country, such as $.
Currency name:
This is the name used for money in your country. For example, Dollars or Pounds.
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Screen References - Express Accounts Quick 
Start Wizard ~ Quick Start: Select Your Province
Select your province:
Select the province where your business resides.
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Screen References - Express Accounts Quick 
Start Wizard ~ Quick Start: Select Your Country
Select your country:
Select the country where your business resides.
Select your province:
Select the province where your business resides.

314



Screen References - Express Accounts Web 
Access Wizard ~ Set Up Web Access
Would you like to set up Web Access now?
Set up remote access from the local network/internet.
Guides you to set up Web Access.
No, don't allow any remote access.
Aborts Web Access setup.

315



Screen References - Express Accounts Web 
Access Wizard ~ User Account Web Access
Web Accounts
Display Name:
Enter the user's name. This is used for display purposes.
Email Address:
This is used to uniquely identify the user. The user will use their email as the account name, to 
login to the web interface, and if they lose their password.
Password:
Enter the password for this user. The user will use this to login to the web interface.
Password Again:
Enter the password for this user again, to make sure it has been entered correctly.
Account Enabled
Tick this option to enable the account, and to allow the user access to the web interface.
User Privileges
Administrator
Checking this option will allow this user to modify others user's preferences and to 
add/edit/remove transactions.
User
Checking this option allows this user to be able to add/edit/remove transactions.
Viewer
Checking this option allows this user to view transactions, but does not allow them to 
add/edit/remove transactions.
Organizations
This is the list of organizations that the user can access. By default, Administrators are allowed 
to access all organizations.
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Screen References - Express Accounts Web 
Access Wizard ~ Choose Web Access Type
Local Access - Access your data from inside your local network.
Select this option if you will only be accessing Express Accounts from the same network, not 
from remote locations over the internet. Not that you will still use a browser to access Express 
Accounts using this option.
Public Access - Access data from anywhere using a web browser.
Select this option if you need to access Express Accounts from computers or devices in 
remote locations or that aren't on the same network.
Cloud Access - An easy but slower alternative to the Public access option.
Select this option if you are having difficulty configuring Public Access. Cloud Access may be 
slower than the other options, but will require much less effort on your part to set up.
Access Status
The Access Status displays any errors associated with your connection type, or will notify you if 
you are configured properly for Web Access. If you see errors, the status should provide hints 
for fixing the errors. Ask your network administrator for help configuring your system.
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Screen References - Express Accounts Create 
New Budget Wizard ~ Create New Budget
Date:
Enter the date for the budget.
Choose Budget Type
Balance Sheet (ending balance)
Balance Sheet type of budget focuses on the ending balance.
Profit and Loss (all activity for the year)
Profit and Loss Budget deals with all the activities for the year.
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